# Contents

<table>
<thead>
<tr>
<th>Chapter 1</th>
<th>Document history</th>
<th>9</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 2</td>
<td>Getting Started</td>
<td>11</td>
</tr>
<tr>
<td>2.1</td>
<td>About this documentation</td>
<td>11</td>
</tr>
<tr>
<td>2.1.1</td>
<td>Terminology</td>
<td>11</td>
</tr>
<tr>
<td>2.2</td>
<td>About the Business Intelligence platform</td>
<td>13</td>
</tr>
<tr>
<td>2.3</td>
<td>Licensing</td>
<td>13</td>
</tr>
<tr>
<td>2.4</td>
<td>Key concepts</td>
<td>14</td>
</tr>
<tr>
<td>2.5</td>
<td>Key tasks</td>
<td>15</td>
</tr>
<tr>
<td>Chapter 3</td>
<td>Working With the Central Management Console (CMC)</td>
<td>17</td>
</tr>
<tr>
<td>3.1</td>
<td>About the Central Management Console</td>
<td>17</td>
</tr>
<tr>
<td>3.2</td>
<td>To log on to the CMC</td>
<td>18</td>
</tr>
<tr>
<td>3.3</td>
<td>Navigating the CMC</td>
<td>18</td>
</tr>
<tr>
<td>3.4</td>
<td>To set CMC preferences</td>
<td>19</td>
</tr>
<tr>
<td>3.4.1</td>
<td>CMC preference options</td>
<td>19</td>
</tr>
<tr>
<td>3.4.2</td>
<td>Preferred viewing locales</td>
<td>20</td>
</tr>
<tr>
<td>Chapter 4</td>
<td>Adding Objects to the Repository</td>
<td>21</td>
</tr>
<tr>
<td>4.1</td>
<td>Managing objects</td>
<td>21</td>
</tr>
<tr>
<td>4.2</td>
<td>Adding objects</td>
<td>21</td>
</tr>
<tr>
<td>4.2.1</td>
<td>To add an object in the CMC</td>
<td>22</td>
</tr>
<tr>
<td>4.2.2</td>
<td>Object property options</td>
<td>23</td>
</tr>
<tr>
<td>4.2.3</td>
<td>Saving objects to the CMS</td>
<td>24</td>
</tr>
<tr>
<td>Chapter 5</td>
<td>Organizing Objects</td>
<td>27</td>
</tr>
<tr>
<td>5.1</td>
<td>Folders</td>
<td>27</td>
</tr>
<tr>
<td>5.1.1</td>
<td>To create a folder</td>
<td>27</td>
</tr>
<tr>
<td>5.1.2</td>
<td>To delete a folder</td>
<td>27</td>
</tr>
<tr>
<td>5.1.3</td>
<td>Copying and moving folders</td>
<td>28</td>
</tr>
<tr>
<td>5.1.4</td>
<td>Specifying folder rights</td>
<td>29</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
<td></td>
</tr>
<tr>
<td>---------</td>
<td>-----</td>
<td></td>
</tr>
<tr>
<td>6.4.5</td>
<td>71</td>
<td></td>
</tr>
<tr>
<td>6.5</td>
<td>71</td>
<td></td>
</tr>
<tr>
<td>6.5.1</td>
<td>71</td>
<td></td>
</tr>
<tr>
<td>6.5.2</td>
<td>72</td>
<td></td>
</tr>
<tr>
<td>6.5.3</td>
<td>73</td>
<td></td>
</tr>
<tr>
<td>6.5.4</td>
<td>73</td>
<td></td>
</tr>
<tr>
<td>6.5.5</td>
<td>74</td>
<td></td>
</tr>
<tr>
<td>Chapter 7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7.1</td>
<td>75</td>
<td></td>
</tr>
<tr>
<td>7.1.1</td>
<td>75</td>
<td></td>
</tr>
<tr>
<td>7.1.2</td>
<td>76</td>
<td></td>
</tr>
<tr>
<td>7.1.3</td>
<td>80</td>
<td></td>
</tr>
<tr>
<td>7.1.4</td>
<td>81</td>
<td></td>
</tr>
<tr>
<td>7.2</td>
<td>81</td>
<td></td>
</tr>
<tr>
<td>7.2.1</td>
<td>82</td>
<td></td>
</tr>
<tr>
<td>7.2.2</td>
<td>120</td>
<td></td>
</tr>
<tr>
<td>7.2.3</td>
<td>121</td>
<td></td>
</tr>
<tr>
<td>7.3</td>
<td>121</td>
<td></td>
</tr>
<tr>
<td>7.3.1</td>
<td>122</td>
<td></td>
</tr>
<tr>
<td>7.3.2</td>
<td>126</td>
<td></td>
</tr>
<tr>
<td>7.3.3</td>
<td>127</td>
<td></td>
</tr>
<tr>
<td>7.3.4</td>
<td>127</td>
<td></td>
</tr>
<tr>
<td>7.4</td>
<td>128</td>
<td></td>
</tr>
<tr>
<td>7.4.1</td>
<td>130</td>
<td></td>
</tr>
<tr>
<td>7.4.2</td>
<td>131</td>
<td></td>
</tr>
<tr>
<td>7.4.3</td>
<td>132</td>
<td></td>
</tr>
<tr>
<td>7.4.4</td>
<td>133</td>
<td></td>
</tr>
<tr>
<td>Chapter 8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8.1</td>
<td>135</td>
<td></td>
</tr>
<tr>
<td>8.1.1</td>
<td>136</td>
<td></td>
</tr>
<tr>
<td>8.1.2</td>
<td>136</td>
<td></td>
</tr>
<tr>
<td>8.1.3</td>
<td>137</td>
<td></td>
</tr>
<tr>
<td>8.1.4</td>
<td>138</td>
<td></td>
</tr>
<tr>
<td>8.1.5</td>
<td>138</td>
<td></td>
</tr>
<tr>
<td>8.1.6</td>
<td>141</td>
<td></td>
</tr>
<tr>
<td>8.1.7</td>
<td>141</td>
<td></td>
</tr>
<tr>
<td>8.2</td>
<td>142</td>
<td></td>
</tr>
<tr>
<td>8.2.1</td>
<td>142</td>
<td></td>
</tr>
</tbody>
</table>
11.1.3 To create a new publication in the CMC .................................................................178
11.1.4 To create a new publication in BI launch pad.......................................................179
11.1.5 To open a publication............................................................................................179
11.1.6 To define general properties for a publication......................................................179
11.1.7 To select source documents..................................................................................180
11.1.8 To select Enterprise recipients..............................................................................180
11.1.9 To select dynamic recipients................................................................................181
11.1.10 To select a destination for a publication..............................................................182
11.1.11 To select a recurrence pattern.............................................................................190
11.1.12 To select personalized placeholders for publication source documents.............193
11.1.13 To select personalized placeholders for email fields..........................................193
11.1.14 To embed content from a dynamic source document in an email.......................194
11.1.15 Crystal report design tasks..................................................................................195
11.1.16 Web Intelligence document design tasks............................................................208
11.1.17 Optional publication features.............................................................................211
11.2 Finalizing a publication............................................................................................215
11.2.1 To test a publication..............................................................................................215
11.2.2 To schedule a publication to run...........................................................................216
11.2.3 To subscribe to or unsubscribe from a publication.................................................220
11.2.4 To subscribe to or unsubscribe from a publication instance.................................220
11.2.5 To redistribute a publication instance..................................................................221
11.2.6 To retry a failed publication..................................................................................221
11.2.7 Improving publication performance.....................................................................222
11.3 Recommendations for adding source documents...................................................224
11.3.1 Recommendations for using dynamic recipient sources.......................................225
11.3.2 Recommendations for sending and receiving email publication instances.........226

Index 227
The following table provides an overview of the most important document changes.

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>May, 2013</td>
<td>Support for SAP Jam was added. When integrated, SAP Jam adds social media and collaboration features to BI launch pad.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Additional collaboration access rights were added for users and groups. The collaboration feed panel includes a drop-down list of instances and times and a button for following or unfollowing a feed. Automatically follow all related instances when you follow a template document in SAP Jam or SAP StreamWork. Comments on instances are posted only for the instance.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can open OpenDocument links to documents and instances on a tab or via the link. When viewing a document or instance via an OpenDocument link, open the SAP StreamWork feed panel to monitor or reply to a document feed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>An <strong>Add File Extension</strong> check box was added to the &quot;Destinations&quot; dialog box.</td>
</tr>
</tbody>
</table>
This guide was updated to include the following information:

**Note:**
You can run one session of BI launch pad at a time. Use tabs (or windows, depending on your configuration) to view multiple objects and applications.

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP BusinessObjects Business Intelligence Platform 4.1 Support Package 1</td>
<td>August, 2013</td>
<td>This guide was updated to include the following information: <strong>Note:</strong> You can run one session of BI launch pad at a time. Use tabs (or windows, depending on your configuration) to view multiple objects and applications.</td>
</tr>
<tr>
<td>SAP BusinessObjects Business Intelligence Platform 4.1 Support Package 2</td>
<td>November, 2013</td>
<td>Information about subscribing to scheduled publications and publication instances was added.</td>
</tr>
</tbody>
</table>
Getting Started

2.1 About this documentation

This documentation contains information about working with and managing objects in BI platform and about accomplishing tasks in the Central Management Console (CMC). Procedures are provided for common tasks. Conceptual information and technical details are provided for all advanced tasks.

For information about system administration tasks, such as planning your deployment, managing servers, setting rights, setting up authentication, or managing users and groups, see the SAP BusinessObjects Business Intelligence Platform Administrator Guide. For information about installing BI platform, see the SAP BusinessObjects Business Intelligence Platform Installation Guide. Both guides are available on the SAP Help Portal at http://help.sap.com.

Who should use this documentation

This information is intended for content administrators and power users who manage content in the repository and distribute updated content to recipients.

2.1.1 Terminology

The following terms are used throughout the BI platform documentation:

**add-on products**
Products that work with the BI platform but have their own installation program, such as SAP BusinessObjects Explorer.

**Auditing Data Store (ADS)**
The database used to store auditing data.

**BI platform**
Shorthand for SAP BusinessObjects Business Intelligence platform.

**bundled database; bundled web application server**
The database or web application server shipped with the BI platform.

**cluster (noun)**
A cluster is two or more Central Management Servers (CMSs) working together and using a single CMS database.
cluster (verb)
   To cluster means to create a cluster. For example, to create a cluster:
   1. Install a CMS and CMS database on machine.
   2. Install a CMS on machine B.
   3. Point the CMS on machine B to the CMS database on machine A.

cluster key
   Used to decrypt the keys in the CMS database. You can change the cluster key using the CCM, but you cannot reset this key like you can with a password. This is an encryption key with which content is encrypted, which makes it very important not to lose.

CMS
   The Central Management Server.

CMS database
   The database used by the CMS to store information about the BI platform.

deployment
   The BI platform software installed, configured, and running on one or more machines.

installation
   An instance of BI platform files created by the installation program on a machine.

machine
   BI platform software is installed on a machine.

major release
   Software releases such as 4.0.

migration
   The process of transferring Business Intelligence content from a previous major release (e.g. from XI 3.1) using the upgrade management tool. Cannot be used for deployments with the same major release - see "promotion".

minor release
   Software releases such as 4.1.

node
   A group of BI platform servers that run on the same machine and are managed by the same Server Intelligence Agent (SIA).

Patch
   Small updates for a specific Support Package version.

promotion
   The process of transferring business intelligence content between deployments with the same major release (e.g. 4.0 to 4.0) using the promotion management application.

server
   A BI platform process. A server hosts one or more services.

Server Intelligence Agent (SIA)
A SIA is a process that manages a group of servers. Management tasks include stopping, starting, and restarting servers.

**Support Package**
Updates for a minor or major release.

**upgrade**
All the planning, preparation, migration, and post-processes required to complete a migration process.

**web application server**
A web application server processes dynamic content. For example, the bundled web application server for 4.1 is Tomcat 7.

### 2.2 About the Business Intelligence platform

The BI platform is a flexible and scalable solution for delivering information to end users, in multiple forms including dashboards and interactive reports, via any web application—intranet, extranet, Internet, or corporate portal. An integrated suite for reporting, analysis, and information delivery, the BI platform provides a solution for increasing end-user productivity and reducing administrative efforts. Whether it is used to distribute weekly sales reports, to provide customers with personalized service offerings, or to integrate critical information in corporate portals, the BI platform delivers tangible benefits that extend across and beyond the organization.

### 2.3 Licensing

BI platform supports the following types of user licenses:
- BI Viewer
- BI Analyst
- Concurrent user
- Named user

Each license type grants and restricts access to particular tasks and applications. Depending on which license you have, you may be unable to access some applications, to create content, or to add documents to the repository. To determine which license you have, contact your system administrator. For more information about licensing, see the *SAP BusinessObjects Business Intelligence Platform Administrator Guide* on the SAP Help Portal at [http://help.sap.com](http://help.sap.com).
2.4 Key concepts

Before you begin, familiarize yourself with key concepts in BI launch pad. Depending on which tasks you perform, some concepts may not apply to you.

**Objects**
An object is a document or file created in BI platform or other software that is stored and managed in the BI platform repository.

**Categories**
A category is an organizational alternative to a folder. Use categories to label objects.

**Scheduling**
Scheduling is the process of automatically running an object at a specified time. Scheduling refreshes dynamic content or data in an object, creates instances, and distributes the instances to users or stores them locally.

**Events**
An event is an object that represents an occurrence in the BI platform system. Events can be used for the following purposes:

- As scheduling dependencies that trigger actions after a scheduled job runs
- To trigger alert notifications
- To monitor BI platform performance

**Calendars**
A calendar is a customized list of run dates for scheduling jobs.

**Instances**
An instance is a snapshot of an object that contains data from the time an object was run.

**Publishing**
PUBLISHING is the process of making personalized dynamic content publicly available for mass consumption.

**Profiles**
A profile is an object that associates users and groups with personalization values. Profiles are used with publishing to create personalized content and distribute it to recipients.

**Alerting**
Alerting is the process of notifying users and administrators when events occur in BI platform.
2.5 Key tasks

**How do I add objects to the repository?**
See “Adding objects”.

**How do I modify and manage objects after they have been added to the repository?**
See the information about working with objects in “General object management”.

**How do I organize objects?**
See the information about organizing objects in “Folders” and “Categories”.

**How do I distribute content to users?**
You can distribute content to users through scheduling, publishing, and alerting.

- Scheduling lets you refresh data in dynamic content documents and distribute the refreshed data to users at regular intervals. See “Scheduling”.
- Publishing lets you personalize and refresh content in dynamic content documents for specific users and groups. See “About publishing”.
- Alerting sends alert notifications to subscribers when an event has occurred in BI platform. See “Alerting”.


3.1 About the Central Management Console

The Central Management Console (CMC) is a web-based tool that you use to perform most day-to-day administrative tasks, including user management, content management, and server management. Any user with valid credentials for SAP BusinessObjects Business Intelligence (BI) platform can log on to the CMC and set preferences. Users who are not members of the Administrators group cannot perform management tasks, unless they have been granted access rights for a task.

There are two ways to access the CMC—from your browser or by selecting Programs > SAP Business Intelligence > SAP BusinessObjects BI platform 4 > SAP BusinessObjects BI platform Central Management Console in Windows.
3.2 To log on to the CMC

You can log on to only one session of the Central Management Console (CMC). (You cannot run multiple sessions of the CMC in separate browser tabs or windows.)

1. In a browser, type the URL to the CMC.
   The default URL is http://webserver:8080/BOE/CMC/. However, your deployment may have a custom URL configured.
   Replace webserver with the name of the web server machine. If the default virtual directory on the web server was changed, you must type that URL. If necessary, change the default port number to the number provided during installation.

   **Tip:**
   On Windows, select Start > All Programs > SAP Business Intelligence > SAP BusinessObjects BI platform 4 > SAP BusinessObjects BI platform Central Management Console to start the CMC.
   If your CMC is hosted on a Web Application Container Server (WACS), select Start > All Programs > SAP Business Intelligence > SAP BusinessObjects BI platform 4 > SAP BusinessObjects BI platform WACS Central Management Console.

2. In the System box, type the name of your Central Management Server (CMS).
3. Type your user name and password.
   If you are using LDAP authentication, you can log on using an account that has been mapped to the Administrator group.
   If this is the first time an administrator in your organization is accessing the CMC, type Administrator as the user name and enter the default password that was created during installation.
4. In the Authentication list, select Enterprise.
   Windows AD, LDAP, and other authentication methods appear in the list. However, third-party user accounts and groups must be mapped to the BI platform before you can use them.
5. Click Log On.
   The "CMC Home" window appears.

3.3 Navigating the CMC

You can navigate the Central Management Console (CMC) in two ways:
* Click icons on the left side of the window, or click links under Organize, Define, or Manage.
* Select options in the CMC Home list in the upper-left corner of the window.
Note:
In the tree view, when you navigate to selections that have many child objects, not all child objects may appear. Use the paginated object listing to locate child objects.

3.4 To set CMC preferences

Use the Preferences area of Central Management Console (CMC) to customize the administrative view of BI platform. Preferences set in the CMC apply to the CMC and to BI launch pad.

Note:
If a user belongs to two or more user groups, BI launch pad displays the preferences configured for only one of the groups.

1. Log on to the CMC, and click Preferences in the upper-right corner of the CMC. The "Preferences" dialog box appears.
2. Set the preference options.
Preferences work the same way as in BI launch pad. However, CMC preferences affect the behavior of objects in the CMC and in BI launch pad.
3. Click Save & Close.

3.4.1 CMC preference options

The following options are available when you click CMC Preferences in the "Preferences" dialog box in the Central Management Console (CMC):

<table>
<thead>
<tr>
<th>CMC preference option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Product Locale</strong> list</td>
<td>Select the default language for BI platform. For more information, see the SAP BusinessObjects Business Intelligence Platform Installation Guide.</td>
</tr>
<tr>
<td><strong>Preferred Viewing Locale</strong> list</td>
<td>Select the default formatting option for dates, times, and numbers in the CMC.</td>
</tr>
<tr>
<td><strong>Maximum number of objects per page</strong></td>
<td>Type the maximum number of objects to display in a window or tab in the CMC. This value limits the number of object displayed, not limit the total number of objects.</td>
</tr>
</tbody>
</table>
### CMC preference option

<table>
<thead>
<tr>
<th>CMC preference option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Time Zone</strong> list</td>
<td>Select your time zone if you are remotely managing BI platform. BI platform synchronizes scheduling patterns and events to your time zone. For example, if you select <strong>Eastern Time (US &amp; Canada)</strong> and you schedule a report to run at 5:00 a.m. every day on a server in San Francisco, the server will run the report at 2:00 a.m. Pacific time.</td>
</tr>
</tbody>
</table>
| **Prompt for Unsaved Data** list | Indicate whether to prompt users for confirmation when they cancel a dialog box or close the CMC without saving:  
- Select **On** to enable the prompt.  
- Select **Off** to disable the prompt.  
- Select **Default** to determine prompt behavior with settings configured in the `CmcApp.properties` file, located in the `custom folder` or `default folder` at C:\Program Files (x86)\SAP\BusinessObjects\tomcat\webapps\BOE\WEB-INF\config. |

### 3.4.2 Preferred viewing locales

The preferred viewing locale (PVL) determines how dates, times, and numbers are formatted in BI launch pad.

For multilingual objects, the PVL also sets the language used to display an object's name and description. If an object has multiple translated names and descriptions, the display language is determined in the following way:

1. **The system displays the name and description that correspond to the user's PVL.**
   
   BI platform may use a default fallback locale, but it is typically a variation of the user's PVL. For example, if the PVL is French (Canada) and the object does not have a translated name and description in Canadian French, BI platform will use French (France).

2. **If no PVL is set, BI platform displays the name and description in the same language as the product locale.**

3. **If option 1 or 2 is not feasible, BI platform displays the name and description in the object's source language.**
Adding Objects to the Repository

4.1 Managing objects

All documents and files in BI platform—hyperlinks, shortcuts, Crystal reports, and Web Intelligence documents—are considered objects. BI platform uses folders and categories to organize objects. Objects must belong to one folder, but they can be assigned to no or several categories. Folders and categories can be either public (corporate) or personal.

4.2 Adding objects

You must add objects to the Business Intelligence (BI) environment and then make the objects available to authorized users. You can add many types of objects to BI platform—for example:

- Reports (from SAP Crystal Reports)
- Documents (from Web Intelligence)
- Flash objects
- Programs
- Microsoft Excel, Word, and PowerPoint files
- Adobe PDF files
- Text files
- Rich text format files

You can add objects to BI platform in the CMC or by saving objects to the Central Management Server (CMS).

Note:
Depending on your user license, you may not have access rights to add objects. To determine which license type you have, contact your system administrator. For more information about licensing, see the SAP BusinessObjects Business Intelligence Platform Administrator Guide on the SAP Help Portal at http://help.sap.com.
4.2.1 To add an object in the CMC

You must have administrative rights to Information platform services before you can add an object in the CMC.

1. Go to the "Folders" management area of the CMC.
2. Browse for the folder that you want to add an object to and select it.
3. On the Manage menu, point to Add and click the appropriate option.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program File</td>
<td>Adds a program object.</td>
</tr>
<tr>
<td>Local Document</td>
<td>Adds other types of objects.</td>
</tr>
</tbody>
</table>

A dialog box appears and lets you specify the properties of the object. This dialog box varies depending on the option you selected.

4. Specify the properties of the object.

**Note:**
The properties fields that appear vary according to the type of object that you chose to publish. The properties fields are summarized in the table "Object properties in the CMC".

5. If you want to assign the object to a category, select the category from the list.
6. Click OK.

The dialog box closes, and the CMC refreshes to display the object and the other contents of the folder.

If necessary, you can modify properties such as title, description, database logon information, scheduling information, user rights, and so on for the object after it is published to the CMC.
Table 4-1: Object properties in the CMC

<table>
<thead>
<tr>
<th>Object type</th>
<th>Property</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>General objects</td>
<td>Filename</td>
<td>Enter the name of the object you want to add, or click <strong>Browse</strong> to find the object.</td>
</tr>
<tr>
<td></td>
<td>Title</td>
<td>Enter the name of the object.</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>Enter a description for the object.</td>
</tr>
<tr>
<td></td>
<td>Keywords</td>
<td>Enter keywords for the object.</td>
</tr>
<tr>
<td>Program files only</td>
<td>Browse for an existing Program object</td>
<td>Enter the name of the program object you want to add, or click <strong>Browse</strong> to find the object.</td>
</tr>
</tbody>
</table>
|                      | Program type              | Click one of the options below "Program type" to define the type of program you are adding. The options are:  
|                      |                           | - **Executable** (binary, batch, shell script)                        |
|                      |                           | - **Java**                                                             |
|                      |                           | - **Script** (VBScript, JavaScript)                                    |
| Other object types   | MIME                      | Specify the MIME extension for the object if needed.                  |

4.2.2 Object property options
### Adding Objects to the Repository

<table>
<thead>
<tr>
<th>Object type</th>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crystal reports and other object types</td>
<td>Filename</td>
<td>Type the name of the object you want to add, or click <strong>Browse</strong> to locate the object.</td>
</tr>
<tr>
<td>Crystal reports only</td>
<td>Keep saved data</td>
<td>Select this option to preserve the report’s saved data.</td>
</tr>
<tr>
<td></td>
<td>Use description from report</td>
<td>Select this option to preserve the report’s summary information.</td>
</tr>
<tr>
<td>Program files only</td>
<td>Browse for an existing Program object</td>
<td>Type the name of the program object to add, or click <strong>Browse</strong> to locate the object.</td>
</tr>
<tr>
<td></td>
<td>Program type</td>
<td>Select the type of program to add:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Executable</strong> (binary, batch, shell script)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Java</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Script</strong> (VBScript, JavaScript)</td>
</tr>
<tr>
<td>Other object types</td>
<td>MIME</td>
<td>Type the MIME extension for the object, if needed.</td>
</tr>
</tbody>
</table>

### 4.2.3 Saving objects to the CMS
If you installed a BI platform designer component, such as SAP Crystal Reports for Enterprise or SAP BusinessObjects Web Intelligence, you can use the **Save As** command to add objects directly to BI platform from the designer.

For example, after you design a report in Crystal Reports, you can save the report to the CMS. Select **File > Save As**, click **Enterprise** in the "Save As" dialog box, log on to the CMS when prompted, select the folder where you want to save the report, and click **Save**.

**Note:**
You can add SAP BusinessObjects Analysis edition for OLAP workspaces to BI platform. However, you cannot set the workspaces to run on a recurring schedule.
Organizing Objects

5.1 Folders

Folders are objects used to group and organize other objects so that content is separated into logical groups. Because you can set security at the folder level, you can use folders to control access to information.

It is a good practice to set up folders in a structure that already exists in your organization (such as departments, regions, or your database table) and then use categories to set up an alternate system of organization.

Each object in the BI platform must reside in a folder. By default, new objects that you add to a folder inherit the object rights of the folder.

5.1.1 To create a folder

Before creating a new top-level (parent) folder, confirm that you are viewing All Folders.

**Tip:**
To edit the name, description, or keywords for a folder, select the folder, and select Manage > Properties.

1. In the CMC, select the Folders area.
2. Go the location where you want to create a folder.
   - If you are creating a subfolder, locate the target folder where you want to put the new folder.
3. Select Manage > New > Folder.
4. In the "Create Folder" dialog box, type a name for the new folder, and click OK.

The new folder appears in the list of folders and objects.

You can add objects to the folder or edit the folder properties.

5.1.2 To delete a folder
1. In the CMC, select the **Folders** area.
2. Locate and select the folder to delete.

   **Tip:**
   To simultaneously delete several folders, hold down the **CTRL** key or the **SHIFT** key, and click each folder to delete.

3. Select **Manage > Delete**.
   A "Delete" message box appears.
4. Click **OK** to confirm the deletion.

   The folder, all subfolders, reports, and other objects in the folder are removed from the BI platform.

### 5.1.3 Copying and moving folders

When you copy or move a folder, the objects in it are copied or moved. BI platform treats a folder's object rights differently, depending on whether you are copying or moving the folder.

When you copy a folder, the copy does not retain the original folder's object rights. Instead, the copy inherits object rights from its new parent folder. For example, if you copy a private **Sales** folder to a **Public** folder, the new **Sales** folder has the object rights of the **Public** folder and is accessible to all users who have access rights to the **Public** folder.

When you move a folder, the folder retains its object rights. For example, if you move a private **Sales** folder to a publicly accessible folder, the **Sales** folder will remain private and will be inaccessible to most users.

### 5.1.3.1 To copy or move a folder

1. In the CMC, select the **Folders** area.
2. Select the folder to copy or to move.
   If a folder is not at the top level, locate its parent folder, and select the parent folder's contents.

   **Tip:**
   To simultaneously copy or move several folders, hold down the **CTRL** key or the **SHIFT** key, and click each folder to copy or to move.

3. Select **Organize > Copy To** or **Organize > Move To**.
   A "Copy To" or "Move To" dialog box appears.
4. Select the destination folder.
5. Click **Copy** or **Move**.
The folder you selected is copied or is moved to the new destination.

5.1.4 Specifying folder rights

You can change the object rights for new folders you create. By default, new objects that you add to a folder inherit the object rights of the parent folder. For more information about rights, see the information about setting rights in the SAP BusinessObjects Business Intelligence Platform Administrator Guide on the SAP Help Portal at http://help.sap.com.

5.1.5 To limit report instances at the folder level

Setting limits enables you to automatically delete report instances in the BI platform. The limits you set on a folder affect all objects in the folder. At the folder level, you can set limits for:

- The number of instances for each object, user, or user group
- The number of days that instances are retained for a user or a group

1. In the CMC, select the Folders area.
2. Locate and select the folder for which to set limits, and select Actions > Limits. The "Limits" dialog box appears.
3. Select the Delete excess instances when there are more than N instances of an object check box, and in the box, type the maximum number of instances per object the folder can contain before instances are deleted. The default value is 100.
4. Click Update.
5. To limit the number of instances per user or group, beside Delete excess instances for the following users/groups, click Add.
6. Select a user or a group, click > to add the user or group to the Selected users/groups list, and click OK.
7. For each user or group you added in step 6, in the Maximum instance count per object per user box, type the maximum number of instances you want to appear in the BI platform. The default value is 100.
8. To limit the age of instances per user or group, beside Delete instances after N days for the following users/groups, click Add.
9. Select a user or a group, click > to add the user or group to the Selected users/groups list, and click OK.
10. For each user or group you added in step 9, in the Maximum instance age in days box, type the maximum age for instances before they are removed from the BI platform.
The default value is 100.

11. Click Update.

Related Topics
• To set limits for instances

5.1.6 To view personal folders

You must have at least the View access right for a folder before you can view it.

BI platform creates a folder for each user on the system. Folders are organized in the CMC as personal folders. By default, there is a personal folder for the Administrator and for Guest accounts. When you log on to the CMC and view the list of personal folders, you see only folders to which you have at least the View access right. In BI launch pad, the folders are called the Favorites folders.

1. In the CMC, select the Folders area.
2. Click Personal Folders.
   A list of folders appears. Each folder corresponds to a user account on the system.

5.2 Categories

Categories organize objects so that users can more quickly locate the objects. There are two types of categories—corporate and personal.

You can assign rights to a category as an object (that is, grant groups and users rights to it). However, an object in a category inherits the rights of the folder it resides in, not the rights of the category.

For example, you can organize content in departmental folders and then use categories to create an alternate filing system that divides content by roles in your organization, such as managers or VPs. This organizational model allows you set security on groups of documents based on department or job role.

5.2.1 Working with categories
You can associate documents with multiple categories, and you can create subcategories within categories.

Corporate categories are created and managed by administrators or other users with access rights to categories. Corporate categories are visible only to groups and users with rights to view them.

Personal categories are created and managed by individual users to organize personal documents. All objects must reside in folders, but category assignment is optional. An object can reside in multiple categories. Personal categories are visible only to the creator.

### 5.2.1.1 To create a new category

1. In the CMC, select the **Categories** area.
2. Select **Manage > New > Category**.
   
   The "Create Category" dialog box appears.
3. In the **Enter a new category name** box, type a name for the category.
4. Click **OK**.

   The category is added to BI platform.

### 5.2.1.2 To delete a category

When you delete a category, all subcategories in it are deleted. However, reports and other objects in the category are not deleted from BI platform.

1. In the CMC, select the **Categories** area.
2. Select the category to delete.
   
   If a category is not at the top level, locate the parent category and then the subcategory.

   **Tip:**
   
   To simultaneously delete several categories, hold down the **CTRL** key or the **SHIFT** key, and click each category to delete.

3. Select **Manage > Delete**.
   
   A "Delete" message box appears.
4. Click **OK** to confirm the deletion.

   The category is deleted from BI platform.
5.2.1.3 To move a category

When you move a category, the category retains the objects associated with it and its object rights.

For example, you have a South American Sales category that is accessible only to people in that region and a World Sales category containing worldwide sales reports that is accessible to all people. You move the region categories to the World Sales category. The South American Sales category retains its rights and associated objects, even though it is a subcategory of the World Sales category.

1. In the CMC, select the **Categories** area.
2. Select the category to move.
   
   If a category is not at the top level, locate its parent category and then the subcategory.

   **Tip:**
   
   To simultaneously move several categories, hold down the **CTRL** key or the **SHIFT** key, and click each category to move.

3. Select **Organize > Move To**.

   **Tip:**
   
   If there are many categories in BI platform, type the category name in the **Search title** box—or click **Previous**, **Next**, or + (plus sign) to browse the category list.

   The “Move To” dialog box appears.

4. Select the destination category, and click **Move**.

   The category is moved to the new destination.

5.2.1.4 To add an object to a category

1. In the CMC, select the **Folders** area.
2. Locate and select the object to add to a category.
3. Select **Manage > Categories**.
   
   The “Categories” dialog box appears.

4. Select the category to which to add the object.
5. Click **Save & Close**.

   The object is added to the category.
5.2.1.5 To remove or delete objects from a category

When you remove an object, you remove it from the category but the object remains in BI platform. When you delete an object, you remove it from the category and delete it from BI platform.

1. In the CMC, select the Categories or Personal Categories area.
2. Double-click the category from which to remove or to delete an object.
3. Select the object(s) to remove or to delete.
4. Perform one of the following actions:
   - Select Actions > Remove From Category to remove the object from the category but not from the BI platform.
   - Select Manage > Delete to remove the object from the category and delete it from BI platform.
   
   A "Remove from Category" or "Delete" dialog box appears.
5. Click OK to confirm the removal or deletion.

The object is removed or deleted.

5.2.1.6 Specifying category rights

You can assign rights to a category as an object (that is, grant groups and users rights to it). However, an object in a category inherit rights from the folder where it is located, not from the category's rights.


5.2.1.7 To view a user's personal categories

If you have the appropriate access rights, you can view, edit, and delete personal categories for users.

1. In the CMC, select the Categories area.
2. Click the user account for which to view personal categories.

A list of the user's personal categories appears.
5.2.1.8 To add multiple objects to a category

1. In the CMC, select the **Categories** area or the **Personal Categories** area.
2. Locate and select the category to which to add objects.
3. Select **Actions > Add to Category**.
   
   The "Add to Category" dialog box appears.
4. Under **Available Objects**, locate the objects to add, and click ▶️ to move the objects to the **Selected Objects** list.
5. Click **OK**.

The objects are added to the category.
Working With Content Objects

6.1 General object management

Many types of objects can exist in BI platform, including:

- SAP Crystal Reports
- Web Intelligence documents
- Programs
- Microsoft Excel, Word, and PowerPoint files
- Adobe PDF files
- RTF files
- Text files
- Hyperlinks
- Object packages
- Actions

After adding objects, you manage them in the Folders area of the CMC.

6.1.1 To copy an object

1. In the "Folders" area, browse for the object that you want to copy and select it.
2. Click Organize > Copy To.
   The "Copy" dialog box appears.
3. In the Select destination(s) area, browse for the destination folder you want to copy the object to, and click > to move it to the Destinations list.
   
   **Note:**
   In order to move the destination folder, you must select that folder in the details pane on the right.

   **Tip:**
   Use SHIFT + click or CTRL + click to select multiple folders.
4. When you are finished, click Copy.
   The object you selected is copied to the destination.
6.1.2 To move an object

1. In the "Folders" area, browse for the object you want to move and select it.
2. Click Organize > Move To.
   The "Move" dialog box appears.
3. Select the destination folder.
   **Note:**
   In order to move the destination folder, you must select that folder in the details pane on the right.
   **Tip:**
   Use **SHIFT + click** or **CTRL + click** to select multiple folders.
4. Click Move.
   The object moves from the origin folder to the destination folder.

6.1.3 To create an object shortcut

Shortcuts are useful for granting a user access to an object without giving that user access to the entire folder in which the object is located.

After you create the shortcut, users who have access to the folder where the shortcut is located can access this object and its instances.

1. In the "Folders" area, browse for the object that you want to create a shortcut for and select it.
2. Click Organize > Create Shortcut In.
   The "Create Shortcut In" dialog box appears.
3. In the "Select destination(s)" area, browse for the folder you want to create a shortcut in, and click > to move the folder to the Destinations list.
   **Note:**
   In order to move the destination folder, you must select that folder in the details pane on the right.
4. Click Create Shortcut.
   A shortcut to the object appears in the folder you specified.

6.1.4 To delete an object
You can delete one or more objects, a folder (which deletes all objects and instances in that folder), or object instances (rather than the object itself).

**Note:**
When you delete an object, all of its existing instances and scheduled instances will be deleted.

1. Go to the "Folders" management area of the CMC.
2. Select the object that you want to delete.
3. Click **Manage > Delete**.
4. When you are prompted by a confirmation message, click **OK**.

**Related Topics**
- Managing instances

### 6.1.5 To search for an object or objects

The search feature enables you to search for specific text within object titles or descriptions.

1. Go to the "Folders" management area of the CMC.
   - The Search field is located in the upper right corner of the "Folders" management area. The search type is set to **Search title** by default.
2. Specify the search criteria.
   a. If you want to search by something other than the file name, click **Search title** to change the search type.
      - Your options are:
        - **Search all fields**
          - This option searches file names, keywords, and descriptions associated with objects.
        - **Search title**
          - This option is the default option and searches file names.
        - **Search keyword**
          - This option searches the keywords that are associated with objects.
        - **Search description**
          - This option searches the descriptions that are associated with objects.
   b. Enter the text that you want to search for in the Search field.
3. Click **Search**.
   - When the search is finished, a list of results that match your search criteria appears.
### 6.1.6 To create a new hyperlink

1. In the "Folders" or "Personal Folders" area, navigate to the folder in which you want to create a new hyperlink.
2. Click **Manage > New > Hyperlink**.
   The "Hyperlink" dialog box appears.
3. Enter a title, description, and keywords for your hyperlink.
4. In the navigation pane, click **URL**.
5. In the **URL** field, enter the URL.
6. Click **OK**.

### 6.1.7 To send an object or an instance to a destination

You can send either a copy of an object or instance, or a shortcut to the object or instance. You can also select the destination, for example, FTP or BI Inbox. Not all types of objects can be sent to all destinations.

**Note:**
You can use **Organize > Send** to send existing objects or instances of an object to different destinations. The **Send** command handles existing objects or instances only. It does not cause the system to run the object and create new instances, nor does it refresh the data for a report instance.

1. Go to the "Folders" management area of the CMC.
2. Select the object or instance that you want to send.
   - If you want to send an object, select it, click **Organize > Send** and choose a destination.
   - If you want to send an instance, select the object and click **Actions > History**. In the "History" dialog box, select an instance, click **Send**, and click the destination option that you want.

   Select only instances with a status of Success or Failed. Instances with a status of Recurring or Pending are scheduled and do not contain any data yet.
### Destination locations

Objects and publications can be scheduled, sent, and published to the following destination locations:

<table>
<thead>
<tr>
<th>Destination location</th>
<th>Description</th>
</tr>
</thead>
</table>
| **BI Inbox**         | Select to send the object to a user's BI Inbox in BI launch pad.  
You must send Web Intelligence documents to BI Inbox or to Email (to a destination configured in BI platform). |
### 6.1.7.2 Destinations by object type

Most destinations can be used for most types of objects, but there are some exceptions. In some cases, recipients must have access to BI platform to be able to open an object.

**Note:**
To use a destination, the destination must be enabled and configured on the Adaptive Job Servers. See “To enable or disable destinations for a job server”.

<table>
<thead>
<tr>
<th>Object type</th>
<th>Unmanaged Disk</th>
<th>FTP</th>
<th>Email (SMTP)</th>
<th>BI Inbox</th>
<th>SAP StreamWork</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>File</td>
<td>Link</td>
<td>File</td>
</tr>
<tr>
<td>Crystal report</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
## Working With Content Objects

<table>
<thead>
<tr>
<th>Object Type</th>
<th>Unmanaged Disk</th>
<th>FTP</th>
<th>Email (SMTP)</th>
<th>BI Inbox</th>
<th>SAP StreamWork</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>File</td>
<td>Link</td>
<td></td>
</tr>
<tr>
<td>Object package</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Program</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Web Intelligence document</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>SAP Business Objects Analysis edition for OLAP workspace</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Excel file</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Word file</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>PDF file</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Text file</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>RTF file</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>PowerPoint file</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Hyperlink</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Related Topics**
- To enable or disable destinations for a job server
6.1.8 To change the properties of an object

1. In the "Folders" management area of the CMC, select an object.
2. Click Manage > Properties.
   The "Properties" dialog box appears.
3. Make your changes.
   You can change the object name, keywords, and description.
4. When you are finished, click Save & Close.

6.1.9 Relationships

In BI platform, objects are related in several ways. Folders are related to their children, connections are related to the universes that use them, and reports and documents are related to universes.

It can be challenging to modify object relationships in BI platform because the changes may break links to the object. To find out which objects are directly related, you can perform a relationship query in the following areas of the CMC:

- Folders
- Personal Folders
- Categories
- Personal Categories
- Users and Groups
- Profiles
- Universes
- Access Levels
- Servers
- Replication Lists

After performing a relationship query, the "Query Results" dialog box appears, showing the results of the query. From the "Query Results" dialog box, you can perform basic object management tasks on result objects.

Example: Relationship queries

In this example, a company database will be replaced by a new database in a different location. The administrator needs to know which objects depend on the current connection so that the objects can be edited and the database connection can be deleted, without disrupting the content of objects. The administrator runs a relationship query on the connection, which returns a list of universes that use the connection. All universes can then be updated. At a later date, the company decides to delete all
objects that depend on the connection. The administrator can run then a relationship query on each universe returned in the first query results to determine which objects use the universes.

6.1.9.1 To check the relationships of an object

1. Navigate to the object for which you would like to run the relationship query.
2. Click Manage > Tools > Check Relationships.
   The "Query Results" area with the results of your relationship query is displayed.
   **Tip:**
   As required, perform further checks on the relations of result objects by selecting an object and choosing Manage > Tools > Check Relationships.
3. To navigate back to your original query, select the name of the object from the Tree panel.

6.2 Report object management

Managing report objects includes applying processing extensions, specifying alert notification, changing database information, updating parameters, using filters, and working with hyperlinked reports. This section explains report objects and instances and how to manage them in the Central Management Console (CMC).

**Note:**
Except for noted exceptions, most information in this section applies to Web Intelligence document objects.

6.2.1 What are report objects and instances?

A report object is created in SAP Crystal Reports, and a Web Intelligence document object is created in BI platform. Both types of objects contain report information (such as database fields) and may contain saved data.

Report objects and Web Intelligence document objects can be made available to all users or to individual users in selected groups.

**Scheduled instances**
You can schedule objects in the CMC, in BI launch pad, or in a custom web application.
When you schedule an object, BI platform creates a scheduled instance for the object that contains object and schedule information but no data. The scheduled instance appears in the "History" window for an object and has a status of Recurring or Pending.

Typically, report objects are designed to create several instances with varying characteristics. For example, if you run a report object with parameters, you can schedule one instance that contains report data for one department and another instance that contains data for another department, even though both instances originate from the same report object.

**Object instances**

At the specified time, BI platform runs the object and creates an object instance containing data. The instance appears in the "History" window for the object and has a status of Success or Failed.

**Changing default settings for an object**

Changes made to an object affect the default values for that object but do not affect scheduled instances or object instances. The next time you schedule the object in the CMC or in an application such as BI launch pad, the new default values appear. You can then change the default values as needed for the scheduled instance.

**Note:**

BI platform supports reports created in SAP Crystal Reports versions 6 to 2011. Once added to BI platform, reports are saved, processed, and appear in version 2011 format. However, reports created in BI platform remain in SAP Crystal Reports for Enterprise format.

**Related Topics**

- [Scheduling](#)

---

### 6.2.2 Setting report refresh options

**Note:**

This feature applies only to Crystal reports.

Refresh options determine which settings of a report object are updated when you refresh the report in BI platform.

When a report object is refreshed, BI platform compares the report object in the CMC with the original .rpt file on the Input File Repository Server.

- If report elements are different in the source report .rpt file and the report object, BI platform deletes or adds elements to the report object so that it matches the .rpt file, overwriting any changes made in the CMC.
- If report elements are the same in the source report .rpt file and the report object, you can use refresh options to determine which report object elements are updated with source .rpt file values.

If a prompt appears in the source .rpt file and in the report object—and the Current and default parameter values check box is selected—BI platform updates the default value of the prompt in the
report object, overwriting any changes made in the CMC. For example, when a prompt is in the source report .rpt file, refreshing the report adds that prompt to the report object, regardless of the report refresh options selected.

To preserve changes to report elements when refreshing a report, clear the appropriate check box. Clear the **Current and default parameter values** check box to preserve the current or default values of prompts in a report object when the report is refreshed. Clear the **Use Object Repository when refreshing report** check box to avoid refreshing repository objects in a report object against the original .rpt file on the Input File Repository Server.

### 6.2.2.1 To set refresh options for a report

This feature applies only to Crystal reports.

1. In the CMC, select the Folders area.
2. Select a report, and select **Actions > Refresh Options**.
3. In the “Refresh Options” dialog box, select the report elements to refresh from the source .rpt file.
4. Click **Update**.

   **Tip:**
   You can click **Refresh report** to immediately refresh the report.

### 6.2.3 Setting report viewing options

**Note:**
This feature does not apply to Web Intelligence documents.

BI platform report viewing options balance the need for up-to-date information with optimized data retrieval times and overall system performance.

Data sharing allows multiple users accessing the same report object to use the same data when viewing or refreshing the report. Data sharing can reduce the number of database calls, which reduces the time needed to generate an instance of the same report for subsequent users and improves overall system performance.

You can set data sharing options on a per-report or a per-server basis:

- If you specify which servers a report uses for viewing, set per-server options to standardize data sharing for groups of reports and centrally administer the settings.

- If some reports should not share data, set per-report options that enable you to decide on a report-by-report basis whether to allow database access when refreshing reports. For example, you can set the data sharing interval for each report.
Data sharing may not be useful for all organizations or for all reports. To get the maximum value from data sharing, you must permit data to be reused for a period of time. This means that some users may see older data when viewing a report on demand or when refreshing a report instance.

The default report viewing options for BI platform emphasize data freshness and integrity. By default, when you add a report to BI platform, the report is configured to use per-server options for report sharing. This enables users to see up-to-date information when refreshing a report and guarantees that the oldest data displayed is zero minutes old. If you configure per-report options, the default settings allow data sharing, allow viewer refreshes to retrieve fresh data from the database, and ensure that the data displayed is no more than five minutes old.

**Tip:**
Disabling the sharing of report data is not the same as setting the **Oldest on-demand data given to a client** option to zero minutes. Under high load volumes, BI platform may receive more than one request for the same report instance at the same time. In this case, if the data sharing interval is set to zero minutes, but the **Share report data between clients** option is selected, BI platform shares data between the client requests. If it is important that data not be shared between clients—for example, because a report uses a User Function Library (UFL) that is personalized for each user—you must disable data sharing for the report.

### 6.2.3.1 To set report viewing options for a report

1. In the CMC, select the **Folders** area.
2. Locate and select a report for which to set viewing options.
3. Select **Manage > Default Settings**.
   
   The "Default Settings" dialog box appears.
4. Click **Viewing Server Group** in the navigation list.
5. Under **Data refresh for viewing**, select **Use report specific viewing settings**, and select options for the report.
6. Click **Save & Close**.

### 6.2.4 Specifying default job servers

Specify the default job server that BI platform uses to run a report object and to schedule and process instances.

For report objects and Web Intelligence documents, you can specify the default server that BI platform will use when a user views or modifies a report or a Web Intelligence document.

Processing report objects on specific job servers or server groups can balance the load on your system. Use one of the following options to specify default job servers:
• Select **Use the first available server** if you want BI platform to use the server with the most available resources.

The Central Management Server (CMS) checks the percentage of the maximum load on each job server to see which server has the lowest load. If all job servers have the same load percentage, the CMS randomly picks a job server.

• Select **Give preference to servers belonging to the selected group**, and select a server group in the list.

BI platform attempts to process the object on a server in the selected server group. If no servers in the selected group are available, the object is processed on the next available server. If no servers in that group are available, BI platform uses any available server.

• Select **Only use servers belonging to the selected group** to use only servers in the selected server group.

If no servers in the group are available, the object is not processed.

Depending on the type of object, BI platform uses the following job servers to process objects:

• Crystal reports run on the Adaptive Job Server, the Crystal Reports 2011 Server or Crystal Reports Processing Server (depending on the designer used to create the report), and the Crystal Reports Cache Server.

• Web Intelligence documents run on the Web Intelligence Processing Server.

You must create server groups before users can select a group.

You can set the maximum number of jobs that a server will accept. For more information, see the *SAP BusinessObjects Business Intelligence Platform Administrator Guide*.

---

### 6.2.4.1 To select default servers for processing an object

1. In the CMC, select the **Folders** area.
2. Select the report object for which to specify default servers.
3. Select **Manage > Default Settings**.
   
   The "Default Settings" dialog box appears.
4. Perform one of the following actions:
   
   - To specify the default servers for scheduling a report object, select **Scheduling Server Group** in the navigation list.
   - To specify the default servers for processing an object when you view it, in the navigation list, click **Viewing Server Group** if the object is a Crystal report or **Web Intelligence Process Settings** if the object is a Web Intelligence document.
5. Click **Save & Close**.
**Related Topics**

- **Specifying default job servers**
  
  Specify the default job server that BI platform uses to run a report object and to schedule and process instances.

---

**6.2.5 To change database settings**

**Note:**

- This feature does not apply to Web Intelligence documents.
- If you selected multiple report objects for which to change database settings, only report objects with the same data source connection are updated.

You can select the database type, set default database logon information, view the data source or data sources for a report object and its instances, and optionally prompt users for a logon name and password when viewing a report instance.

For information about supported databases and drivers, see the supported platforms documents on the SAP Service Marketplace.

1. In the CMC, select the **Folders** area.
2. Select a report object for which to change the database settings.
3. Select **Manage > Default Settings**.
   
   The "Default Settings" dialog box appears.
4. Click **Database Configuration** in the navigation list.
5. Perform one of the following actions:
   - Select **Use original database logon information from the report**, and type a user name and password for the original report database.
   - Select **Use custom database logon information specified here**, and type a server name (or a DSN for an ODBC data source), database name, user name, and password for predefined database drivers or for a custom database driver. If you changed the default table prefix in your database, specify a custom table prefix.

6. To select a database logon option, perform one of the following actions:
   - Select **Prompt the user for database logon** to prompt users for a password when they refresh a report.
     
     The BI platform prompts users the first time they refresh a report. When users refresh the report again, they are not prompted. This option does not effect scheduled instances.
   - Select **Use SSO context for database logon** to use the user's logon and password to log on to the database.
The BI platform must be configured for end-to-end single sign-on or for single sign-on to the database. For more information, see the SAP BusinessObjects Business Intelligence Platform Web Application Deployment Guide.

- Select **Use same database logon as when report is run** to use the same database logon information that was used when the report ran on the job server.

- Select **Use user database credentials for database logon** to use the database credentials specified for the user account.

7. Click **Save & Close**.

### 6.2.6 To update default prompt values for a Crystal report

**Note:**
This feature applies only to Crystal reports.

Parameter fields (with preset values) enable users to view and to specify which data appears in the BI platform. When a report contains parameters, you can set the default value for each parameter. The default values are used when a report instance is generated.

Using a BI platform application such as BI launch pad, your users can open a report with the default value(s) or choose other value(s). If you do not specify a default value, users are prompted for a value when scheduling a report.

1. In the CMC, select the **Folders** area.
2. Select a report object for which to update the default prompt values.
3. Select **Manage > Default Settings**.
   The "Default Settings" dialog box appears.
4. Click **Prompts** in the navigation list.
   This option is available only if a report object contains parameters. If it does not contain parameters, this option is not available; skip this step.
5. In the **Default Value** column, type or select a default value for the parameter.
   Options appear for changing the default value. Depending on the parameter value type, you can type a value in the box or choose a value in a list.
6. Click the **Clear Value** button to clear the current value set for the parameter.
7. Select the **Prompt when viewing** check box to prompt users before they can view a report instance in a BI platform application.
8. Click **Save & Close**.
6.2.7 To update prompts for a Web Intelligence document

Note:
This feature applies only to Web Intelligence documents.

Prompt fields (with preset values) enable users to specify which data they see. When a report contains parameters, you can set the default prompt value for each parameter. The default value is used when a report instance is generated.

Through an application in the BI platform such as BI launch pad, users can either use the report with the preset default value(s) or choose other value(s). If you do not specify a default value, users are prompted for a value when scheduling a report.

1. In the CMC, select the Folders area.
2. Select a Web Intelligence document for which to update prompts.
3. Select Manage > Default Settings.
   The “Default Settings” dialog box appears.
4. Click Prompts in the navigation list.
   This option appears only if the Web Intelligence document object contains prompts. If it does not contain prompts, this option is not available.
5. Click Modify.
6. Select a prompt, and enter a value for it.
   
   Tip:
   If the available values do not appear, click the Refresh Values button.
7. Repeat steps 5 and 6 for each prompt value you want to change.
8. Click Apply.
9. Click Save & Close.

Related Topics
• To update default prompt values for a Crystal report

6.2.8 Filtering reports

You can set the default selection formulas for a report. Selection formulas are similar to parameter fields—they filter results so that only required information appears. However, users are not prompted for selection formula values when viewing or refreshing a report. When users schedule reports in a web-based client application, such as BI launch pad, they can optionally modify selection formulas for
the reports. By default, the web-based client application uses the formulas defined in the CMC. For more information about selection formulas, see the *SAP Crystal Reports for Enterprise User's Guide*.

In addition to changing selection formulas, if you created processing extensions, you can select which extensions to apply to a report. When you use filters with processing extensions, a subset of the processed data is returned. Selection formulas and processing extensions act as filters for a report.

**Note:**
Selection formulas and processing extensions do not apply to Web Intelligence documents, SAP Crystal reports in `.rptr` format, or reports created in SAP Crystal Reports for Enterprise.

### 6.2.8.1 To use filters

**Note:**
This feature does not apply to Web Intelligence documents, SAP Crystal reports in `.rptr` format, or reports created in SAP Crystal Reports for Enterprise.

1. In the CMC, select the **Folders** area.
2. Select a report object for which to add filters.
3. Select **Manage > Default Settings**.
   
   The "Default Settings" dialog box appears.
4. Click **Filters** in the navigation list.
5. To update or add new selection formulas, perform one of the following actions:
   
   • In the **Record selection** box, create or edit one or more record selection formulas that limit the records used when a report is scheduled.
   
   • In the **Group selection** box, create or edit one or more group selection formulas that limit the groups used when a report is scheduled.
6. Click **Save & Close**.

### 6.2.9 Setting printer and page layout options

**Note:**
This feature does not apply to Web Intelligence documents.

You can optionally print Crystal report instances when scheduling a report or each time a report runs. Report instances always print in Crystal reports format.
Choosing the page layout

When viewing or scheduling a report instance to any format, you can choose page layout criteria, such as page orientation and page size. A report instance's page layout determines the overall look of the report and affects how the instance prints. The overall look is also affected by properties of the device displaying the report—for example, font metrics and other layout settings of the viewer and/or the printer.

Choosing a printer

Before you can choose a printer, the Crystal Reports Job Server must be running under an account that has access rights to the printer.

You can print report instances to the Crystal Reports Job Server's default printer or a different printer and select typical printing options.

6.2.9.1 To select a printer

**Note:**
This feature does not apply to Web Intelligence documents.

1. In the CMC, select the **Folders** area.
2. Select a report object to assign a printer to.
3. Select **Manage > Default Settings.**
   The “Default Settings” dialog box appears.
4. Click **Print Settings** in the navigation list.
5. Under **Print Settings**, select the **Print Crystal reports when scheduling** check box.
   Crystal reports will be sent to the printer in SAP Crystal Reports format, which does not interfere with the page layout you selected when scheduling the report.
   Additional options appear.
6. In the **Number of Copies** box, type the number of copies to print.
7. Under **Page Range**, select **All** to print all report pages, or select **Pages** and type the first and last pages to print in the boxes.
8. In the **Set collate option to** list, perform one of the following actions:
   - Select **Collate** to collate the report.
   - Select **Do not collate** if you do not want to collate the report.
   - Select **Use printer defaults** to use the default collation setting of the printer.
9. In the **Page Scaling** list, perform one of the following actions:
   - Select **Scale to fit** to proportionately scale the report page to fit the printed page.
   - Select **Only shrink to fit** to shrink the report page to fit the printed page.
   - Select **Do not scale** if you do not want to scale the report.
10. Select the **Center the page** check box to center the report on the printed page.
11. Select the **Fit horizontal pages into one page** check box to fit horizontal pages on one printed page.

12. Under **Specify page layout**, perform one of the following actions:
   - Select **Default printer** to print to the Crystal Reports Job Server's default printer.
   - Select **Specify a printer**, and type the printer's path and name in the box.
     
     If your job server is on Windows, type `\printserver\printername`, where `printserver` is the name of the printer server and `printername` is the name of the printer.
     
     If your job server is on Unix, confirm that the Unix printer is shown (not hidden), and type the print command you normally use, such as `lp -d printername`.

13. Click **Save & Close**.

### 6.2.9.2 To select page layout options for Crystal report and PDF objects

1. In the CMC, select the **Folders** area.
2. Select a report object to set the page layout for.
3. Select **Manage > Default Settings**.
   
   The "Default Settings" dialog box appears.
4. Click **Print Settings** in the navigation list.
5. Under **Print Settings**, to select the default print mode, perform one of the following actions:
   - Select **Always print to PDF (Preview)** to use PDF print settings when printing the report from a web viewer.
   - Select **Follow Crystal Reports preference setting** to use the default Crystal report print settings defined in the CMC preferences.
6. Under **Specify page layout**, in the **Set layout to** list, perform one of the following actions:
   - Select **Report file default** to use the page layout defined in Crystal Reports.
   - Select **Specify printer settings** to use the printer's default page layout, and select the Crystal Reports Job Server default printer or a different printer.
     
     You can print scheduled report instances only to the printer specified under **Print when scheduling**. That is, you cannot set a report to use the default page layout of one printer and then print to a different printer.
   - Select **Custom settings** to customize all page layout settings, and select the page orientation and page size.
7. Click **Save & Close**.

**Related Topics**

* Setting printer and page layout options
6.2.10 Processing extensions

**Note:**
This feature does not apply to Web Intelligence documents, Crystal reports in `.rptr` format, or reports created in SAP Crystal Reports for Enterprise.

A processing extension is a dynamically loaded library of code that applies your business logic to particular view or schedule requests before they are processed by BI platform. You use customized processing extensions to add security to your reporting environment.

Through processing extensions, the BI platform administration SDK exposes a handle that enables developers to intercept a view or schedule request and then append selection formulas to the request, before a report is processed. Included in the SDK is a fully documented API that developers can use to write processing extensions. For more information, see the developer documentation on the product CD.

**Example:** Report-processing extension to enforce row-level security

This type of security restricts data access by row, in one or more database tables. A developer writes a dynamically loaded library that intercepts view or schedule requests for a report, before the requests are processed by the Adaptive Job Server, Crystal Reports Processing Server, or Report Application Server. The developer's code determines which user owns the processing job and then looks up the user's data-access privileges in a third-party system. The code generates and appends a record selection formula to the report to limit the data returned from the database. In this example, the processing extension adds customized row-level security to BI platform.

**Applying processing extensions to reports**

You must register a processing extension in the CMC before you can apply it to a report object. You can apply more than one processing extension to a report object. BI platform server components dynamically load the processing extensions at run-time.

On Windows, dynamically loaded libraries are referred to as dynamic-link libraries (.dll). On Unix, dynamically loaded libraries are often referred to as shared libraries (.so). Processing extension names must include the file extension but cannot include a backward slash (`\`) or a forward slash (`/`).

**6.2.10.1 To apply a processing extension to a report**

Before you can apply a processing extension to a report object, the processing extension must be registered in the CMC.
**Note:**
This feature does not apply to Web Intelligence documents, Crystal reports in .rptr format, or reports created in SAP Crystal Reports for Enterprise.

You can apply more than one processing extension to a report object.

1. In the CMC, select the **Folders** area.
2. Select the report object to apply a processing extension to.
3. Select **Manage > Default Settings**.
   
   The "Default Settings" dialog box appears.
4. Click **Extensions** in the navigation list.
5. In the **Available processing extensions** list, select a processing extension, and click \( \) to move it to the **Use these processing extensions (in the order listed)** list.
   
   The **Available processing extensions** list contains only registered processing extensions.
6. Use the **Move Up** and **Move Down** buttons to set the order in which to use processing extensions.
7. Click **Save & Close**.
   
   The processing extension(s) are assigned to the report object.

### 6.2.11 Working with hyperlinked reports

**Note:**
This feature does not apply to Web Intelligence documents or reports created in SAP Crystal Reports for Enterprise.

In SAP Crystal Reports, you use hyperlinks to navigate between report objects—a Report Part in a report, other report objects or their parts, or specific instances of reports or Report Parts. BI platform includes script-based DHTML viewers (zero-client, server-side) for Crystal report navigation. By linking directly from one report object to another, the required data context is passed automatically so that data is relevant when you navigate to an object.

Initially, when you add hyperlinks between reports in SAP Crystal Reports, you create a link from one file directly to another. However, when you simultaneously add linked report files to the same object package, the links are updated to point to managed report objects. (Each link is modified to reference the appropriate destination report by Enterprise ID, rather than by file path.) The modified links become relative inside the object package.

When you schedule the object package, BI platform processes the reports and again modifies the hyperlinks in each report instance. In a specific instance of the object package, hyperlinks between report objects are converted to hyperlinks between report instances.

To view hyperlinked reports, you must add both the home report and the destination report to BI platform. (A home report is one that contains a hyperlink to the destination report.)

For information about creating hyperlinks between report objects, see the SAP Crystal Reports Help.
6.2.11.1 Adding reports with existing hyperlinks

**Note:**
This feature does not apply to Web Intelligence documents.

The best practice for creating hyperlinked reports is to publish individual reports and then create hyperlinks between them.

Use the Report Upload Wizard in the SAP Crystal Reports 2011 designer to add linked reports to the same object package. When you publish reports this way, hyperlinks are converted to relative links.

**Note:**
If you individually add hyperlinked reports to the repository (instead of simultaneously adding them to the same object package), the hyperlinks between reports will break. You must re-establish the links using SAP Crystal Reports and then save the report to BI platform. For more information, see the SAP Crystal Reports Help.

Related Topics
- To add reports to the repository and hyperlink them

6.2.11.2 Viewing hyperlinked reports

BI platform supports navigation between hyperlinked reports only for script-based viewers, specifically the DHTML and Advanced DHTML viewers in BI launch pad.

**Note:**
This feature does not apply to Web Intelligence documents or to reports created in SAP Crystal Reports for Enterprise.

To change the viewing format, in the CMC, click Preferences in the upper-right corner of the window, click CMC Preferences, and select your preferred viewing locale (PVL). For more information about changing your preferred viewing locale, see the SAP BusinessObjects Business Intelligence Platform Launch Pad User Guide.

Parameter information is not transferred from the home report to destination reports. That is, when you view a destination report by clicking a hyperlink in a home report, you are prompted to enter parameters that the destination report requires.
Security considerations
To view hyperlinked reports in BI platform, you must have access rights both in BI platform and at the database level.

In BI platform, to be able to view a destination report via a hyperlink in a home report, you must have View rights for the destination report. When the hyperlink points to a report object, you must have View On Demand rights to be able to refresh data in the report object against its source.

Database logon information is carried over between hyperlinked reports. If the credentials you entered to view the home report are not valid for the destination report, you are prompted to enter valid database logon credentials for the destination report.

6.2.11.3 To add reports to the repository and hyperlink them

Note:
This feature does not apply to Web Intelligence documents or to reports created in Crystal Reports for Enterprise.

To avoid breaking hyperlinks between reports, add the reports first and then create hyperlinks. For more information about tasks in SAP Crystal Reports, see the SAP Crystal Reports Help.

1. In Crystal Reports, create the reports without hyperlinks.
2. Add the reports to BI platform.
3. Use Crystal Reports to log on to the BI platform.
4. Create hyperlinks between the home report and the destination report.

Crystal Reports automatically determines whether to establish a relative or absolute link between the reports. In the BI platform, relative links are assigned to reports in the same object package, and absolute links are assigned to individual report objects or instances.

6.2.12 To show a thumbnail image of a Crystal report’s first page

1. In the CMC, select the Folders area.
2. Locate and select the report for which to show a thumbnail image of the first page.
3. Select Manage > Default Settings.
   The "Default Settings" dialog box appears.
4. Click Thumbnail in the navigation list.
5. Select the Show report thumbnail check box.
6. Click Save & Close.
6.2.13 To view alerts in Crystal reports

The BI platform tracks report instances that trigger alerts. You can view the alerts for reports created in SAP Crystal Reports.
1. In the CMC, select the Folders area.
2. Locate the folder or category that contains the Crystal report you want to view, and select the object.
   
   The “Alerts” dialog box appears, displaying the instances that triggered an alert.
4. Double-click a title to open the report instance.

6.2.14 To view the universes for a Web Intelligence document

A universe is a representation of the information available in a database. You build queries for Web Intelligence documents using objects in a universe. In CMC, you can view which universes are used by a Web Intelligence document.
1. In the CMC, select the Folders area.
2. Select the Web Intelligence document object for which to view universes.
3. Select Manage > Default Settings.
   
   The “Default Settings” dialog box appears.
4. Click Report Universes in the navigation list.
A list of the universes used by the document appears.

6.3 Working with reports in an integrated environment

This section contains information about working with reports in SAP NetWeaver Business Warehouse (BW) and in BI platform.

Note:
This section does not apply to reports created in SAP Crystal Reports for Enterprise.
### 6.3.1 Adding reports from BW to BI platform

You can add reports from SAP NetWeaver Business Warehouse (BW) to BI platform in the following ways:

- After creating reports from BW queries, immediately add the reports to BI platform.
- In batches, add reports from BW to BI platform.

If you have Crystal Reports installed on your machine, you can design a report based on a BW query and then simultaneously save the report to BW and add it to BI platform from Crystal Reports. To enable this feature, in Crystal Reports, select SAP > Settings, and select Automatically publish to SAP BusinessObjects Enterprise.

#### 6.3.1.1 Adding Crystal reports to BI platform

You can add Crystal reports to BI platform in the following ways:

- Add reports to BI platform in batches. Use this method if you have already added a number of reports to SAP NetWeaver Business Warehouse (BW).
- Use the Report Upload Wizard in SAP Crystal Reports 2011 or in the Central Management Console (CMC) in BI platform.

#### 6.3.1.2 Adding reports in batches from BW

You can use Content Administration Workbench to add large numbers of Crystal reports to BI platform. For information about publishing in Content Administration Workbench, see the SAP BusinessObjects Business Intelligence Platform Administrator Guide.

### 6.3.2 Migrating development content to a production BW system

If BI platform is deployed in a development SAP NetWeaver Business Warehouse (BW) environment, you can import report content that is configured for use with a production BW environment to BI platform. Before importing content, consider the following information:
• BW treats Crystal reports (.rpt files) as native objects. If Crystal reports are stored in the repository of your development BW system, you can transport the BW content and then add the reports in batches to BI platform. This process ensures that database information for each report is updated by NetWeaver BW Report Publisher. For information about transporting content between BW systems, search for “SAP Library” on the SAP Help Portal at help.sap.com.

• If you deleted some or all Crystal reports from the repository of the development BW system, you can use Life Cycle Manager to import report objects from one BI platform installation to another BI platform installation. When using Life Cycle Manager, you must set the correct database information on each report file you import.

• If you are migrating a small number of report files, it may be easier to change each report's database information in the CMC. (In the Folders area, locate the report, and select Actions > Database Configuration.)

After migrating content, use Content Administration Workbench to perform maintenance tasks on the reports. Report maintenance tasks include synchronizing information about reports between BI platform and BW (updating the status), deleting unwanted reports, and updating reports migrated from earlier versions of BI platform (post-migration).

### 6.3.3 Viewing reports

You can view Crystal reports in a number of applications, depending on how BI platform is integrated with SAP NetWeaver Business Warehouse (BW). For example:

• You can log on to BI launch pad with your SAP credentials and view reports.
• You can open reports in a web browser in SAP Easy Access.

### 6.3.3.1 To view a report in BI launch pad

1. In a web browser, type the URL for BI launch pad: http://webserver:portnumber/BOE/BI

   Replace webserver with the name of the web server and portnumber with the port number for BI platform.

   **Tip:**

   If BI platform is installed, select Start > Programs > SAP Business Intelligence > SAP BusinessObjects BI platform 4 > SAP BusinessObjects BI platform Java BI launch pad.

   The "Log On to BI launch pad" dialog box appears.

2. In the Authentication list, select the SAP check box.
3. In the SAP System ID box, type the three-character ID (SID) for your SAP system.
4. In the SAP Client box, type your three-digit SAP client number.
5. In the **User Name** box and **Password** box, type your SAP logon credentials.

6. Click **Log On**.
   You are logged on to BI launch pad.

7. Click the **My Groups** folder to quickly access all objects saved under your SAP roles and published to BI platform.
   For information about using BI launch pad, see the BI Launch Pad Help.

### 6.3.3.2 To view a published report in SAP Easy Access

1. Log on to SAP Easy Access.
2. Browsing your roles, locate the reports saved to SAP NetWeaver Business Warehouse (BW).
   **Tip:**
   Look for the Crystal report icon in BW.
3. Double-click the report.
   The report appears in the web browser. If you are prompted to log on to the SAP Web Application Server and/or to BI platform, enter your usual credentials.

### 6.3.4 Personalizing reports generated from BW queries

BI platform supports personalized variables in reports generated from SAP NetWeaver Business Warehouse (BW) queries. Reports based on BW queries can include variables that contain values used by the queries to limit or specify returned data. Typically, to run a report, you enter a value or select from a list of predefined values.

Using personalization in SAP Business Explorer (BEx), you can enter a value for a variable and save it as your personal default value. When the report runs, data is generated based on the variable value. If you run the same report again, you can use the saved default values.

**Note:**
Personalized values are user-specific. You can set personalized values for yourself, not for other users. Each user can set personalized values instead of using the preset values for a variable.

For more information about personalization, see the BW system documentation.
6.3.4.1 Parameters

Report variables are called parameters in BI launch pad. Before viewing or scheduling a report, you must choose a value for each parameter from a dynamic picklist.

Note:
The values available for parameters have been assigned to each variable in the SAP environment and filtered based on your SAP access rights.

In the "Enter Prompt Values" dialog box, you can perform the following tasks:

- Run a report with the default parameter values
- Select parameter values in dynamic picklists and run a report
- Enter a value for each parameter and run a report
- Personalize a value for each parameter and run a report
- Run a report with null values for all parameters

Note:
Some options are available only when they are enabled in a report's referenced SAP NetWeaver Business Warehouse (BW) query or in BI platform.

6.3.4.1.1 To view a report with default parameter values

The default values for a report's parameters are set in the SAP environment when a SAP NetWeaver Business Warehouse (BW) query is designed. Because a BI platform report is based on a BW query, the default values for query variables automatically become the default values for report parameters.

1. Log on to BI launch pad.
2. Double-click the report object for which you want to view default parameter values.
   The "Enter Prompt Values" dialog box appears.
3. Click OK.
   The report appears in a Crystal report viewer. Its data is based on the default values assigned to the parameter.

6.3.4.1.2 To view a report using parameter values from a dynamic picklist

Note:
This option is available only for SAP NetWeaver Business Warehouse (BW) query-based parameters. The choices in a parameter's dynamic picklist are based on values assigned to the variable in the SAP environment. The values you see in BI launch pad correspond to your access rights—only values for which you have rights are available.
1. Log on to BI launch pad.
2. Double-click the report object for which you want to set parameter values.
   The "Enter Prompt Values" dialog box appears.
3. Beside the first parameter to define, click the browse (...) button.
   The "Picklist" dialog box appears.
4. In the list, locate a value for the parameter, and click its hyperlink.
   The "Enter Prompt Values" dialog box appears again, with the value you selected displayed in the edit field for the parameter.
5. Repeat steps 3 and 4 for the remaining parameters, and click Execute.
   The report appears in a Crystal report viewer. Its data is based on the parameter values you selected.

6.3.4.1.3 Null parameter values in scheduled reports

When you schedule a report to run with a null parameter value, no value is passed to the SAP NetWeaver Business Warehouse (BW) query when the report is executed. Instead, the report uses the default value or a personalized value for variables. Personalized values override default values.

To change the parameter value used to run a report, click the report in BI platform and reschedule it with a new parameter. Because the report was initially scheduled to run with a null parameter value, no value is saved with the report. The next time you run the report, the new parameter value will be used to generate data.

If a variable does not have a default value or a personalized value, the report attempts to run without a value for the variable. Depending on the query, an error message may appear if the variable requires a value before the report can run.

To view a report with null parameter values

**Note:**
This option is available only for SAP NetWeaver Business Warehouse (BW) query-based parameters.
This feature is primarily used when scheduling reports.

1. Log on to BI launch pad.
2. Double-click the report object for which you want to set parameter values.
   The "Enter Prompt Values" dialog box appears.
3. For each parameter, select Set to null.
4. Click OK.
   The report appears in a Crystal report viewer. Its data is based on the default or personalized values assigned to the variables in the SAP environment.

6.3.4.1.4 Personalized parameter values in scheduled reports

When you set a recurring schedule for a report that contains a personalized parameter value, BI platform uses the personalized value in the report each time it runs.
Note:
After you personalize a value, BI platform saves the value and sets it as the permanent user-specific parameter value for the report. Even if you change the personalized value of a parameter, scheduled reports continue to display data based on the original personalized value.

After changing the personalized value of a parameter, perform the following actions to use the new value in scheduled reports:

• Reschedule reports with the new parameter value.
• Schedule reports to run with null values for the parameter. BI platform will evaluate the personalization values when the report runs.

To view a report with personalized parameter values

Note:
This option is available only for SAP NetWeaver Business Warehouse (BW) query-based parameters. It applies only to reports that are based on the SAP NetWeaver MDX driver.

Personalization enables you to set the default value for a parameter and save the value for future use. When you set a personalized value for a parameter, the personalized value becomes the default.

Personalized values are user-specific; you cannot define them for other users. Other users who work with the same report can set their own personalized values or use a preset value for a parameter. For more information about personalization, see the BW system documentation or contact your system administrator.

1. Log on to BI launch pad.
2. Double-click the report object for which to set parameter values.
   The "Enter Prompt Values" dialog box appears, listing the default values for report parameters beside Current value.
3. To personalize a value for a parameter, perform one of the following actions:
   • Select a value in the list, and click the personalize icon ( ) to set it as your personalized value.
   • Type a value in the parameter's edit box, and click the personalize icon to set it as your personalized value.

You can view the report with data that is based on the personalized value. In the future, if you view the same report, the personalized value is used to run the report, unless otherwise specified.

6.4 Program object management

This section explains program objects and instances, how to manage objects and instances in the Central Management Console (CMC), type-specific program object configuration, and security considerations for program objects.
6.4.1 What are program objects and instances?

A program object is an object in BI platform that represents an application. After adding a program object, you can schedule and run the object and manage access rights to it.

When you add a program object or its associated files to BI platform, the object or files are stored on the Input File Repository Server (FRS). Each time a program runs, the program and files are passed to the Program Job Server, and BI platform creates a program instance.

Unlike report instances, which you can view in the completed format, program instances exist as records in the object history. BI platform stores each program’s standard output and standard error in a text output file that appears when you click a program instance in an object’s history.

To successfully schedule and run a program object, log on to the account that the program object will use when it runs.

Related Topics
• What are program objects and instances?

6.4.1.1 Types of program objects

As the administrator, you can enable or disable any type of program object.

After you add a program object to the repository, you can configure it in the Folders area of the CMC. For each type of program object (Executable, Java, or Script), you can specify command-line arguments and a working directory. For executable and Java programs, there are additional ways, both required and optional, to configure program objects and provide them with access to other files.

You can add the following types of applications to the repository as program objects:

<table>
<thead>
<tr>
<th>Program object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executable</td>
<td>Executable programs are binary files, batch files, or shell scripts with file extensions such as .com, .exe, .bat, or .sh. You can add any executable program that can be run from the command line to the machine that runs the Program Job Server.</td>
</tr>
</tbody>
</table>
You can add any Java program to the BI repository as a Java program object. Script program objects are JScript and VBScript scripts. They run on Windows using an embedded COM object and can—once published—reference BI platform SDK objects.

**Note:** Script program objects are not supported on Unix.

**Tip:**
Use program objects to write, publish, and schedule scripts or Java programs that run on BI platform and to perform maintenance tasks such as deleting instances from the history. You can design the scripts and Java programs to access BI platform session information. This ensures that scheduled program objects retain the security rights or restrictions of the user who scheduled the job. (Your scripts and Java programs require access to the BI platform SDK. For more information, see BI platform SDK documentation, such as the *SAP Business Intelligence Platform Java SDK Developer Guide.*)

## 6.4.2 Setting program processing options

### 6.4.2.1 To specify command-line arguments

For each program object, you can specify command-line arguments with the **Default Settings** command on the **Manage** menu.

You can specify any argument that is supported by the command-line interface for your program. Arguments are passed directly to the command-line interface, without parsing.

1. In the “Folders” management area of the CMC, select the program object.
2. Click **Manage > Default Settings**.
   The “Default Settings” dialog box appears.
3. Click **Program Parameters** on the navigation list.
4. In the **Arguments** field, type the command-line arguments for your program, using the same format you would use at the command line itself.
   
   For example, if your program has a **loops** option, to set the loops value to 100, you might type `-loops 100`

5. Click **Save & Close**.

### 6.4.2.2 Setting the working directory for a program object

By default, when a program object runs, BI platform creates a temporary subdirectory in the Adaptive Job Server's working directory and uses the subdirectory as the working directory for the program. The subdirectory is automatically deleted when the program stops running.

You can specify an alternative working directory for the program object by selecting **Manage > Default Settings**, or you can changes the default working directory for the Adaptive Job Server.

The account under which a program object runs must have appropriate access rights to the folder that you select as the working directory. A program's account generally needs read, write, and execute permissions to a working directory. The level of file permissions required depends on what the program does.

#### 6.4.2.2.1 To set a working directory for a program object

1. In the "Folders" management area of the CMC, select the program object.
2. Click **Manage > Default Settings**.
   
   The "Default Settings" dialog box appears.

3. Click **Program Parameters** on the navigation list.
4. In the **Working Directory** field, type the full path to the directory that you want to set as the program object's working directory.
   
   For example, on Windows, if you created a working directory named `working_directory`, type `C:\working_directory`
   
   On UNIX, type `/working_directory`

5. Click **Save & Close**.

#### 6.4.2.2.2 To modify the default working directory for program objects

1. Go to the **Servers** area of the CMC.
2. Select the Adaptive Job Server that hosts the Program Scheduling Service.
   
   To check whether an Adaptive Job Server hosts the Program Scheduling Service, select the server and select **Manage > Properties**.

3. Click **Manage > Properties**.
   
   The "Properties" dialog box appears.
4. In the **Temporary Directory** box, enter the full path to the directory you want to set as the working directory.
5. Click **Save & Close**.

### 6.4.3 Configuring executable program objects

After you add an executable program object to CMC, you can perform the following actions:
- Configure the object to access external or auxiliary files
- Customize environment variables for the shell in which BI platform runs the program

**Related Topics**
- Configuring Java programs

#### 6.4.3.1 To specify the path to external or auxiliary files

Some binary files, batch files, and shell scripts require access to external or auxiliary files. In addition to defining a working directory for a program object, you can provide access to external or auxiliary files in the following ways:
- If a required file is on the same machine as the Adaptive Job Server that hosts the Program Scheduling Service, specify the full path to the file.
- If a required file is located elsewhere, upload the file to the File Repository Server, which passes the file to the Program Scheduling Service as needed.

1. In the CMC, select the **Folders** area.
2. Select the executable program object for which to specify the path.
3. Select **Manage > Default Settings**.
4. In the "Default Settings" dialog box, click **Program Parameters**.
5. In the **External Dependencies** box, type the full path to the file, and click **Add**.
   
   **Tip:**
   To edit or remove external dependencies, select the path under **External Dependencies**, and click **Edit** or **Remove**.

6. Repeat step 5 for each file for which you want to specify the path.
7. Click **Save & Close**.
6.4.3.2 To upload required files

1. In the "Folders" management area of the CMC, select the executable program object.
2. Click Actions > Associated Files.
3. Click Browse to navigate to the required file, then click Add File.
4. Repeat step 3 for each required file.
5. Click Save & Close.

**Tip:**
To remove auxiliary files that you have specified, select the file(s) from the Current auxiliary files list and click Remove File(s).

6.4.3.3 To add an environment variable

In the CMC, you can configure your program by adding or modifying environment variables.

Modifications to an existing environment variable override the variable, rather than append to it. Any changes you make to environment variables exist only in the temporary shell in which Information platform services runs the program. Thus, when the program exits, the environment variables are destroyed.

1. In the "Folders" management area of the CMC, click the program object.
2. Click Manage > Default Settings.
   The "Default Settings" dialog box appears.
3. Click Program Parameters.
4. In the Environment Variables field, type the environment variables you want to set, and then click Add.
   Use the form name=value, where name is the environment variable name and value is the value for the environment variable. For example, you can set the path variable to append a user’s bin directory to the existing path:
   - On Windows, you might type: path=%path%;c:\usr\bin
   - On UNIX, you might type: PATH=$PATH:/usr/bin

**Note:**
Information platform services sets your environment variables using the syntax that is appropriate for your operating system. However, on UNIX you must follow convention, and use the appropriate case. For example, all name values on UNIX must be typed in upper case.

5. Click Save & Close.
Tip:
To edit or remove environment variables that you have specified, select the variable from the Environment Variables list, and click the appropriate button, either Edit or Remove.

6.4.3.3.1 To edit or remove an environment variable
1. In the CMC, select the Folders area.
2. Select the program object for which to edit or remove an environment variable.
3. Select Manage > Default Settings.
4. In the "Default Settings" dialog box, click Program Parameters.
5. In the Environment Variables list, select the variable to edit or remove, and click Edit or Remove.

6.4.4 Configuring Java programs

To successfully schedule and run Java programs in BI platform, you must specify required parameters for the program object. You can provide the Java program with access to files located on the Adaptive Job Server and specify Java Virtual Machine options.

6.4.4.1 To specify required parameters for Java programs

To successfully schedule and run a Java program, you must provide Information platform services with the base name of the .class file that implements the IProgramBase interface from the SAP BusinessObjects Enterprise Java SDK.

Note:
The Java Runtime Environment must be installed on each machine that is running an Adaptive Job Server.
1. In the "Folders" management area of the CMC, select the Java program object.
2. Click Manage > Default Settings.
   The "Default Settings" dialog box appears.
3. Click Program Parameters in the navigation list.
4. In the Class to run field, type the base name of the .class file that implements the IProgramBase from the SAP BusinessObjects Enterprise Java SDK (com.businessobjects.sdk.plugin.desktop.program.IProgramBase).
   For example, if the file name is Arius.class, type Arius.
5. Click Save & Close.
6.4.4.2 To provide Java programs with access to other files

You can provide Java programs with access to files, such as Java libraries, located on the Program Scheduling Service machine.

1. In the "Folders" management area of the CMC, select the Java program object.
2. Click Manage > Default Settings.
   The "Default Settings" dialog box appears.
3. Click Program Parameters on the navigation list.
4. In the Classpath field, type the full paths to the locations of any Java library files that are required by the Java program, and stored on the Adaptive Job Server that hosts the Program Scheduling Service.
   You must separate multiple paths with the classpath separator that is appropriate to your operating system: a semi-colon for Windows, a colon for UNIX.
5. Click Save & Close.

6.4.5 To specify a user account for a program object

1. In the "Folders" management area of the CMC, select the program object.
2. Click Manage > Default Settings.
   The "Default Settings" dialog box appears.
3. Click Program Logon on the navigation list.
4. In the User Name and Password fields, type the credentials for the user account under which the program should run.
5. Click Save & Close.

6.5 Object package management

6.5.1 Object packages, components, and instances
Object packages function as distinct objects in BI platform. (Think of them as folders you can schedule.) Object packages can be composed of any combination of report and program objects in BI platform.

You cannot add non-BI platform objects to object packages—for example, Microsoft Excel, Microsoft Word, Adobe Acrobat, text, rich text, Microsoft PowerPoint, and hyperlinked objects.

For reports, object packages enable users to view synchronized data across reports.

**Object package component objects**

Placing multiple (component) objects in a single object package enables you to simultaneously schedule the objects. However, configuration options are more limited for component objects than other objects, and component objects do not appear in the object list in the Folders area of the CMC. To see component objects, you must open their object package.

**Object package instances**

BI platform creates an object package instance each time it runs an object package. An object package instance contains individual instances of each component object in the package. The individual instances are tied to object package instances, rather than to component objects.

For example, if you run an object package and create an instance—and then remove a report object from the object package—the existing object package instance will not change. It still contains the instance for the report object you removed. The next time you run the object package and create an object package instance, no instance will be created for the report object you removed.

For hyperlinked report instances in object package instances, the hyperlinks point to other report instances in the same object package instance.

**Related Topics**

- Working with hyperlinked reports

### 6.5.2 To create a new object package

1. Go to the "Folders" management area of the CMC and navigate to the folder that you want to create the object package in.

2. Click Manage > New > Object Package. The "Object Package" dialog box appears.

3. Enter a title, description, and keywords for your object package.

4. Click OK.

When the object package has been added to the system, you can modify the properties, contents, scheduling information, destination, user rights, object settings, and notification for the object package. To do this, use Manage > Properties or Manage > Default Settings.
6.5.3 Adding objects to an object package

In CMC, after you create an object package, you can add report and/or program component objects to it, add new or copy existing objects to it, and move copies of objects (not actual objects) to it or between object packages.

When you copy an object to an object package, the component object retains the settings of the original object. When you create a copy of an object inside an object package, the component object and the original object are separate entities. Changes to one object do not affect the other object.

6.5.3.1 To add a new object to an object package

1. In the "Folders" management area of the CMC, double-click an object package.
   The object package's contents are displayed in the Details panel.
2. Click Manage > Add > Local Document or Program File depending on the object you want to add.
   Different dialog boxes appear depending on the option you selected.
3. Click Browse and select the object that you want to add.
4. Set the appropriate properties.
   If you are adding a program object, set the program type by clicking Executable, Java, or Script.
5. Click OK.

6.5.4 Configuring object packages and their objects

Object packages save time because they enable you to simultaneously schedule multiple objects that have similar scheduling requirements. As a result, you configure some parameters at the object package level and some at the object level (that is, for individual objects in the package).

For example, you must specify a destination for an object package, but you cannot specify a destination for individual objects in the package. When BI platform runs the object package, it will save output instances to the destination specified for the object package.

Note:
Because objects in an object package are copies of objects that exist outside the package, changes you make do not affect objects outside the package.
6.5.4.1 To set component failure options for an object package

Perform this task to specify how component failure affects an object package at run time.

1. In the "Folders" management area of the CMC, navigate to the object package and select it.
2. Click Manage > Default Settings.
3. Click Component Failure on the navigation list.
4. Select or deselect the Scheduled package fails upon individual component failure check box.
5. Click Save & Close.

6.5.5 Authentication and object packages

Object packages simplify both Enterprise and database authentication. You enter your Enterprise authentication only once to schedule an object package, including all of its component objects. Therefore, you must have the Schedule right for each object in the object package. If you attempt to schedule an object package containing a component object that you do not have the Schedule right for, the component instances fail.

For database authentication, you must specify database logon information for each report component object in an object package. (If you copied the report to the object package, it initially inherited database logon information from the original report.)
Scheduling Objects

7.1 Calendars

A calendar is a customized list of run dates for scheduled jobs. When you apply the calendar to a job, BI platform runs the job on the predefined run dates you have specified.

Calendars allow users to create more complex processing schedules than standard scheduling options allow.

**Note:**
Calendars can be used for any object you can schedule including report objects, program objects, and object packages.

You can set up as many calendars as you want in BI platform.

**Calendars and processing schedules**

Calendars make it easy for you to schedule complex recurring jobs efficiently. Calendars are particularly useful when you want to run a recurring job on an irregular schedule, or if you want to provide users with sets of regular scheduling dates to choose from. Calendars also allow you to create more complex processing schedules, combining unique scheduling dates with recurring ones.

**Example:** Non-run calendars for holidays

If you want a report object to run every business day except for your country's statutory holidays, you can create a calendar with the holidays marked as “non-run” days, on which the report object cannot be run. BI platform will run the job every day you have specified as a “run” day in your calendar.

7.1.1 To create a calendar

Perform this task to create a new calendar.

**Tip:**
It is good practice to create a calendar for users to use as a template for creating new calendars. They can copy this template calendar and modify it as necessary. For example, you can create a default Weekdays calendar that includes all days as run dates except weekends and company holidays.
1. Go to the "Calendars" management area of the CMC.
2. Click Manage > New > New Calendar.
3. Type a name and description for the new calendar.
4. Click OK.

The new calendar is added to the system. You can now add run dates to this calendar.

When the calendar is created, you can add run dates to it using the Dates tab.

**Related Topics**

• To add dates to a calendar

### 7.1.2 To add dates to a calendar

You can add dates to a calendar using a number of different formats. You can choose specific dates using a yearly, quarterly, or monthly view of the calendar, or you can choose recurring dates using general formats based on the day of the month or week.

1. Go to the "Calendars" management area of CMC.
2. Select the calendar you want to change.
3. Click Actions > Select Dates.
4. Choose a calendar format option (Yearly, Quarterly, or Monthly); alternatively, if you want to create a calendar with recurring dates, click By day of month or By day of week.
5. Click the days of the month that you want to include as run days for the calendar.

To remove a run day, click the day again.

**Tip:**

To select a week, or all of the particular weekdays in a month, you can click the row or column header.

6. When you are finished, click Save.

**Note:**

When you change an existing calendar, the BI platform checks all currently scheduled instances in your system. Objects that use the edited calendar are automatically updated to run on the revised date schedule.

#### 7.1.2.1 Calendar format options
### Calendar format option

<table>
<thead>
<tr>
<th>Calendar format option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yearly</td>
<td><em>Yearly</em> displays the calendar's run dates for the year. To change the year displayed, click the <em>Previous year</em> and <em>Next year</em> buttons. To add a date using the <em>Yearly</em> format, click the day, weekday header, or week row header that you want to add.</td>
</tr>
<tr>
<td>Quarterly</td>
<td><em>Quarterly</em> displays the calendar's run dates for the current calendar quarter. You can change the displayed quarter using the <em>Previous quarter</em> and <em>Next quarter</em> buttons. To add a date using the <em>Quarterly</em> format, click the day, weekday header, or week row header that you want to add.</td>
</tr>
<tr>
<td>Monthly</td>
<td><em>Monthly</em> displays the calendar's run dates for the current month. You can change the displayed month using the <em>Previous month</em> and <em>Next month</em> buttons. To add a date using the <em>Monthly</em> format, click the day, weekday header, or week row header that you want to add.</td>
</tr>
</tbody>
</table>

### 7.1.2.2 Specific dates

To add a specific date to a calendar, use the *Yearly*, *Quarterly*, and *Monthly* formats to add dates to the calendars.

The *Yearly* format displays the run schedule for the entire year. The *Quarterly* format displays the run dates for the current quarter. You can also view the *Monthly* format for the calendar, which displays the run dates for the current month. In all three formats, you can change the displayed time range by clicking the previous and next buttons.

You can add specific dates in any calendar format by clicking on the day you want to add. If you want to add an entire week, click > in the row header for that week. To add run days on all of a given day of the week in a month, click the name day of the week.
For example, if your company ships products according to an irregular schedule that cannot be defined using the daily or weekly settings, you can create a list of these dates in a “Shipping dates” calendar. The Shipping department can now check the inventory after each shipment by scheduling a report that uses the calendar to run at the end of each shipping day.

**Related Topics**  
- Recurring dates

### 7.1.2.3 Recurring dates

You can add recurring dates based on the day of the week or the day of the month. To view existing run dates, you must use the *Yearly*, *Quarterly*, or *Monthly* format; the generic formats must be used to add recurring dates to the calendar. To add the recurring days, click *By day of month* or *By day of week* and select the days you want to add.

Although you can set a recurring schedule using the standard scheduling options, calendars let you combine different recurring run patterns at once. You can also run instances on dates that do not follow the pattern by adding individual days to a calendar.

For example, to schedule a report object to run on the first four days of every month, and on the second and fourth Friday of every month, first create a new calendar object and name it. Then, choose to add
recurring days by day of month to add the first four days of the month to this calendar. When you update the calendar, the Yearly format appears with the new run dates.

**Add recurring days by day of month**

Add recurring days: *By day of month* [By day of week]

Add monthly recurring run days by clicking on the days of month below.

**Legend**

- 8 Non-run day
- 8 New run day

To add every second and fourth Friday to the calendar, choose to add recurring days by day of week and select the second and fourth Friday.
7.1.3 To delete a calendar

When you delete a calendar, any objects that are scheduled according to the deleted calendar will be run one more time by the system. After that, the system will not be able to schedule the objects again because the calendar no longer exists. To ensure the objects continue to be run, change the scheduling information for the objects either by selecting a different calendar or a different recurrence pattern.

1. Go to the "Calendars" management area of the CMC.
2. Select the calendar you want to delete.
   
   **Tip:**
   Select multiple calendars by holding down the CTRL or SHIFT key and clicking on them.

3. Click Manage > Delete.
4. Click OK to confirm.

**Related Topics**
- To schedule an object
7.1.4 Specifying calendar rights

You can grant or deny users and groups access to calendars. Depending how you organize calendars, you can make specific sets of dates available only for certain employees or departments. For example, your finance team may use a series of financial tracking dates that aren't useful for other departments.

**Note:**
Users can see only the calendars they have the rights to see; you can use rights to hide calendars that aren't applicable to a particular group.

By default, calendars are based on current security settings. Calendars inherit rights from the users' parent folders.


7.2 Scheduling

Scheduling is the process of configuring an object to automatically run at specified times. When scheduling an object, you choose the recurrence pattern and other parameters that determine when and how often the object will run.

At the time you schedule an object, BI platform creates a scheduled instance. The scheduled instance appears in the "History" dialog box for the object (with a status of Recurring or Pending) but contains only object and schedule information (no data).

When BI platform runs the object, it creates an output instance for the object—for example, a report or program instance. A report instance contains actual data from the database. A program instance is a text file that contains the standard output and the standard error produced when the program object ran. Output instances also appear in the "History" dialog box for an object (with a status of Success or Failed).

Users must use web-based client software, such as BI launch pad or a custom web application, to schedule and run objects. BI launch pad is used to schedule objects and to view reports. The CMC is used to manage, administer, and schedule objects and to view reports.

**Related Topics**

- To select a recurrence pattern
The recurrence pattern determines how often a publication runs.

### 7.2.1 Setting options for scheduling

#### 7.2.1.1 To schedule an object

**Tip:**
To change the default schedule settings for an object, click Default Settings in the "Schedule" dialog box, set the scheduling options, and click Save.

1. In the CMC, select the Folders area.
2. Select the object to schedule.
3. Select Actions > Schedule.
   The “Schedule” dialog box appears, showing the default settings for the object.
4. Type an appropriate instance title.
5. Click Recurrence, and select a recurrence pattern.
   For example, select a Weekly recurrence for the object.
6. Specify run options and scheduling parameters as needed.
   For example, select Monday, Wednesday, and Friday.
7. Click Schedule.
   The system creates a scheduled instance and runs it according to the schedule you specified. You can view scheduled instance in the "History" dialog box for the object.

**Related Topics**
- Recurrence patterns
- Run options for recurrence patterns
- Viewing instance information

Manage instances with the Instance Manager or in the "History" dialog box for individual objects.
7.2.1.2 Scheduling objects for individual users

The Schedule For feature generates reports that contain data for specific users. You can use the feature for the following types of objects:

- Crystal reports based on Business Views, universes, or SAP BEx queries
- Web Intelligence documents that use universes

Use the Schedule For feature to schedule an object and to specify for which users to run the object. BI platform runs the object and generates multiple instances of the report or document. Each instance contains data relevant to an individual user.

Example:

You can schedule a sales report, and in the “Schedule For” dialog box, specify the user names of all sales representatives. At the specified time, BI platform runs the report object and generates individual report instances. Each instance contains sales information for the specified sales representative.

7.2.1.2.1 To schedule an object for individual users

1. In the CMC, select the Folders area.
2. Select a report object to schedule.
3. Select Actions > Schedule.
4. Click Schedule For.
5. Select Schedule only for myself or Schedule for specified users and user groups.
6. If you selected Schedule for specified users and user groups, locate and select the users and groups to schedule for, and click > to add them to the Selected list.

   **Tip:**
   If you need to remove users or groups from Selected list, select them and click <.

7. Specify the remaining scheduling options, and click Schedule.

**Related Topics**

- Recurrence patterns
- Run options for recurrence patterns

7.2.1.3 Recurrence patterns

First you select a recurrence pattern, and then you must select run options for the recurrence pattern.
<table>
<thead>
<tr>
<th>Recurrence pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Now</td>
<td>The object runs when a user clicks Schedule.</td>
</tr>
<tr>
<td>Once</td>
<td>The object runs once. You specify at which time it will run and the start and end dates.</td>
</tr>
<tr>
<td>Hourly</td>
<td>The object runs hourly. You specify how often the object runs, at which time it will run, and the start and end dates.</td>
</tr>
<tr>
<td>Daily</td>
<td>The object runs once every $N$ days. You specify how often the object runs, at which time it will run, and the start and end dates.</td>
</tr>
<tr>
<td>Weekly</td>
<td>The object runs every week. You specify on which days and at which time it will run and a start and end date.</td>
</tr>
<tr>
<td>Monthly</td>
<td>The object runs every $N$ months. You specify how often the object runs, at which time it will run, and the start and end dates.</td>
</tr>
<tr>
<td>Nth Day of Month</td>
<td>The object runs on the $N$ day of every month. You specify the day of the month, at which time it will run, and a start and end date.</td>
</tr>
<tr>
<td>1st Monday of Month</td>
<td>The object runs on the first Monday of every month. You specify at which time it will run and a start and end date.</td>
</tr>
<tr>
<td>Last Day of Month</td>
<td>The object runs on the last day of every month. You specify a start and end date.</td>
</tr>
<tr>
<td>X Day of Nth Week of the Month</td>
<td>The object runs on a particular day of a particular week each month. You specify the week and day it will run, at which time it will run, and the start and end date.</td>
</tr>
<tr>
<td>Calendar</td>
<td>The object runs on the dates specified in a calendar.</td>
</tr>
</tbody>
</table>

**Related Topics**
- Run options for recurrence patterns
- Calendars
# 7.2.1.4 Run options for recurrence patterns

First you select a recurrence pattern, and then you must select run options for the recurrence pattern. Not all run options are available for all objects. When you select a run option that contains a variable, BI platform displays the variable's default value. You can change default values as needed.

<table>
<thead>
<tr>
<th>Run option for recurrence patterns</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Start Date/Time** lists and calendar box | This option appears for all recurrence patterns except **Now** and **Calendar**.  
Select the time (hours, minutes, and AM or PM) and the date on which to start running the object.  
The BI platform runs the object according to the specified schedule, as soon as it can after the start time has passed. The default is the current date and time. For example, if you specify a start time that is three months in the future, the BI platform waits to run the object until the start date has passed, even if all other criteria are met. After the start date, the BI platform runs the report at the specified time. |
| **End Date/Time** lists and calendar box | This option appears for all recurrence patterns except **Now** and **Calendar**.  
Select the time (hours, minutes, and AM or PM) and the date on which to stop running the object.  
After the end time has passed, the BI platform no longer runs an object. The default is the current time and a date in the distant future, to ensure an object will run indefinitely. |
| **Hour(N)** list and **Minute(X)** list | These options appear when you select the **Hourly** recurrence pattern.  
Select the interval (in hours and minutes) at which to run the object. If you do not enter a value for **N** or **X**, the BI platform runs the report every hour. |
### Run option for recurrence patterns

<table>
<thead>
<tr>
<th>Run option for recurrence patterns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Days(N) box</td>
<td>This option appears when you select the <strong>Daily</strong> recurrence pattern. Type the interval (in days) at which to run the object. If you do not enter a value for ( N ), the BI platform runs the report every day.</td>
</tr>
<tr>
<td>Monday, Tuesday, Wednesday, Thursday, Friday, Saturday, and Sunday check boxes</td>
<td>This option appears when you select the <strong>Weekly</strong> recurrence pattern. Select a check box for each day of the week on which to run the job.</td>
</tr>
<tr>
<td>Month(N) list</td>
<td>This option appears when you select the <strong>Monthly</strong> recurrence pattern. Type the interval (in months) at which to run the object. If you do not enter a value for ( N ), the BI platform runs the report every month.</td>
</tr>
<tr>
<td>Day(N) box</td>
<td>This option appears when you select the <strong>Nth Day of Month</strong> recurrence pattern. Select the day of the month on which to run the object. If you do not select a value for ( N ), the BI platform runs the report every day.</td>
</tr>
<tr>
<td>Week(N) list and Day(X) list</td>
<td>This option appears when you select the <strong>X Day of Nth Week of the Month</strong> recurrence pattern. Select the week in the month and the day of the week on which to run the object. If you do not enter a value for ( N ) or ( X ), the BI platform runs the report every day.</td>
</tr>
</tbody>
</table>

### 7.2.1.5 Notification of success or failure of scheduled jobs
You can set options that automatically send notification when a scheduled object instance succeeds or fails. You can send audit or email notification, combine multiple notification methods, and select different notification options for successful and failed instances.

For example, you have a large number of reports that run every day. You need to check each instance to make sure it ran properly, and then send email to users who need to know that a new report is available. With thousands of reports, it would take too long to manually check reports and contact users. You can set BI platform options for each object to automatically notify you when a report fails to run and to automatically inform users when new report instances run successfully.

### 7.2.1.5.1 Determining the success or failure of a scheduling job

When you schedule an object, the scheduled instance either succeeds or fails. The conditions required for an instance's success or failure depend on the type of object you schedule:

- **Report objects and Web Intelligence documents**
  
  A report instance or document object instance runs successfully if it does not encounter errors while processing an object or accessing the database. An instance may fail if a user does not provide the correct logon information.

- **Program objects**
  
  For program objects, BI platform must run in order to succeed. If BI platform does not run, the instance is considered a failure. If BI platform runs but does not perform tasks it is supposed to, it is still considered a successful instance because the program object ran. BI platform does not monitor problems with the program object code.

- **Object packages**
  
  An object package may fail if one of its components fails. You can set scheduling options for individual objects in an object package, including notification, database logon, filter, format, printing, parameter, server group, and alert options for each object.

  **Tip:**
  
  To prevent an object package from failing if an object in the package fails, select the object, and select **Manage > Default Settings**, click **Component Failure**, and clear the **Scheduled package fails upon individual component failure** check box.

  You cannot set audit or email notification for object packages, but you can schedule object packages with events and set notification for individual objects in an object package.

### Related Topics

- **Schedule-based events**

### 7.2.1.5.2 Notification options

You can choose notification options for each object and send a different notification for different conditions. For object packages, you can set only event notification, which triggers an event based on
the success or failure of the object package. To monitor object successes and failures from a more general perspective, use auditing in BI platform.

If notification fails, the object instance fails. For example, if an email notification sends a message to an invalid email address, the notification fails and the object instance is recorded as failed in the object history.

You can choose from the following notification options:

- **Audit notification**
  
  To use audit notification, you must configure the auditing database and enable auditing on the servers. If you use auditing to monitor the BI platform system, you can use audit notification. For information about configuring the auditing database and enabling auditing, see the *SAP BusinessObjects Business Intelligence Platform Administrator Guide* available on the SAP Help Portal at [http://help.sap.com](http://help.sap.com).

  When you select audit notification, information about the scheduled object is written to the auditing database. You can send a notification to the auditing database when a job runs successfully, when it fails to run, or at both times.

- **Email notification**
  
  You can send an email notification about an object instance's success or failure. You choose the sender and recipients of the email and whether to send notification when an instance fails or succeeds. For example, when a report fails, you can send an email to your administrator. When a report succeeds, you can automatically send an email to users to let them know a report is available.

  **Note:**
  To enable email notification, you must have the Email SMTP destination enabled and configured on the job servers. For more information, see the *SAP BusinessObjects Business Intelligence Platform Administrator Guide*.

  **Note:**
  Notification of a scheduled object's success or failure is not the same as alert notification. Alert notification must be built into the design of a report. For example, alert notification can send an email to you when a specific value in a report exceeds $1,000,000. In this case, the notification has nothing to do with the content of the report—it is just about whether the report object instance failed or succeeded.

7.2.1.5.3 To set a notification for an instance's success or failure

If a notification option is available, it is labeled "Not in use". If a notification type is in use, it is labeled "Enabled".

1. In the CMC, select the **Folders** area.
2. Select an object for which to set notification.
3. Select **Actions > Schedule**.
4. On the navigation list, click **Notification**.
5. To use audit notification, click **Audit Notification**, and perform the following actions:
   - Select the **A job has been run successfully** check box to send a record to the auditing database when a job succeeds.
Select the **A job has failed to run** check box to send a record to the auditing database when a job fails.

6. To use email notification, click **Email Notification**, and perform the following actions:
   - Select the **A job has been run successfully** check box to send an email when a job succeeds. To specify the content and recipients of the email, select **Set the values to be used here**, and type email addresses in the **From** and **To** boxes, type the subject, and type the message. Separate multiple addresses or distribution lists with semicolons.
   - Select the **A job has failed to run** check box to send an email when a job fails. To specify the content and recipients of the email, select **Set the values to be used here**, and type email addresses in the **From** and **To** boxes, type the subject, and type the message. Separate multiple addresses or distribution lists with semicolons.

**Note:**
By default, the notification is sent to the server's default email destination.

### 7.2.1.6 Selecting a destination

When BI platform runs an object, it stores the output instance by default on the Output File Repository Server (FRS). However, you can configure an object or instance to send output to a different destination. For example, you can configure an object to automatically deliver its output by email to specific users. Choosing an additional destination gives you the flexibility to deliver instances across your Enterprise system and to destinations outside of your system.

When you select a destination other than the default Output FRS destination, BI platform generates a unique file name for the output file(s). The file name includes a combination of ID, object name or title, owner, and date and time information.

You can select a destination for an object or instance in the Central Management Console (CMC) or BI launch pad. When you use the CMC, the values you select become the default scheduling values in BI launch pad.

**Note:**
You can configure object instances to print after running.

**Related Topics**

- **To set the default destination**

  To save instances only to the Output File Repository Server (FRS)—not to any other destination—use the **Default Enterprise Location** destination.

- **To schedule an object to BI Inboxes**

- **To schedule an object to email**

- **To schedule an object to a file location**

- **To schedule an object to an FTP server**
• To enable or disable destinations for a job server

7.2.1.6.1 Destinations

The following destinations are available:
• Default Enterprise Location
• BI Inbox
• Email
• FTP Server
• File System
• SAP StreamWork (if enabled and configured)

Table 7-4: Default Enterprise Location destination

<table>
<thead>
<tr>
<th>Description</th>
<th>Instance is saved to</th>
</tr>
</thead>
<tbody>
<tr>
<td>The publication is accessible from the folder it was created in. You can perform the following actions: • Merge all exported PDF documents (Crystal reports only) • Package the publication as a compressed (.zip) file If you send a publication to this location, choose a folder that is accessible to all recipients.</td>
<td>Output File Repository Server Historical instances are saved to the default Enterprise server but not to any other destination.</td>
</tr>
</tbody>
</table>
**Table 7-5: BI Inbox destination**

<table>
<thead>
<tr>
<th>Description</th>
<th>Instance is saved to</th>
</tr>
</thead>
<tbody>
<tr>
<td>The publication is sent to each recipient's BI Inbox. You can perform the</td>
<td></td>
</tr>
<tr>
<td>following actions:</td>
<td></td>
</tr>
<tr>
<td>• Use the default settings for the destination</td>
<td>• Output File Repository Server</td>
</tr>
<tr>
<td>• Deliver objects to individual users</td>
<td>• Specified BI Inboxes</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td></td>
</tr>
<tr>
<td>To quickly locate a user, you can search for a recipient's user name, full</td>
<td></td>
</tr>
<tr>
<td>name, or email address in the <strong>Find title</strong> box.</td>
<td></td>
</tr>
<tr>
<td>• Use the default file name, enter a file name, or add placeholders. If you</td>
<td></td>
</tr>
<tr>
<td>select <strong>Use Specific Name</strong>, type a file extension or add the **File</td>
<td></td>
</tr>
<tr>
<td>Extension** placeholder to the box.</td>
<td></td>
</tr>
<tr>
<td>• Automatically add the extension to file name</td>
<td></td>
</tr>
<tr>
<td><strong>Caution:</strong></td>
<td></td>
</tr>
<tr>
<td>If you do not add a file extension to a file name, you may be unable to</td>
<td></td>
</tr>
<tr>
<td>open the document.</td>
<td></td>
</tr>
<tr>
<td>• Send the publication as a shortcut or a copy. If you send a publication</td>
<td></td>
</tr>
<tr>
<td>to a recipient's BI Inbox shortcut, choose a folder that is accessible to</td>
<td></td>
</tr>
<tr>
<td>all recipients. To send a publication shortcut to a BI Inbox, select both</td>
<td></td>
</tr>
<tr>
<td><strong>BI Inbox</strong> and <strong>Default Enterprise Location</strong> as the destination.</td>
<td></td>
</tr>
<tr>
<td>• Merge all exported PDF documents (Crystal reports only)</td>
<td></td>
</tr>
<tr>
<td>• Package the publication as a compressed (<strong>.zip</strong>) file</td>
<td></td>
</tr>
</tbody>
</table>
Table 7-6: Email destination

<table>
<thead>
<tr>
<th>Description</th>
<th>Instance is saved to</th>
</tr>
</thead>
</table>
|             | • Output File Repository Server  
|             | • Specified email recipients  
<p>|             | Before you can schedule or send a report instance to this destination, you must enable and configure the email (SMTP) destination on the Adaptive Job Server. |</p>
<table>
<thead>
<tr>
<th>Description</th>
<th>Instance is saved to</th>
</tr>
</thead>
</table>

**Note:**
Before you select this destination, confirm that your email settings are configured properly on the Adaptive Job Server.

The publication is sent to recipients in an email. You can perform the following actions:
- Use the default settings for the destination
- Deliver objects to individual users
- (Required) Enter your email address in the **From** box. If you do not enter your email address, BI platform uses the email address associated with the publisher's account. If the publisher's account has no email address, BI platform uses the email address for the Adaptive Job Server.

**Caution:**
If there is no email address in the **From** box, the publisher's account, or the Adaptive Job Server, the publication will fail.

- Enter recipient email addresses or add the **Email Address** placeholder to the **To** box
- Enter recipient email addresses or add the **Email Address** placeholder to the **Cc** box
- Enter recipient email addresses or add the **Email Address** placeholder to the **Bcc** box
- Enter a subject or add placeholders to the **Subject** box
- Enter information to deliver with the publication or add placeholders and embed a dynamic content document in the body of the email in the **Message** box
- Attach source document instances to an email
- Accept the default file name, enter a file name, or add placeholders. If you select **Use Specific Name**, enter a file extension or add the **File Extension** placeholder to the box.
- Automatically add the extension to file name

**Caution:**
If you do not add a file extension to a file
<table>
<thead>
<tr>
<th>Description</th>
<th>Instance is saved to</th>
</tr>
</thead>
<tbody>
<tr>
<td>name, you may be unable to open the document.</td>
<td></td>
</tr>
<tr>
<td>• Merge all exported PDF documents (Crystal reports only)</td>
<td></td>
</tr>
<tr>
<td>• Package the publication as a compressed (.zip) file</td>
<td></td>
</tr>
</tbody>
</table>

Table 7-7: FTP Server destination

<table>
<thead>
<tr>
<th>Description</th>
<th>Instance is saved to</th>
</tr>
</thead>
<tbody>
<tr>
<td>The publication is sent to an FTP server. You must enter the FTP server location in the <strong>Host</strong> box. (If you do not, BI platform uses the FTP server configured for the Adaptive Job Server.) You can perform the following actions:</td>
<td></td>
</tr>
<tr>
<td>• Use the default settings for the destination</td>
<td></td>
</tr>
<tr>
<td>• Type the port number, user name and password, and account</td>
<td></td>
</tr>
<tr>
<td>• Type a directory name</td>
<td></td>
</tr>
<tr>
<td>• Accept the default file name, enter a file name, or add placeholders. If you select <strong>Use Specific Name</strong>, type a file extension or add the <strong>File Extension</strong> placeholder to the box.</td>
<td></td>
</tr>
<tr>
<td>• Automatically add the extension to file name</td>
<td></td>
</tr>
<tr>
<td><strong>Caution:</strong> If you do not add a file extension to a file name, you may be unable to open the document.</td>
<td></td>
</tr>
<tr>
<td>• Merge all exported PDF documents (Crystal reports only)</td>
<td></td>
</tr>
<tr>
<td>• Package the publication as a compressed (.zip) file</td>
<td></td>
</tr>
<tr>
<td>• Output File Repository Server</td>
<td></td>
</tr>
<tr>
<td>• Selected FTP server</td>
<td></td>
</tr>
</tbody>
</table>
Table 7-8: File System destination

<table>
<thead>
<tr>
<th>Description</th>
<th>Instance is saved to</th>
</tr>
</thead>
<tbody>
<tr>
<td>The publication is sent to a directory on a file system. You must enter the directory for the publication. You can perform the following actions:</td>
<td></td>
</tr>
<tr>
<td>• Use the default settings for the destination</td>
<td></td>
</tr>
<tr>
<td>• Type a user name and password to access the file location</td>
<td></td>
</tr>
<tr>
<td>• Deliver objects to individual users</td>
<td></td>
</tr>
<tr>
<td>• Accept the default file name, enter a file name, or add placeholders. If you select Use Specific Name, type a file extension or add the File Extension placeholder to the box.</td>
<td></td>
</tr>
<tr>
<td>• Automatically add the extension to file name</td>
<td></td>
</tr>
<tr>
<td><strong>Caution:</strong> If you do not add a file extension to a file name, you may be unable to open the document.</td>
<td></td>
</tr>
<tr>
<td>• Merge all exported PDF documents (Crystal reports only)</td>
<td></td>
</tr>
<tr>
<td>• Package the publication as a compressed (.zip) file</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Output File Repository Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected file location</td>
</tr>
</tbody>
</table>

Table 7-9: SAP StreamWork destination

<table>
<thead>
<tr>
<th>Description</th>
<th>Instance is saved to</th>
</tr>
</thead>
<tbody>
<tr>
<td>The publication is sent for collaboration with other users.</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> This destination is available if SAP StreamWork is configured and enabled in BI platform.</td>
<td></td>
</tr>
</tbody>
</table>

SAP StreamWork

The **Deliver objects to each user** check box is selected by default for all destinations. However, in some cases, you may not want to deliver objects to each user. For example, three recipients have identical personalization values so they receive the same data in publication instances. If you clear the
Deliver objects to each user check box, one publication instance is generated and delivered to all three recipients. If you select the Deliver objects to each user check box, the same publication instance is delivered three times (once for each recipient).

If you are sending the publication to the FTP Server or File System destination and some recipients share identical personalization values, you can clear the Deliver objects to each user check box to decrease overall processing time. When you clear Deliver objects to each user, placeholders used when configuring destinations will contain the publisher's (not the recipient's) information.

7.2.1.6.2 Destination options

**Note:**
You can change the default Adaptive Job Server settings in the Servers area of the CMC. For more information, see the SAP BusinessObjects Business Intelligence Platform Administrator Guide.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Enterprise Location</td>
<td>The scheduled job will run on the Output File Repository Server (FRS). You do not need to set additional options for this destination. Historical instances are saved to the default Enterprise server but not to any other destination.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Destination</td>
<td>BI Inbox</td>
</tr>
<tr>
<td>Keep an instance in the history</td>
<td>Select this check box to retain a copy of this instance in the object's history. This check box is selected by default. Clear this check box if you want BI platform to automatically delete the instance from the Output FRS to minimize the number of instances on the server.</td>
</tr>
</tbody>
</table>
### Table 7-12: Email destination

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use default settings</td>
<td>Select this check box to use the default Adaptive Job Server values for BI Inbox-</td>
</tr>
<tr>
<td></td>
<td>- If you do not want to use the default Adaptive Job Server values, clear this check box, and</td>
</tr>
<tr>
<td></td>
<td>set the destination recipient options that appear.</td>
</tr>
<tr>
<td>Available Recipients and</td>
<td>In the Available Recipients list, select users or user groups to send the instance</td>
</tr>
<tr>
<td>Selected Recipients</td>
<td>to, and click &gt; to add the users or groups to the Selected Recipients list.</td>
</tr>
<tr>
<td>Find title (if available)</td>
<td>Type a recipient's user name, full name, or email address in the Find title box to quickly</td>
</tr>
<tr>
<td></td>
<td>locate the user in the Available Recipients list.</td>
</tr>
<tr>
<td>Target Name</td>
<td>- To use a system-generated file name for the instance, select Use Automatically Generated Name.</td>
</tr>
<tr>
<td></td>
<td>- To choose a file name for the instance, select Use Specific Name, and type a name or select</td>
</tr>
<tr>
<td></td>
<td>variables for the file name from the Add placeholder list.</td>
</tr>
<tr>
<td></td>
<td>The available variables are Title, ID, Owner, DateTime, (your) Email Address, (your) User Full</td>
</tr>
<tr>
<td></td>
<td>Name, and File Extension.</td>
</tr>
<tr>
<td></td>
<td>Select the Add File Extension check box to automatically add the file extension to the instance</td>
</tr>
<tr>
<td></td>
<td>file name. If you do not add a file extension, you may be unable to open the document.</td>
</tr>
<tr>
<td>Send As</td>
<td>- To send a shortcut to the instance to recipients, select Shortcut.</td>
</tr>
<tr>
<td></td>
<td>- To send a copy of the instance to recipients, select Copy.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Destination</td>
<td>Email</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Keep an instance in the history</td>
<td>Select this check box to retain a copy of this instance in the object's history. This check box is selected by default. Clear this check box if you want BI platform to automatically delete the instance from the Output FRS to minimize the number of instances on the server.</td>
</tr>
<tr>
<td>Use default settings</td>
<td>Select this check box to use the default Adaptive Job Server values for email. If you do not want to use the default Adaptive Job Server values, clear this check box, and set the destination recipient options that appear.</td>
</tr>
<tr>
<td>From</td>
<td>Type a return email address, or select variables for the email address from the <strong>Add placeholder</strong> list. The available variables are Title, ID, Owner, DateTime, (your) Email Address, and (your) User Full Name. Click a variable to add it. Separate email addresses with a semicolon (;). <strong>Note:</strong> This option may be unavailable, depending on your system configuration.</td>
</tr>
<tr>
<td>To</td>
<td>Type each email address that you want to send the instance to, or select variables for the email address from the <strong>Add placeholder</strong> list. The available variables are Title, ID, Owner, DateTime, (your) Email Address, and (your) User Full Name. Click a variable to add it. Separate email addresses with a semicolon (;).</td>
</tr>
<tr>
<td>Cc</td>
<td>Type each email address that you want to send a copy of the email and instance to, or select variables for the email address from the <strong>Add placeholder</strong> list. The available variables are Title, ID, Owner, DateTime, (your) Email Address, and (your) User Full Name. Click a variable to add it. Separate email addresses with a semicolon (;).</td>
</tr>
<tr>
<td>Bcc</td>
<td>Type the email address of each undisclosed recipient, or select variables for the email address from the <strong>Add placeholder</strong> list. The available variables are Title, ID, Owner, DateTime, (your) Email Address, and (your) User Full Name. Click a variable to add it. Separate email addresses with a semicolon (;).</td>
</tr>
<tr>
<td>Subject</td>
<td>Type the subject of the email, or select variables for the subject from the <strong>Add placeholder</strong> list. The available variables are Title, ID, Owner, DateTime, (your) Email Address, and (your) User Full Name. Click a variable to add it.</td>
</tr>
</tbody>
</table>
**Table 7-13: FTP Server destination**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Destination</strong></td>
<td>FTP Server</td>
</tr>
<tr>
<td><strong>Keep an instance in the history</strong></td>
<td>Select this check box to retain a copy of this instance in the object’s history. This check box is selected by default. Clear this check box if you want BI platform to automatically delete the instance from the Output FRS to minimize the number of instances on the server.</td>
</tr>
</tbody>
</table>

**Option** | **Description**
--- | ---
**Message** | Type the message for the body of the email, or select variables for the message from the Add placeholder list. The available variables are Title, ID, Owner, DateTime, (your) Email Address, (your) User Full Name, Viewer, and Document Name. Click a variable to add it.

**Add Attachment** | Select this check box if you want to add an attachment to the email message containing the instance.

**File Name** | - To use a system-generated file name for the instance, select Use Automatically Generated Name.
  - To choose the file name for the instance, select Use Specific Name, and type a name or select variables for the file name from the Add placeholder list. The available variables are Title, ID, Owner, DateTime, (your) Email Address, (your) User Full Name, and File Extension.

Select the Add File Extension check box to automatically add the file extension to the instance file name. If you do not add a file extension, you may be unable to open the document.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use default settings</td>
<td>Select this check box to use the default Adaptive Job Server values for FTP servers. If you do not want to use the default Adaptive Job Server values, clear this check box, and set the destination recipient options that appear. You can change the values in the Servers area of the CMC. For more information, see the SAP BusinessObjects Business Intelligence Platform Administrator Guide.</td>
</tr>
<tr>
<td>Host</td>
<td>Type the IP address of the FTP server host computer where you want to send the instance.</td>
</tr>
<tr>
<td>Port</td>
<td>Type the port of the FTP server where you want to send the instance. The default is 21.</td>
</tr>
<tr>
<td>User Name</td>
<td>Type a user name with access rights to upload the object to the FTP server.</td>
</tr>
<tr>
<td>Password</td>
<td>Type the password required to access the FTP server.</td>
</tr>
<tr>
<td>Account</td>
<td>Type the account required to access the FTP server.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Account is part of the standard FTP protocol but is rarely implemented. Enter an account only if your FTP server requires it.</td>
</tr>
<tr>
<td>Directory</td>
<td>Type the path to the FTP directory where you want to send the instance.</td>
</tr>
<tr>
<td>File Name</td>
<td>• To use a system-generated file name for the instance, select <strong>Use Automatically Generated Name</strong>.</td>
</tr>
<tr>
<td></td>
<td>• To choose the file name for the instance, select <strong>Use Specific Name</strong>, and type a name or select variables for the file name from the <strong>Add placeholder list</strong>. The available variables are <strong>Title</strong>, <strong>ID</strong>, <strong>Owner</strong>, <strong>DateTime</strong>, (your) <strong>Email Address</strong>, (your) <strong>User Full Name</strong>, <strong>Document Name</strong>, and <strong>File Extension</strong>.</td>
</tr>
<tr>
<td></td>
<td>Select the <strong>Add File Extension</strong> check box to automatically add the file extension to the instance file name. If you do not add a file extension, you may be unable to open the document.</td>
</tr>
</tbody>
</table>
Table 7-14: File System destination

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Destination</strong></td>
<td><strong>File System</strong></td>
</tr>
<tr>
<td><strong>Keep an instance in the history</strong></td>
<td>Select this check box to retain a copy of this instance in the object's history. This check box is selected by default. Clear this check box if you want BI platform to automatically delete the instance from the Output FRS to minimize the number of instances on the server. <strong>Note:</strong> Instances are required for auditing events. This check box is overruled if auditing is enabled for a scheduled object.</td>
</tr>
<tr>
<td><strong>Use default settings</strong></td>
<td>Select this check box to use the default Adaptive Job Server values for the file system. If you do not want to use the default Adaptive Job Server values, clear this check box, and set the destination recipient options that appear.</td>
</tr>
<tr>
<td><strong>User Name</strong></td>
<td>Type a user name with access rights to save files to the destination directory. <strong>Note:</strong> You can specify a user name and password only for servers on Windows.</td>
</tr>
<tr>
<td><strong>Password</strong></td>
<td>Type the user password that is required to access the destination directory. <strong>Note:</strong> You can specify a user name and password only for servers on Windows.</td>
</tr>
<tr>
<td><strong>Directory</strong></td>
<td>Type the path to a local hard disk location or mapped location or a UNC path to the directory where you want to send the instance. If you are scheduling a Web Intelligence document and want to create folders based on variables (such as the title of the instance, owner, date and time, or user names), use a placeholder. The placeholder is inserted after the text in the box.</td>
</tr>
</tbody>
</table>
To use a system-generated file name for the instance, select Use Automatically Generated Name.

To choose the file name for the instance, select Use Specific Name, and type a name or select variables for the file name from the Add placeholder list. The available variables are Title, ID, Owner, DateTime, (your) Email Address, (your) User Full Name, Document Name, and File Extension.

Select the Add File Extension check box to automatically add the file extension to the instance file name. If you do not add a file extension, you may be unable to open the document.

The **SAP StreamWork** destination is available if SAP StreamWork is enabled and configured in BI platform.

**Table 7-15: SAP StreamWork destination**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Destination</strong></td>
<td>SAP StreamWork</td>
</tr>
<tr>
<td><strong>Keep an instance in the history</strong></td>
<td>Select this check box to retain a copy of this instance in the object's history. This check box is selected by default. Clear this check box if you want BI platform to automatically delete the instance from the Output FRS to minimize the number of instances on the server.</td>
</tr>
<tr>
<td><strong>Use default settings</strong></td>
<td>Select this check box to use the default Adaptive Job Server values for SAP StreamWork. If you do not want to use the default Adaptive Job Server values, clear this check box, and set the destination options that appear.</td>
</tr>
<tr>
<td><strong>File</strong></td>
<td>This box displays the file name. You cannot change the name here.</td>
</tr>
<tr>
<td><strong>Select Destination</strong></td>
<td>Select an existing or new activity as the destination of the report. Use the first list to filter activities by worklist.</td>
</tr>
</tbody>
</table>
### Option | Description
---|---
Select Worklist | Type the name of the worklist, or select it in the list.
Select Activity | Type the name of the activity, or select it in the list.
Activity Name | If the object will publish to a new activity, this box displays the name of the activity.
Activity Objectives | This box displays the activity's objectives, if available.
Item Description | (Optional) Type a description of the object's content to help participants understand what the object is and how to use it.
Select Activity Type | (Optional) Select the type of activity you are scheduling.
Add Participants | (Optional) If you are creating a new SAP StreamWork activity, type the email address of each participant (user) to invite to the activity. Separate email addresses with a comma.

#### 7.2.1.6.3 To set the default destination

To save instances only to the Output File Repository Server (FRS)—not to any other destination—use the Default Enterprise Location destination.

1. In the Central Management Console (CMC), select the Folders area.
2. Select the object for which to set the default destination.
3. Select Actions > Schedule.
4. Click Destinations.
5. In the Destination list, select Default Enterprise Location.
6. Click Schedule.

**Related Topics**
- Destination options
7.2.1.6.4 To schedule an object to BI Inboxes

When scheduling objects, you can configure an object to send its instances to one or more user BI Inboxes. The BI platform stores the instance on the Output File Repository Server (FRS) and sends a copy of the instance to the BI Inboxes you specify.

By default, the BI Inbox destination is enabled and configured on the Adaptive Job Servers.

1. In the CMC, select the Folders area.
2. Select an object to schedule.
3. Select Actions > Schedule.
4. Click Destinations.
5. In the Destination list, select BI Inbox.
6. Select or clear the Keep an instance in the history check box.
7. Select or clear the Use default settings check box.
   If you selected the check box, go to step 9.
8. If you cleared the Use default settings check box, perform the following actions:
   a. Under Available Recipients, select users to send the instance to.
   b. Under Target Name, select Use Automatically Generated Name or Use Specific Name.
   c. Under Send As, select Shortcut or Copy.
9. Click Schedule.

Related Topics
- Destination options
- To enable or disable destinations for a job server

7.2.1.6.5 To schedule an object to email

Before you can use this destination, the Email (SMTP) destination must be enabled and configured on the Adaptive Job Servers.

When you select the Email destination, the BI platform saves the output instance to the Output File Repository Server and sends a copy of the instance as an attachment to the email addresses you specify.

Note:
- Crystal report and other object instances are sent to email destinations via Simple Mail Transfer Protocol (SMTP) mail support.
- The BI platform supports Multipurpose Internet Mail Extensions (MIME) encoding.

1. In the CMC, select the Folders area.
2. Select an object to schedule.
3. Select Actions > Schedule.
4. Click Destinations.
5. In the Destination list, select Email.
6. Select or clear the Keep an instance in the history check box.
7. Select or clear the Use default settings check box.
   If you selected the check box, go to step 9.
8. If you cleared the Use default settings check box, perform the following actions:
   a. In the From box, enter the return email address.
   b. In the To box, enter the email address of each recipient to send the instance to.
   c. In the Cc box, enter the email address of each recipient to send a copy of the email and instance to.
   d. In the Bcc box, enter the email address of each undisclosed recipient to send a copy of the email and instance to.
   e. In the Subject box, enter the subject of the email.
   f. In the Message box, enter a message for the body of the email.
   g. Select or clear the Add Attachment check box.
   h. Under File Name, select Use Automatically Generated Name or Use Specific Name.
9. Click Schedule.

Related Topics
- Destination options
- To enable or disable destinations for a job server

7.2.1.6.6 To schedule an object to an FTP server

Before you can use this destination, it must be enabled and configured on the Adaptive Job Servers.

When scheduling objects, you can configure the objects for output to a File Transfer Protocol (FTP) server. To connect to the FTP server, you must specify a user who has the necessary rights to upload files to the server. If you specify an FTP destination, the system will save an output instance to both the Output File Repository Server and the specified destination.

1. In the CMC, select the Folders area.
2. Select an object to schedule.
3. Select Actions > Schedule.
4. Click Destinations.
5. In the Destination list, select FTP Server.
6. Select or clear the Keep an instance in the history check box.
7. Select or clear the Use default settings check box.
   If you selected the check box, go to step 9.
8. If you cleared the Use default settings check box, perform the following actions:
   a. In the Host box, enter the IP address of the FTP server host computer to send the instance to.
   b. In the Port box, enter the port of the FTP server to send the instance to.
   c. In the User Name box, enter a user name with access rights to upload the object to the FTP server.
d. In the **Password** box, enter the user password that is required to access the FTP server.

e. In the **Account** box, enter the account that is required to access the FTP server.

f. In the **Directory** box, enter the path to the FTP directory where you want to send the instance.

g. Under **File Name**, select **Use Automatically Generated Name** or **Use Specific Name**.

9. Click **Schedule**.

**Related Topics**

- Destination options
- To enable or disable destinations for a job server

### 7.2.1.6.7 To schedule an object to a file location

**Before you can use this destination, it must be enabled and configured on the Adaptive Job Server. In addition, the processing server must have sufficient access rights to the file location.**

When scheduling objects, you can configure objects for output to an unmanaged disk. In this case, the BI platform saves an output instance to the Output File Repository Server (FRS) and to the specified destination.

If the object is a Web Intelligence document or an object package, you cannot choose an unmanaged disk as a destination. However, for an object package, you can configure individual objects in the object package for output to an unmanaged disk.

**Note:**

The location must be a local directory on the processing server. For servers on Windows, the location can be a Universal Naming Convention (UNC) path or a local directory.

1. In the CMC, select the **Folders** area.
2. Select an object to schedule.
3. Select **Actions** > **Schedule**.
4. Click **Destinations**.
5. In the **Destination** list, select **File System**.
6. Select or clear the **Keep an instance in the history** check box.
7. Select or clear the **Use default settings** check box.
   
   If you selected the check box, go to step 9.

8. If you cleared the **Use default settings** check box, perform the following actions:
   
   a. In the **User Name** box, enter a user name with access rights to save files to the destination directory.
   
   b. In the **Password** box, enter the user password that is required to access the destination directory.
   
   c. In the **Directory** box, enter a local hard disk location, mapped location, or UNC path to the directory where you want to send the instance.
   
   d. Under **File Name**, select **Use Automatically Generated Name** or **Use Specific Name**.

9. Click **Schedule**.
7.2.1.6.8 To schedule an object for collaboration

- Before you can use this destination, it must be enabled and configured on the Adaptive Job Servers.
- Before you can schedule an object for collaboration, you must have an active SAP StreamWork account.

1. In the Central Management Console (CMC), select the Folders area.
2. Select an object to schedule.
3. Select Actions > Schedule.
4. Click Destinations.
5. In the Destination list, select Collaboration.
   If you do not have an SAP StreamWork account associated with your user name, you are prompted to log on to SAP StreamWork.
6. Select or clear the Keep an instance in the history check box.
7. Select or clear the Use default settings check box.
   If you selected the check box, go to step 9.
8. If you cleared the check box, perform the following actions:
   a. In the Select Destination list, select an existing or new activity as the destination of the report.
   b. In the Select Worklist list, type the name of the worklist to schedule or select a name in the list.
   c. In the Select Activity list, type the name of the activity to schedule or select a name in the list.
      The activity name appears in the Activity Name box, and the activity objectives, if defined, appear in the Activity Objectives box.
   d. In the Item Description box, enter a description of the object.
   e. In the Select Activity Type list, select an activity type.
   f. In the Add Participants box, if you are creating a new activity, enter the participant email addresses to invite to the activity, separating addresses with a comma.
9. Click Schedule.

7.2.1.6.9 To enable or disable destinations for a job server

Before you can use a destination, the destination must be enabled and configured on the Adaptive Job Servers.

By default, when the BI platform runs a scheduled report or program object, it stores the output instance it creates on the Output File Repository Server (FRS). When you choose a destination (other than
Default Enterprise Location) to schedule or send an object to, the BI platform stores the output instance on the Output FRS and saves a copy at the destination you specify.

By default, the BI Inbox destination is enabled and configured on the Adaptive Job Servers so that you can distribute reports and documents. You can enable and configure additional destinations on the Adaptive Job Server.

1. In the CMC, select the Servers area.
2. Select the Adaptive Job Server for which to enable or disable a destination.
3. Select Manage > Properties.
4. In the "Properties" dialog box, click Destinations.
5. Perform one of the following actions:
   • To enable a destination, select it in the Destination list, and click Add. After you enable a destination, you must configure it.
   • To disable a destination, select it in the Destination list, and click Remove.
6. Click Save or Save & Close.

7.2.1.7 Crystal report alert notification

Note:
Alert notification applies only to Crystal reports. It does not apply to Web Intelligence documents.

Crystal report alert notifications are different from alerting in BI launch pad. Alert notifications are custom messages, created in SAP Crystal Reports, that appear when conditions are met by data in a report. When an alert condition (defined in SAP Crystal Reports) is met, an alert is triggered and its message appears, indicating actions a user should take or containing information about report data.

In BI platform, you can optionally send alert notification when scheduling a Crystal report. When alert notification is enabled, messages are sent through an SMTP server. You can configure email delivery options, enter email addresses, a subject, and message, enter the URL of the viewer you want recipients to use, and set the maximum number of alert records to send.

The Alert Notification link is available only if a Crystal report object contains alerts. To enable alert notification, you must have the Email (SMTP) destination enabled and configured on Adaptive Job Servers. For more information, see the SAP BusinessObjects Business Intelligence Platform Administrator Guide.

Note:
Alerts are triggered in Crystal report objects, even when alert notification is disabled. However, no notification is sent.

Related Topics
• Differences between alerting and Crystal report alert notifications
In earlier versions of BI platform, you could configure Crystal report alert notifications when you scheduled reports. BI platform still supports this functionality for reports created in SAP Crystal Reports.

7.2.1.7.1 To set an alert notification

1. In the CMC, select the Folders area.
2. Select a report object for which to set alerts.
3. Select Actions > Schedule.
4. In the "Schedule" window, click Notification.
5. Select the Enable alert notification check box.
6. Select Use default settings to deliver alert notification using the default Adaptive Job Server settings, or select Custom settings and specify the email settings.

   Note:
   You can change the default Adaptive Job Server settings in the Servers area of the CMC. For more information, see the SAP BusinessObjects Business Intelligence Platform Administrator Guide.

7. Enter the URL of the viewer that you want recipients to use for the report, or select the default viewer.
   You must use World Wide Web Consortium (W3C) encoding for the viewer URL. For example, replace spaces in the path with %20. For more information, see http://www.w3.org/.

   Tip:
   To set a viewer URL as the default, select Central Management Console in the Applications area of the CMC, select Actions > Processing Settings, and type the URL in the URL (must be URL encoded) box.

   The viewer URL will appear as a hyperlink in the alert notification email.

8. Enter the maximum number of alert records to include in an alert notification.
   A hyperlink in the alert notification will go to a report page containing the records that triggered the alert.

   Tip:
   You enter the alert name and status in SAP Crystal Reports.

9. Click Schedule.

7.2.1.8 Output file formats for instances

Crystal report file formats
You can send or schedule objects to different formats for each type of instance. For information about require options for scheduling a Crystal report to a specific format, see the exporting information in the SAP Crystal Reports 2011 User's Guide.
The Crystal Reports option preserves the most formatting of all options. When you select any other option, BI platform preserves as much formatting as the format allows. However, reports may lose some or all formatting.

**Note:**
If you choose to print a report when it is scheduled, the report instance is automatically sent to the printer in Crystal Reports format. This file format does not conflict with the file format you select when scheduling the report.

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crystal Reports</td>
<td>This .rpt format preserves the most formatting of all output format options. It produces a normal, editable report.</td>
</tr>
<tr>
<td>Crystal Reports (RPTR)</td>
<td>This .rptr format produces a read-only Crystal report.</td>
</tr>
<tr>
<td>Microsoft Excel (97-2003)</td>
<td>This .xls format attempts to preserve the look and feel of the original report. It preserves data and does not merge cells. You must specify some formatting properties for the report.</td>
</tr>
<tr>
<td>Microsoft Excel (97-2003) (Data Only)</td>
<td>This .xls format saves only data, and each cell represents a field.</td>
</tr>
<tr>
<td>Microsoft Excel Workbook Data-only</td>
<td></td>
</tr>
<tr>
<td>Microsoft Word (97-2003)</td>
<td>This .doc format preserves as much formatting as possible, including graphics. Each object appears in an individual text field.</td>
</tr>
<tr>
<td>PDF</td>
<td>.pdf format</td>
</tr>
<tr>
<td>Rich Text Format (RTF)</td>
<td>This .rtf format preserves as much formatting as possible, including graphics. Each object appears in an individual text field. This option is available only from a web viewer.</td>
</tr>
<tr>
<td>Microsoft Word - Editable (RTF)</td>
<td>This .doc format preserves less formatting than the Microsoft Word (97-2003) option. Text appears in lines, and images are placed inline with text.</td>
</tr>
<tr>
<td>Plain Text</td>
<td></td>
</tr>
</tbody>
</table>
You must specify some formatting properties for the report.

Tab Separated Text (TTX)
This format places a tab character between values. You must specify some formatting properties for the report.

Separated Values (CSV)
This .csv format places a specified character between values. You must specify some formatting properties for the report. For example, if you select this option, you must enter characters for the separator and delimiter.

XML
.xml format

Web Intelligence file formats

<table>
<thead>
<tr>
<th>Format</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web Intelligence</td>
<td></td>
</tr>
<tr>
<td>Microsoft Excel</td>
<td></td>
</tr>
<tr>
<td>Adobe Acrobat</td>
<td>.pdf format</td>
</tr>
<tr>
<td>Comma Separated Values (CSV)</td>
<td>.csv format</td>
</tr>
</tbody>
</table>

7.2.1.8.1 To select an output file format
1. In the CMC, select the Folders area.
2. Select a report object for which to choose an output file format.
3. Select Actions > Schedule.
4. Click Formats.
5. Select an output format.
   For example, for a Crystal report, select a format under Format Options for Selected Document, and for a Web Intelligence document, select a format under Output Format.
6. Set the remaining scheduling options as needed.
7. Click Schedule.
Related Topics

- Crystal report instance formatting options

When you schedule a Crystal report instance to some output formats, you may need to set additional options.

7.2.1.8.2 Crystal report instance formatting options

When you schedule a Crystal report instance to some output formats, you may need to set additional options.

Table 7-18: Microsoft Excel (97-2003) format

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Page Range</strong></td>
<td>• To include all pages in a report, select <strong>All</strong>.</td>
</tr>
<tr>
<td></td>
<td>• To include a page range, select <strong>Pages from</strong>, type the first page number</td>
</tr>
<tr>
<td></td>
<td>to include, and type the last page number to include in the <strong>to</strong> box.</td>
</tr>
<tr>
<td><strong>Use the export options defined in the report</strong></td>
<td>Select this check box to use the export options defined in a report. You cannot set any other formatting options.</td>
</tr>
<tr>
<td><strong>Set Column Width</strong></td>
<td>• To set the width of Excel columns based on objects in a report, select <strong>Column width based on objects in the</strong> and choose a report area from which to take the column width in the list.</td>
</tr>
<tr>
<td></td>
<td>• To set a constant column width, select <strong>Constant column width (in points)</strong>, and type the width in the box.</td>
</tr>
<tr>
<td><strong>Export page header and page footer</strong></td>
<td>• To choose when to export page headers and footers in an instance, select <strong>Once Per Report</strong> or <strong>On Each Page</strong>.</td>
</tr>
<tr>
<td></td>
<td>• To exclude page headers and footers from an instance, select <strong>None</strong>.</td>
</tr>
<tr>
<td><strong>Create page breaks for each page</strong></td>
<td>Select this check box to create a page break after each page in a report</td>
</tr>
<tr>
<td><strong>Convert date values to strings</strong></td>
<td>Select this check box to export date values in a report as text strings</td>
</tr>
<tr>
<td><strong>Show gridlines</strong></td>
<td>Select this check box to view gridlines in exported documents</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Use the export options defined in the report</td>
<td>Select this check box to use the export options defined in a report. You cannot set any other formatting options.</td>
</tr>
</tbody>
</table>
| Set Column Width                           | • To set the width of Excel columns based on objects in a report, select **Column width based on objects in the**, and choose a report area from which to take the column width in the list.  
• To set a constant column width, select **Constant column width (in points)**, and type the width in the box. |
| Export object formatting                    | Select this check box to preserve the object formatting.                                             |
| Export images                               | Select this check box to export the images in a report.                                              |
| Use worksheet functions for summaries       | Select this check box to use summaries in a report to create worksheet functions in Excel.          |
| Maintain relative object position           | Select this check box to maintain the position of objects, relative to one another.                  |
| Maintain column alignment                   | Select this check box to preserve the alignment of text in columns in a report.                      |
| Export page header and page footer          | Select this check box to include the header and footer in an instance.                              |
| Simplify page headers                       | Select this check box to use simple page headers.                                                    |
| Show group outlines                         | Select this check box to show group outlines.                                                         |
### Table 7-20: Microsoft Word (97-2003) format

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Page Range</strong></td>
<td>• To include all pages in a report, select <strong>All</strong>.</td>
</tr>
<tr>
<td></td>
<td>• To include a page range, select <strong>Pages from</strong>, type the first page number to include, and type the last page number to include in the <strong>to</strong> box.</td>
</tr>
</tbody>
</table>

### Table 7-21: PDF format

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Page Range</strong></td>
<td>• To include all pages in a report, select <strong>All</strong>.</td>
</tr>
<tr>
<td><strong>Use the export options defined in the report</strong></td>
<td>• To include a page range, select <strong>Pages from</strong>, type the first page number to include, and type the last page number to include in the <strong>to</strong> box.</td>
</tr>
<tr>
<td><strong>Create bookmarks from group tree</strong></td>
<td>Select this check box to create bookmarks in a PDF file based on the tree structure of a report. This makes reports easier to navigate.</td>
</tr>
</tbody>
</table>

### Table 7-22: Rich Text Format (RTF) format

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Page Range</strong></td>
<td>• To include all pages in a report, select <strong>All</strong>.</td>
</tr>
<tr>
<td></td>
<td>• To include a page range, select <strong>Pages from</strong>, type the first page number to include, and type the last page number to include in the <strong>to</strong> box.</td>
</tr>
</tbody>
</table>

### Table 7-23: Microsoft Word—Editable (RTF) format

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Page Range</strong></td>
<td>• To include all pages in a report, select <strong>All</strong>.</td>
</tr>
<tr>
<td></td>
<td>• To include a page range, select <strong>from</strong>, type the first page you want to include, and type the last page you want to include in the <strong>to</strong> box.</td>
</tr>
</tbody>
</table>
### Table 7-24: Plain Text format

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use the export options defined in the report</td>
<td>Select this check box to use the export options defined in a report. You cannot set any other formatting options.</td>
</tr>
<tr>
<td>Insert page break after each report page</td>
<td>Select this check box to insert page breaks after each page in a report.</td>
</tr>
</tbody>
</table>

### Table 7-25: Paginated Text format

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use the export options defined in the report</td>
<td>Select this check box to use the export options defined in a report. You cannot set any other formatting options.</td>
</tr>
<tr>
<td>Number of Characters per Inch</td>
<td>Type a value between 8 and 16 to indicate the number of characters to include per inch. This setting determines how text files appear and are formatted.</td>
</tr>
<tr>
<td>Number of Lines per Page</td>
<td>Type the number of lines of text to include between page breaks.</td>
</tr>
<tr>
<td>Number of Characters per Inch</td>
<td>Type a value between 8 and 16 to indicate the number of characters to include per inch. This setting determines how text files appear and are formatted.</td>
</tr>
</tbody>
</table>
### Table 7-26: Separated Values (CSV) format

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use the export options defined in the report</td>
<td>Select this check box to use the export options defined in a report. You cannot set any other formatting options.</td>
</tr>
<tr>
<td>Delimiter</td>
<td>Type the character to use as the delimiter.</td>
</tr>
<tr>
<td>Separator</td>
<td>Type the character to use to separate values, or select the <strong>Tab</strong> check box.</td>
</tr>
<tr>
<td>Mode</td>
<td>Select <strong>Standard Mode</strong> or <strong>Legacy Mode</strong>.</td>
</tr>
<tr>
<td></td>
<td>When you select <strong>Standard Mode</strong>, you can choose report, page, and group sections to include in an instance. When you select <strong>Legacy Mode</strong> mode, you cannot choose report, page, or group section options.</td>
</tr>
<tr>
<td>Report and page sections</td>
<td>If you chose <strong>Standard Mode</strong>, select <strong>Export</strong> or <strong>Do not export</strong> to indicate whether to export report and page sections.</td>
</tr>
<tr>
<td></td>
<td>If you selected <strong>Export</strong>, select the <strong>Isolate report/page sections</strong> check box if you want to isolate the report and page sections.</td>
</tr>
<tr>
<td>Group sections</td>
<td>If you chose <strong>Standard Mode</strong>, select <strong>Export</strong> or <strong>Do not export</strong> to indicate whether to export group sections.</td>
</tr>
<tr>
<td></td>
<td>If you selected <strong>Export</strong>, select the <strong>Isolate group sections</strong> check box if you want to isolate the group sections.</td>
</tr>
</tbody>
</table>

### Table 7-27: XML

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use the export options defined in the report</td>
<td>Select this check box to use the export options defined in a report. You cannot set any other formatting options.</td>
</tr>
<tr>
<td>XML Exporting Formats</td>
<td>Choose an XML export format, such as <strong>Crystal Reports XML</strong>.</td>
</tr>
</tbody>
</table>
7.2.1.9 To select a cache format for Web Intelligence documents

Selecting a cache format applies only to Web Intelligence documents. Cache formats have no effect on Crystal reports.

When the BI platform runs a scheduled Web Intelligence document, it stores the instance it generates on the Output File Repository Server (FRS). When you select a cache format, the BI platform caches the instance on the appropriate report server. If you do not select a cache format, the system cannot cache the instance.

1. In the CMC, select the Folders area.
2. Select a Web Intelligence document object for which to select a cache format.
3. Select Actions > Schedule.
4. Click Caching.
5. Under Available Formats to Cache, select Microsoft Excel, Standard HTML, and/or Adobe Acrobat.
   You can select more than one format.
   The cache is preloaded with the format(s) you selected.
6. Under Available locales, select the locale(s) to preload the cache with, and click to move the locale(s) to the Selected locales list.
   You can select more than one locale. When you schedule this Web Intelligence document, the BI platform generates cached versions of the document in these locale(s).
   The cache is preloaded with the locale(s) you selected.
7. Set the remaining scheduling options as needed.
8. Click Schedule.

7.2.1.10 Scheduling an object with events

When you schedule an object with events, the object runs only when the event occurs. You can schedule objects to wait for the following event types:

- File-based: Triggered by the existence of a specified file
- Custom: Manually triggered
- Schedule-based: Triggered by another object running

If you want a scheduled object to trigger an event, you must choose a schedule-based event.
Scheduling objects based on an event

When you schedule an object based on an event, the object will run only when the event is triggered and the remaining schedule conditions are met.

If an event is triggered before the start date of the object, the object will not run. If you specified an end date for the object and the event is not triggered before the end date occurs, the object will not run because not all conditions were met.

If you choose a weekly, monthly, or calendar schedule, the object has a specified time period when it can run. The event must be triggered within that time frame for the object to run. For example, if you schedule a weekly report object that runs on Tuesdays, the event must be triggered before the end date of the instance—the end of Monday.

Scheduling objects to trigger an event

Note:
To schedule an object with an event, you must first create the event.

When you schedule an object to trigger a schedule-based event, after the object runs, BI platform triggers the event. For example, if a schedule-based event is based on an instance running successfully, the event is not triggered if the instance fails.

Related Topics
• General object management
• Scheduling an object with events

7.2.1.10.1 To schedule an object based on an event

Perform this task to run a scheduled job after an event has occurred.

1. In the CMC, select the Folders area.
2. Select the object to run based on an event.
3. Select Actions > Schedule.
4. Click Recurrence in the navigation list.
5. In the Run object list, select a run option.
6. Set the remaining recurrence options for the object (start date, end date, and so on) as needed.
7. Click Events in the navigation list.
8. Under Available Events, select one or more events, and click to add the event(s) to the Events to wait for list.
9. Click Schedule.

Related Topics
• Recurrence patterns
• Run options for recurrence patterns
• Events
Events are objects that represent occurrences in the system.

### 7.2.1.10.2 To schedule an object to trigger an event

Perform this task to trigger an event when a scheduled job runs.

1. In the CMC, select the **Folders** area.
2. Select the object that will trigger the event.
3. Select **Actions > Schedule**.
4. Click **Recurrence** in the navigation list.
5. In the **Run object** list, select a run option.
6. Set the remaining recurrence options for the object (start date, end date, and so on) as needed.
7. Click **Events** in the navigation list.
8. Under **Available Schedule Events**, select one or more events, and click to add the event(s) to the **Events to trigger on completion** list.
   - You can select only schedule-based events.
9. Click **Schedule**.

**Related Topics**

- Recurrence patterns
- Run options for recurrence patterns
- Schedule-based events

### 7.2.1.11 To select a server for a scheduled object

You can choose the server on which a scheduled object will run, which gives you more control over load balancing. For example, you can run program jobs on a specific server group so that they do not monopolize system resources.

You can choose the server group that the BI platform will use when a user refreshes a Crystal report or Web Intelligence document instance while viewing it.

1. In the CMC, select the **Folders** area.
2. Select the object to schedule.
3. Select **Actions > Schedule**.
4. Click **Scheduling Server Group** in the navigation list.
5. Select the appropriate option:
   - Choose **Use the first available server** to run the object as quickly as possible, regardless of server groups.
6. Select or deselect Run at origin site to run the object where it is located.
7. Set the rest of your scheduling options and click Schedule.

7.2.1.12 To select languages for report instances

Note: This task applies to SAP Crystal Reports only.
Perform this task if you want to generate report instances in different languages.
1. In the "Folders" management area of the CMC, select the object you want to schedule.
2. Click Actions > Schedule.
3. On the navigation list, click Languages.
4. Select one of the following language options:
   - **Schedule the report in Preferred Viewing Locale**
     This option schedules the report according to the preferred viewing locale you set in your preferences, and creates instances using that locale only.
   - **Schedule the report in Multiple Locales**
     This option schedules the report in multiple languages. If you choose this option, you must also select locales by moving them from the All Locales list to the Selected Instance Locales list.
5. Set other scheduling parameters as required, and click Schedule.

7.2.2 To run objects now

As an alternative to scheduling, you can run objects in bulk from the "Folders" management area of the CMC using Run Now. When you run objects now, they are run instantly using their default scheduling settings.
1. Go to the "Folders" management area of the CMC.
2. Navigate to the object(s) that you want run and select them.
3. Click **Actions > Run Now.**

### 7.2.3 Scheduling objects using object packages

You can schedule objects in batches using the object packages feature. Object packages are distinct objects in BI platform. They can contain any combination of objects that can be scheduled, such as reports, program objects, and Web Intelligence documents. Using object packages simplifies authentication, and allows users to view synchronized data across instances for different objects.

To schedule objects using object packages, first create an object package. Then copy existing objects into the object package. Finally, schedule the object package as you would any object.

**Note:**
You must configure the processing information of each of the components of an object package individually. For example, if you want a report object in an object package to print when scheduled, you must configure it by clicking **Components** in the "Schedule" dialog box and clicking the title of the component you want to print. You can then expand **Print Settings** for the component and set it to print as you would when scheduling the component on its own.

**Related Topics**
- [Configuring object packages and their objects](#)
- [Working with hyperlinked reports](#)

### 7.3 Managing instances

BI platform creates instances from objects. That is, a report instance is created when a report object is scheduled and run by the Job Server. Essentially, a report instance is a report object that contains report data that is retrieved from one or more databases. Each instance contains data that is current at the time the report is processed.

Similarly, BI platform creates a program instance each time that a program object is scheduled and run by the Job Server. Unlike report instances, which can be viewed in their completed format, program instances exist as records in the object history. BI platform stores the program's standard output and standard error in a text output file.

You can view and manage instances by doing either of the following:
- Opening the "History" dialog box for an object.
- Going to the "Instance Manager".
Related Topics

- Viewing instance information
  Manage instances with the Instance Manager or in the "History" dialog box for individual objects.
- To set limits for instances
- Instance Manager

### 7.3.1 Viewing instance information

Manage instances with the Instance Manager or in the "History" dialog box for individual objects.

The following tables identify the columns in each interface and describe the instance information that is displayed.

**Table 7-28: Instance information displayed in the Instance Manager**

<table>
<thead>
<tr>
<th>Column</th>
<th>Information displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>The title of the instance.</td>
</tr>
<tr>
<td>Type</td>
<td>The object type.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of each instance.</td>
</tr>
<tr>
<td>Location</td>
<td>The location of the object in the repository.</td>
</tr>
<tr>
<td>Owner</td>
<td>The user who scheduled the instance.</td>
</tr>
<tr>
<td>Completion Time</td>
<td>The date and time when the instance completed its run.</td>
</tr>
<tr>
<td>Next Run Time</td>
<td>The next time the object will be run if it is on a recurring schedule and has a status of pending.</td>
</tr>
<tr>
<td>Submission Time</td>
<td>The date and time at which the user scheduled the object.</td>
</tr>
<tr>
<td>Start Time</td>
<td>The date and time at which the object began running.</td>
</tr>
<tr>
<td>Duration (seconds)</td>
<td>The duration of the scheduled job.</td>
</tr>
<tr>
<td>Recurrence</td>
<td>The frequency of the scheduled job.</td>
</tr>
<tr>
<td>Expiry</td>
<td>The date and time when the instance finished running or failed.</td>
</tr>
<tr>
<td>Server</td>
<td>The server on which the instance was run.</td>
</tr>
<tr>
<td>Error</td>
<td>The errors, if any, that occurred and caused the object to fail.</td>
</tr>
</tbody>
</table>
Table 7-29: Instance information displayed in the "History" dialog box

<table>
<thead>
<tr>
<th>Column</th>
<th>Information displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance Time</td>
<td>The time and the date of the last update for each instance.</td>
</tr>
<tr>
<td>Title</td>
<td>The title of the instances.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of each instance.</td>
</tr>
<tr>
<td>Run By</td>
<td>The user who scheduled the instance.</td>
</tr>
<tr>
<td>Format</td>
<td>The format in which report instances are stored. Applies to report objects only.</td>
</tr>
<tr>
<td>Parameters</td>
<td>The parameters that were or will be used for each instance. Applies to report objects only.</td>
</tr>
<tr>
<td>Arguments</td>
<td>The command-line options that were or will be passed to the command line interface for each instance. Applies to program objects only.</td>
</tr>
</tbody>
</table>

**Note:**
Depending on the object type, additional columns may appear that are not described in the table.

**Related Topics**
- To view an instance
- To delete an instance

### 7.3.1.1 Instance Manager

The "Instance Manager" lets you view and manage all of the instances in your BI platform deployment from one location. You can use the Instance Manager to perform tasks such as the following:

- Find specific instances.
- Select multiple instances and perform batch operations on them (for example, pause, resume, or delete them).
- View detailed information for a single instance.
- Diagnose and resolve system problems that are causing instances to fail.

The default view of the "Instance Manager" shows all pending instances, sorted by title. To view detailed information about an instance, select the instance and click the **Instance details** icon in the toolbar.
Example: Using the "Instance Manager" for troubleshooting

An administrator logs on to the CMC, checks the "Instance Manager", and notices that several jobs have failed. The administrator filters the list to show only failed jobs from the last two days, and notices that they all seem to have run on the same server. The administrator sorts the list by server and verifies that all of the failed jobs ran on the same server. The error code for each failure is the same. The administrator views detailed information for an instance and discovers that a database connection has been reconfigured improperly. The administrator reconfigures the database connection correctly and returns to the "Instance Manager" to re-run all of the failed jobs.

7.3.1.1.1 Finding specific instances in the Instance Manager

You can find specific instances in the "Instance Manager" using the options under "Find instances meeting the following criteria". The following table describes the options that are available.
Scheduling Objects

Option | How to enable
---|---
**Parent Folder** | Select the Parent Folder check box and browse for a repository folder. BI platform will list all the instances in that folder.

**Owner** | Select the Owner check box and type a user name to find instances scheduled by that user.

**Status** | Select the Status check box, and then choose one of the following status options from the list:
- Success
- Failed
- Running
- Paused
- Pending
- Recurring

**Object Type** | Select the Object Type check box, and then choose an object type from the list.

**Completion Time** | Select the Completion Time check box, and then set the start and stop times.

*Note:* For completed publication instances, it is recommended that you enable Object Type and set it to Publication as well as setting the completion time.

**Next Run Time** | Select the Next Run Time check box, and then set the start and stop times.

You can use more than one option at a time to find instances. Only instances that meet all the criteria you have enabled will be displayed. When you have finished, click **Find**.

*Note:* When you schedule an object to BI Inboxes, the documents that users receive in their BI Inboxes are not considered instances. Therefore, these BI Inbox documents do not appear in the "Instance Manager".

### 7.3.1.2 To manage instances for an object

Perform this task if you want to view and manage instances for a specific object. If you want to view and manage instances for all objects, use the "Instance Manager" instead.

1. In the "Folders" management area of CMC, select an object.
2. Click **Actions > History**.
3. Select an instance or instances.

   **Note:**
   To refresh the list, click **Refresh**. In this case, you do not need to select an instance first.

4. Click either **Run Now**, **Pause**, **Resume**, **Send to**, **Reschedule**, or **Delete**.
   If you click **Run Now**, the system schedules the object to be run immediately. The scheduled job will have a status of Pending.

**Related Topics**
- **Instance Manager**

### 7.3.1.3 To view an instance

1. Select an object in the "Folders" management area of CMC.
2. Click **Actions > History**.
3. In the **Instance Time** column, click the instance you want to view.
   You can also use the "Instance Manager" to view a list of instances by status or by user.

You will need to scroll to the right in order to view all the columns with default width.

**Note:**
You cannot sort instances using the Submission time, Start time, Duration, Recurrence, or Expiry columns.

**Related Topics**
- **Instance Manager**

### 7.3.2 Pausing or resuming an instance

For objects with a status of Pending or Recurring, you can pause and then resume an object's scheduled instances.

For example, if a job server is down for maintenance, you can pause a scheduled instance to prevent BI platform from running the object. Scheduled jobs fail when the job server is not running. When the job server is running again, you can resume the scheduled instance.
7.3.2.1 To pause an instance

1. Go to the "History" dialog box for an object.
2. Select the scheduled instance you want to pause.
3. Click Pause.

7.3.2.2 To resume a paused instance

1. Go to the "History" dialog box for an object.
2. Select the scheduled instance you want to resume.
3. Click Resume.

7.3.3 To delete an instance

You can delete instances from an object as needed. You can delete both scheduled instances, which have a status of recurring or pending, and report or program instances, which have a status of success or failed.

1. Go to the "History" dialog box for an object.
2. Select the instance or instances you want to delete.
3. Click Delete.

7.3.4 To set limits for instances

You set limits to automate regular clean-ups of old instances. At the object level, you can limit the number of instances that remain on the system for the object or for each user or group; you can also limit the number of days that an instance remains on the system for a user or group.

In addition to setting the limits at the object level, you can also set limits at the folder level. When you set limits at the folder level, these limits will be in effect for all objects located within the folder (including any objects found within the subfolders).
Note:
When you set the limits at the object level, the object limits will override the limits set for the folder; that is, the object will not inherit the limits of the folder.

1. In the “Folders” management area of CMC, select an object.
2. Click Actions > Limits.
   The “Limits” dialog box appears.
3. Configure the limits settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete excess instances when there are more than N instances of an object</td>
<td>To limit the number of instances per object, select this check box. Then, type the maximum number of instances that you want to remain on the system. (The default value is 100.)</td>
</tr>
<tr>
<td>Delete excess instances for the following users/groups</td>
<td>To limit the number of instances for users or groups, click Add in this area. Select from the available users and groups and press &gt; to add them to your list. Then click OK. Type the maximum number of instances in the Instance Limit column. (The default value is 100.)</td>
</tr>
<tr>
<td>Delete instances after N days for the following users/groups</td>
<td>To limit the number of days that instances are saved for users or groups, click Add in this area. Select from the available users and groups and press &gt; to add them to your list. Then click OK. Type the maximum age of instances in the Maximum Days column. (The default value is 100.)</td>
</tr>
</tbody>
</table>

4. Click Update.

Related Topics
- To limit report instances at the folder level

7.4 Events

Events are objects that represent occurrences in the system.

Depending on the event type, they can be used for scheduling, alerting, or monitoring system health. The "Events" management area of CMC organizes all events into folders according to event type. Within each event type folder, you can create subfolders to better store and manage events.

Events and scheduling

Event-based scheduling provides you with additional control over scheduling objects: you can set up events so that objects are processed only after a specified event occurs. Working with events consists of two steps: creating an event and scheduling an object with events. That is, once you create an event,
you can select it as a dependency when you schedule an object. The scheduled job is then processed only when the event occurs.

You can create the following types of events to be used in conjunction with scheduling:

• **File events**

  When you define a file-based event, you specify a filename that the **Event Server** monitors for a particular file. When the file appears, the **Event Server** triggers the event. For instance, you might want to make some reports dependent upon the regular file output of other programs or scripts. File events are stored in the **System Events** folder.

• **Schedule events**

  When you define a schedule-based event, you select an object whose existing recurrence schedule will serve as the trigger for your event. In this way, schedule-based events allow you to set up contingencies or conditions between scheduled objects. For instance, you might want certain large reports to run sequentially, or you might want a particular sales summary report to run only when a detailed sales report runs successfully. Schedule events are stored in the **System Events** folder.

• **Custom events**

  When you create a custom event, you create a shortcut for triggering an event manually. Custom events are stored in the **Custom Events** folder.

When scheduling with events, keep in mind that an object's recurrence schedule determines how frequently the object runs. For instance, a daily report that is dependent upon a file-based event will run once a day (as long as the file that you specify appears every day). In addition, the event must occur within the time frame established when you actually schedule the event-based report.

**Tip:**
Use file-based of events for alerting.

**Automatically created events**

The system automatically creates corresponding events when certain types of objects (for example, Crystal reports) are added to the repository.

**Note:**
You can view these types of events in the "Events" area. However, to manage or modify these types of events, you must have access to the corresponding event source or the relevant application.

**Monitoring events**

To monitor the overall health of the system, the BI platform offers Monitoring events. These events correspond to the Monitoring probes that are created and managed in the "Monitoring" area.

**Related Topics**

• **Alerting**
  
  Alerts notify you about changes and notify users and administrators when events are triggered. Use alerting to manage objects and events on the basis of exception.

• **Scheduling an object with events**

• **File-based events**
**7.4.1 File-based events**

File-based events wait for a particular file (the trigger) to appear before the event occurs. Before scheduling an object that waits for a file-based event to occur, you must first create the file-based event in the "Events" management area of the CMC. Then, you can schedule the object and select this event.

File-based events are monitored by the Event Server. When the file that you specify appears, the Event Server triggers the event. CMC then releases any schedule requests that depend on the event.

For example, you want daily reports to run after your database analysis program has finished and written its automatic log file. To do this, you specify the log file in your file-based event, and then schedule your daily reports with this event as a dependency. When the log file appears, the event is triggered and the reports are processed.

**Note:**
If the file already exists prior to the creation of the event, the event is not triggered. In this case, the event is triggered only when the file is removed and then recreated. If you want an event to be triggered multiple times, you must remove and recreate the file each time.

**Related Topics**
- Scheduling an object with events

### 7.4.1.1 To create a file-based event

1. Go to the "Events" management area of the CMC and open the System Events folder.
   File-based events are stored and managed in **System Events**.
2. Click Manage > New > New Event.
3. In the **Type** list, select **File**.
4. Type a name for the event in **Event Name**.
5. Type a description in **Description**.
6. In the **Server** list, select the Event Server that will monitor the specified file.
7. Type a file name in **Filename**.
7.4.2 Schedule-based events

Schedule-based events depend on scheduled objects. When a particular object has been processed, an event is triggered based on a job being completed or on the success or failure of a scheduled object.

Note that you must associate your schedule-based event with at least two scheduled objects. The first object serves as the trigger for the event: when the object is processed, the event occurs. The second object is dependent upon the event: when the event occurs, this second object runs.

For example, assume that you want report objects R1 and R2 to run after program object P1 runs. To do this, first create a schedule-based event in the "Events" management area: specify the Success option for the event (this means the event is triggered only when program P1 runs successfully). Next, you schedule reports R1 and R2 with events; select your new schedule-based event as the dependency. Schedule program P1 with events, and set program P1 to trigger the schedule-based event upon successful completion. When program P1 runs successfully, the schedule-based event is triggered, and reports R1 and R2 are subsequently processed.

Related Topics
• Scheduling an object with events

7.4.2.1 To create a schedule-based event

1. Go to the "Events" management area of CMC and open the System Events folder. Schedule-based events are stored and managed in System Events.

2. Click Manage > New > New Event.
   The "New Event" dialog box appears.

3. In the Type list, select Schedule.

4. Type an event name in Event Name.

5. Complete the Description field.
6. Select an event status option.

<table>
<thead>
<tr>
<th>Event status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>The event is triggered only upon successful completion of a specified object.</td>
</tr>
<tr>
<td>Failure</td>
<td>The event is triggered only upon non-successful completion of a specified object.</td>
</tr>
<tr>
<td>Success or Failure</td>
<td>The event is triggered upon completion of a specified object.</td>
</tr>
</tbody>
</table>

7. To enable Alerting for the event, select Alerting Enabled. When the event is triggered, an alert notification is sent to users.

8. Click OK.

### 7.4.3 Custom events

A custom event occurs only when you explicitly trigger it.

As with all other events, an object based on a custom event runs only when the event is triggered within the time frame established by the object's schedule parameters. Custom events are useful because they allow you to set up a shortcut that, when clicked, triggers any dependent schedule requests.

For instance, assume you want to schedule a number of reports to run them after you have updated information in your database. To do this, create a new custom event, and schedule the reports with that event. When you update the data in the database and you need to run the reports, return to the event in the CMC and trigger it manually. BI platform then runs the reports.

**Note:**
You can trigger a custom event multiple times. For example, you might schedule two sets of event-based program objects to run daily—one set runs in the morning, and one set runs in the afternoon. When you first trigger the related custom event in the morning, one set of programs is run; when you trigger the event again in the afternoon, the remaining set of programs is run. If you neglect to trigger the event in the morning and trigger it only in the afternoon, both sets of programs run at that time.

**Related Topics**
- [Scheduling an object with events](#)
7.4.3.1 To create a custom event

1. Go to the "Events" management area of the CMC and open the Custom Events folder.
2. Click Manage > New > New Event.
3. Type a name for the event in the Event Name field.
4. Complete the Description field.
5. If you want to enable Alerting for the event, select Alerting Enabled and enter a message in the Alert Message field.
   When the event is triggered, the message you enter is included in the alert notification sent to users.
6. Click OK.

Note:
Before you trigger this custom event, schedule an object that depends on this event.

Related Topics
• To schedule an object
• To enable alerting for an event

Alerting is automatically enabled for Crystal reports that contain alerts—that is, users can subscribe to report alerts as soon as a report is added to the repository.

7.4.3.2 To trigger a custom event

1. Go to the "Events" management area of the CMC and open the Custom Events folder.
2. Select a custom event.
3. Click Actions > Trigger Event.

7.4.4 Specifying event rights
You can grant or deny users and groups access to events and event folders, and you can specify events to be available only for certain employees or departments—for example, designating certain events for management or IT.

Users can only see events their rights allow them to see. Rights can be used to hide events that aren't applicable to a particular group. For example, by granting only the ITadmin group access to IT-related events, those events won't appear for a user from the HRadmin group; this makes the event list easier for the HRadmin group to navigate.

**Note:**
By default, events are based on current security settings.

Rights are inherited from the users' parent folders.

**Tip:**
Events are sorted into folders based on event type. Within each event type folder, you can create subfolders to provide more granular sorting for events.

Alerting

8.1 Alerting

Alerts notify you about changes and notify users and administrators when events are triggered. Use alerting to manage objects and events on the basis of exception.

**Subscribing to alerts**
In BI platform, users and administrators can subscribe to alerts in BI launch pad or in the Central Management Console (CMC).

**Enabling alerts**
When new reports are created, report designers enable alerts. As events are triggered, notifications are sent to subscriber email addresses or to a BI system destination (for example, a BI launch pad account).

**Viewing alert notifications**
In BI platform, users and administrators view notifications in BI launch pad or in an email.

Right-click an alert and select **See More** to display alert information, including the alert's title, message, and trigger time.

**Managing alerts**
Content administrators and power users manage alerts in BI launch pad or in the CMC.

System administrators manage alerts in the CMC and control user access by assigning access rights.

**Example: Alerting and Crystal reports**
For example, Julie works at an auto insurance company and tracks the number of claims filed using a Crystal report. Julie subscribes to the daily Claim Number alert and chooses to receive her alert notification by email. After a week, the number of auto insurance claims reaches 10,000, meeting the alert's condition and triggering the alert. Julie receives an email notification and realizes that auto insurance claims have increased dramatically. She informs her manager and recommends launching a campaign to promote safer driving habits.
8.1.1 Alert sources

<table>
<thead>
<tr>
<th>Object that supports alerting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crystal reports</td>
<td>Crystal reports can contain multiple alerts. When you add a report containing alerts to the repository, BI platform automatically creates event objects that correspond to each alert in the report. Event objects are located in the Crystal Reports Events folder, under Events, in the CMC. You can search for alerts using Content Search. <strong>Note:</strong> Only reports created in BI platform support alerting and allow users to subscribe to alert notifications when the reports are added. To subscribe, locate the report, and perform the subscription task on the report object.</td>
</tr>
<tr>
<td>Events (file-based, schedule-based, and custom)</td>
<td>You can enable alerting for any event.</td>
</tr>
</tbody>
</table>

Monitoring uses alerting to notify system administrators of changes in the overall health of BI platform. Alerts based on monitoring probes are located in the Monitoring Events folder, under Events, in the CMC. For more information about monitoring, see the SAP BusinessObjects Business Intelligence Platform Administrator Guide.

Objects created in applications such as Information Steward and Event Insight also use alerting. For more information, see the application's documentation.

8.1.2 Alerting workflow

**Alerting workflow for Crystal reports**

1. The report creator designs a report that contains alerts in SAP Crystal Reports for Enterprise.
2. The report creator or a content administrator adds the Crystal report to a folder in the "Folders" or "Personal Folders" area of the CMC. When the report is added, BI platform automatically creates report event objects, based on the alerts in the report.
3. A user logs on to the CMC or to BI launch pad, locates the Crystal report, and subscribes to the alert.
4. The report creator or a content administrator schedules the Crystal report to run.
If the alert condition is met, the alert is triggered and the user receives notification according to the subscription settings.

**Alerting workflow for events**
1. The content administrator creates an event in the CMC and enables alerting on the new event.
2. The user sees the alert in the "Events" area of the CMC or searches for the alert in BI launch pad, and subscribes to it.
3. The event occurs, triggering the alert.
4. The user receives notification that the event occurred according to the subscription settings.

### 8.1.3 Differences between alerting and Crystal report alert notifications

In earlier versions of BI platform, you could configure Crystal report alert notifications when you scheduled reports. BI platform still supports this functionality for reports created in SAP Crystal Reports.

<table>
<thead>
<tr>
<th>Key difference</th>
<th>Alert notifications in Crystal reports</th>
<th>Alerting in BI launch pad</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported objects</td>
<td>Reports created in Crystal Reports</td>
<td>• Reports created only in Crystal Reports</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Events</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Monitoring probes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Information Steward alerts</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Event Insight alerts</td>
</tr>
<tr>
<td>Supported destinations</td>
<td>Email</td>
<td>• <strong>My Alerts</strong> in BI launch pad</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Email</td>
</tr>
<tr>
<td>Usage</td>
<td>You configure alerts when you schedule a Crystal report. Recipients can include Enterprise users or dynamic users. You must manually enter all recipient email addresses.</td>
<td>You subscribe to alert notifications from the alert source and can change a subscription as needed. Recipients can be Enterprise users or dynamic users. You must manually enter email addresses for dynamic recipients.</td>
</tr>
</tbody>
</table>
### 8.1.4 Locating alert source objects in the CMC

Alert sources are stored in different locations according to their object type. The following table summarizes how to locate different alert sources.

<table>
<thead>
<tr>
<th>Object (alert source)</th>
<th>Location in the CMC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crystal reports</td>
<td>Folders or Personal Folders area</td>
</tr>
<tr>
<td></td>
<td>A list of all Crystal report alerts in the system that support alerting is available in the Crystal Reports Events folder in the Events area of the CMC. To subscribe to an alert, locate the Crystal report in the Folders or Personal Folders area.</td>
</tr>
<tr>
<td>Events (file-based, schedule-based, and custom)</td>
<td>Events area</td>
</tr>
<tr>
<td></td>
<td>Events are organized by event type. Alerting-enabled events are indicated by a icon.</td>
</tr>
</tbody>
</table>

### 8.1.5 Access rights required for alerting

Depending on your role in the alerting workflow and your responsibilities, the access rights you need may vary.

*Table 8-2: Document alert rights*

<table>
<thead>
<tr>
<th>Role</th>
<th>Task</th>
<th>Rights required</th>
</tr>
</thead>
</table>
| User | Subscribe to a document alert | - "View" rights on the document  
- "View" rights on the corresponding event  
- "Subscribe" rights on the user’s own account  
- (To view an instance via a document link in an alert notification) "View Instance" rights on the document |
<table>
<thead>
<tr>
<th>Role</th>
<th>Task</th>
<th>Rights required</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>Unsubscribe from a document alert</td>
<td>• &quot;View&quot; rights on the corresponding event</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• &quot;Subscribe&quot; rights on the user's own account</td>
</tr>
<tr>
<td>User</td>
<td>Receive notification about a document alert</td>
<td>• &quot;View&quot; rights on the corresponding event</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• &quot;View&quot; rights on the document</td>
</tr>
<tr>
<td>Content administrator</td>
<td>Manage destination and parameter settings for a document alert</td>
<td>• &quot;Edit&quot; rights on the document</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• &quot;Edit&quot; rights on the event</td>
</tr>
<tr>
<td>Note:</td>
<td>Manage alerting settings for a document</td>
<td>• &quot;View&quot; rights and &quot;Edit&quot; rights on the document</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• &quot;View&quot; rights and &quot;Edit&quot; rights on the corresponding event</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• &quot;View&quot; rights and &quot;Subscribe&quot; rights on the users or groups to add as subscribers</td>
</tr>
<tr>
<td>Content administrator</td>
<td>Unsubscribe a user from a document alert</td>
<td>• &quot;View&quot; rights on the document</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• &quot;View&quot; rights on the corresponding event</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• &quot;View&quot; rights and &quot;Subscribe&quot; rights on the user</td>
</tr>
<tr>
<td>Content administrator</td>
<td>Trigger a document alert</td>
<td>• &quot;View&quot; rights and &quot;Schedule&quot; rights on the document</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• &quot;View&quot; rights and &quot;Trigger&quot; rights on the corresponding event</td>
</tr>
</tbody>
</table>

Note: To add a user group to the list of subscribers, you must have "View" rights and "Subscribe" rights on the user group object. Having "View" rights and "Subscribe" rights on individual users in a group is not sufficient.
### Table 8-3: Event alert rights

<table>
<thead>
<tr>
<th>Role</th>
<th>Task</th>
<th>Rights required</th>
</tr>
</thead>
</table>
| User                | Subscribe to an event alert | • "View" rights on the event  
• "Subscribe" rights on the user's own account. By default, each user has "Subscribe" rights on her or his own account. |
| User                | Unsubscribe from an event alert | • "View" rights on the event  
• "Subscribe" rights on the user's own account. By default, each user has "Subscribe" rights on her or his own account. |
| Content administrator | Manage alerting settings for an event | • "View" rights and "Edit" rights on the event  
• "View" rights and "Subscribe" rights on users or groups to add as subscribers  
**Note:** To add a user group to the list of subscribers, you must have "View" rights and "Subscribe" rights on the user group object. Having "View" rights and "Subscribe" rights on individual users in a group is not sufficient. |
| Content administrator | Trigger an event | • "View" rights and "Trigger" rights on the event |

### Table 8-4: Alert notification rights

<table>
<thead>
<tr>
<th>Role</th>
<th>Task</th>
<th>Rights required</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>Receive an alert notification</td>
<td>• &quot;View&quot; rights on the corresponding event</td>
</tr>
</tbody>
</table>
| User                | Mark an alert notification as read or unread | • "View" rights on the alert notification  
• "Subscribe" rights on the user account |
| User                | Reread an alert notification    | • "View" rights on the alert notification |
### 8.1.6 Resolving subscription conflicts

As a result of group membership, users can have subscription settings that cause conflicts. When subscription setting conflicts occur, alerting resolves them in the following ways:

- A setting made on a user overrides any settings inherited from group membership.
- A setting made on a subgroup overrides any settings inherited from a group.

A user can inherit different subscription settings from two hierarchically equal groups. In this situation, the user receives alert notifications according to each setting.

**Note:**
The Excluded list overrides all other subscription settings. If a user is subscribed to alerts but is on the Excluded list, the user does not receive alert notifications.

**Example:** *Subscription settings from two hierarchically equal groups*

Julie belongs to the North America Sales group and the South America Sales group, neither of which is a subgroup of the other. The North America Sales group receives Revenue alert notifications in their email and BI Inboxes, while the South America Sales group receives Revenue alert notifications in their email only. As a result of her membership in both groups, Julie receives Revenue alert notifications in her email and her BI Inbox. If the report has defined parameters (for example, regional parameter values of “North America” and “South America”), Julie receives separate email alert notifications; otherwise, the alerts are combined into one email.

### 8.1.7 Best practices for alerting

- Do not rename Crystal report alerts. BI platform interprets a renamed Crystal report alert as a new object. If you rename an alert, subscription settings for the alert are lost.
- Subscribe to specific groups instead of to the Everyone group.
- For high-volume alerts, use email as a destination instead of BI launch pad. Alert messages sent to BI launch pad are stored in the system and, once accumulated, can interfere with system performance.
### 8.2 Alerting tasks

#### 8.2.1 To enable alerting for an event

Alerting is automatically enabled for Crystal reports that contain alerts—that is, users can subscribe to report alerts as soon as a report is added to the repository.

Enabling alerting for events requires additional steps, such as enabling an alert when a new event is created.

1. In the **Events** area of the CMC, select the event for which you want to enable alerting.
2. Click **Manage > Properties**.
3. In the "Properties" dialog box, click **Event Settings** in the navigation pane.
4. Select the **Alerting Enabled** check box, and enter a message in the **Alert Message** box to send to subscribers when the alert is triggered.

   **Note:**
   You cannot enter messages for schedule-based events.

5. Click **Save & Close**.

#### 8.2.2 To subscribe to an alert

1. In the **Events** area of the CMC, locate and select the alert source.
2. Select **Actions > Subscribe**.
   The "Subscribe to Publication" dialog box appears.
3. Under **Destinations**, select a destination for the alert:
4. If multiple documents are listed under Alert, select the check box for each alert that you want to receive.

5. To specify a parameter for the alert, under Parameters, click Edit, and modify the parameter value. If a document is personalized, personalization details appear when you hover the mouse over an alert check box.

6. Configure the remaining alert subscription options as needed. Depending on the alert source, additional subscription options may appear. For example, for Crystal reports that contain multiple alerts, you must select which alert to subscribe to.

7. Click OK.

The next time the alert is triggered, a notification is sent to the destination you selected. To send the alert notification to a different destination, select the alert source, and select Actions > Modify Subscription. You can also use this option to select the Crystal report that an alert is subscribed to.

Notifications are sent using the destination defaults set for the Alerting application, unless you specify custom settings for the alert source.

**Related Topics**

- To manage alerting settings for an alert source
  - Unless you change the alerting settings for an alert source, notifications are sent using the default destination settings for the Alerting application.

- Locating alert source objects in the CMC

---

### 8.2.3 To unsubscribe from an alert

1. In the Events area of the CMC, locate and select the alert source.
2. Select Actions > Unsubscribe.
3. In the "Unsubscribe from Alert(s)" dialog box, when prompted for confirmation, click **Unsubscribe**.

**8.2.4 To unsubscribe other users from an alert**

1. In the **Events** area of the CMC, locate and select the alert source.
2. Select **Actions > Manage Subscribers**.
   The "Manage Subscribers" dialog box appears.
3. Click **Subscriber List** in the navigation pane.
4. Select a user or user group you want to stop subscribing alerts to, and click **Unsubscribe**.

**8.2.5 To subscribe other users to an alert**

1. In the **Events** area of the CMC, locate and select the alert source.
2. Select **Actions > Manage Subscribers**.
3. In the "Manage Subscribers" dialog box, click **Subscriber List** in the navigation pane.
4. To add new subscribers:
   a. Click **Add**.
   b. In the "Add Subscribers" dialog box, use the > button to move users and groups from the **Available** list to the **Subscribed** list, and click **Add Default Subscription(s)**.
   c. In the "Edit Subscriptions" dialog box, configure the alert and destination options as needed.
      For example, you can modify which alerts to subscribe to (if the alert source contains multiple alerts). Depending on the alert source, other settings may be available.
   d. Click **Save & Close**.
5. To edit settings for a subscriber:
   a. Select a user in the **Subscriber** column, and click **Edit**.
   b. To edit which alerts the user will receive, in the "Edit Subscriptions" dialog box, click **Alerts** in the navigation list, and select the check box for each alert you want to subscribe the user to.
      If the alert source contains multiple alerts, each alert is listed. Otherwise, only one alert appears.
   c. To edit which destinations an alert will be sent to, click **Destinations** in the navigation list, and select the check box for each destination you want to sent the alert to.
      Only email destinations that are enabled and configured on the Adaptive Job Server are available.
      If no email destination is configured, only the **My Alerts** check box appears.
   d. If available, configure other alerting options as needed.
      Depending on the alert source, additional options may be available.
   e. Click **Save & Close**.
6. In the "Manage Subscribers" dialog box, click **Save & Close**.

**8.2.6 To forward an alert notification to another user's BI Inbox**

You can forward alert notifications from **My Alerts** to another user's BI Inbox.

1. On the **Documents** tab, expand the **My Documents** drawer, and click **My Alerts**.
2. Right-click the alert notification that you want to forward and select **Organize > Forward**.
3. Enter the user BI Inbox to forward the alert to, and click **OK**.

**8.2.7 To exclude users from an alert**

Excluding users is useful when you want to subscribe only a handful of users in a group. You first subscribe the entire group and then exclude users who do not need to receive alert notifications.

**Note:**
The **Excluded** list overrides all other subscription settings for a user.

1. In the **Events** area of the CMC, locate and select the alert source.
2. Select **Actions > Manage Subscribers**.
   
   The "Manage Subscribers" dialog box appears.
3. Ensure **Excluded List** is selected on the navigation panel.
4. Use the > button to move users or groups from the **Available** list to the **Excluded** list.
5. Click **Save & Close**.

**Related Topics**
- [Locating alert source objects in the CMC](#)

**8.2.8 To manage alerting settings for an alert source**

Unless you change the alerting settings for an alert source, notifications are sent using the default destination settings for the Alerting application.

1. In the **Events** area of the CMC, locate and select the alert source.
2. Select **Actions > Manage Alerting Settings**.
   
   The "Manage Alerting Settings" dialog box appears.
3. To enable BI launch pad as a destination, select the **Enable My Alerts** check box.  
   This option sends alert notifications to subscriber BI launch pad accounts, and subscribers can view them under **My Alerts** in BI launch pad.

4. To enable email as a destination, select the **Enable Email** check box, and then select **Use default email settings** or **Use custom email settings**.  
   If you selected **Use default email settings**, the default settings are derived from alerting values set in the **Applications** area.

5. If you selected **Use custom email settings**, perform the following actions as needed:
   a. In the **From** box, type a return email address, or select variables for the email address from the **Add placeholder** list.
   b. In the **To** box, type each email address that you want to send alert notifications to, or select variables for the email address from the **Add placeholder** list.
   c. In the **Cc** box, type each email address that you want to send alert notifications to, or select variables for the email address from the **Add placeholder** list.
   d. In the **Bcc** box, type the email address of each undisclosed recipient that you want to send alert notifications to, or select variables for the email address from the **Add placeholder** list.
   e. In the **Subject** box, type the subject of the alert notification, or select variables for the subject from the **Add placeholder** list.
   f. In the **Message** box, type the message for the body of the alert notification, or select variables for the message from the **Add placeholder** list.
   g. Select the **Add Attachment** check box to add an attachment to the alert notification.
   h. Under **File Name**, select **Use Automatically Generated Name** or **Use Specific Name**. If you select **Use Specific Name**, type a file name or select a placeholder in the list.
   i. Select the **Add File Extension** check box to automatically a file extension to file names.

   **Caution:**  
   If you do not add a file extension to a file name, the document cannot be opened.

6. Click **Save & Close**.

**Related Topics**

- **Locating alert source objects in the CMC**
Managing Profiles

9.1 How profiles work

Profiles work together with publications to personalize content.

Profiles as objects
Profiles are also objects in BI platform that let you classify users and groups. Profiles link users and groups to profile values, which are used to personalize data within a report. Profiles also use profile targets, which describe how a profile is applied to a report. By assigning different profile values, the data within a report can be tailored to specific users or groups. Many different personalized versions of the report are then delivered to your users.

Profiles and roles
Often profiles reflect the roles of users and groups in an organizational structure. For example, you could have a Department profile that includes all employees in an organization. The users and groups each have profile values that reflect their roles in the organization (for example, “Finance”, “Sales”, and “Marketing”). When a publisher applies the Department profile to a publication, the employees receive data that is relevant to their department.

Profiles and document content
Profiles are used to refine or filter a document's content; profiles do not control access to data. When you use profiles to display a subset of the data to a user, it is not the same as restricting the user from seeing that data. If users have the appropriate rights and access to the document in its original format, they may still see the complete data for the document by viewing it in BI launch pad or the CMC. Profiles filter data views without changing or securing the data being queried from the data source.

9.1.1 Profiles and the Publishing workflow

Using a profile to personalize a publication is a two-part process. First, create the profile in the "Profiles" area of CMC. Creating a profile involves these tasks:

1. Create a profile.
2. Add users and groups to the profile.
3. Assign profile values to each user and group for that profile.
4. Specify a global profile target if necessary.
When you create the publication, you perform these tasks:
1. Add users and groups as recipients.
2. Specify a local profile target for the profile to filter (for example, a field in a Crystal report).
3. Specify the profile(s) to use for personalization.

### Related Topics
- **Personalization**
  
  Personalization is the process of filtering data in source documents so that only relevant data appears to publication recipients.

### 9.1.2 To create a profile

1. Go to the "Profiles" management area of the CMC.
2. Click **Manage > New > New Profile**.
   
   The "Create New Profiles" dialog box appears.
3. Type a name for the profile in the **Title** field.
4. Complete the **Description** field.
5. Click **OK**.

### Related Topics
- **Profile targets and profile values**
- **To specify a profile value**
- **Specifying profile rights**

### 9.2 Profile targets and profile values

To use a profile to personalize a publication, you must set profile values and profile targets for the profile.

**Profile targets**

Profile targets are data sources that profile values filter and interact with to provide personalized publications. There are two types of profile targets:

- **Local profile target**
A local profile target can be a variable in a Web Intelligence document, or a field or parameter in a Crystal report. When you use a local profile target, the source document that contains the local profile target is filtered for the publication recipients.

- Global profile target

A global profile target can be a universe. You must also specify an object within that universe. This type of profile target can filter all source documents that use the universe.

**Note:**
You can use global profile targets for publications that contain Web Intelligence documents. You cannot use global profile targets with Crystal reports.

**Profile values**
Profile values are attributes detailed to specific users or groups when you assign these users and groups to a profile. When a profile is applied to a publication, the users and groups assigned to that profile receive versions of the publication that are filtered according to the profile values set for them.

**Note:**
If you assign profile values to both users and groups, note that inheritance works the same way for profiles as it does for security settings. For more information, see the “Setting Rights” chapter in the SAP BusinessObjects Business Intelligence Platform Administrator Guide available on the SAP Help Portal at [http://help.sap.com](http://help.sap.com).

**Using profile targets and profile values**
Profile targets and profile values enable a profile to personalize a publication for recipients. The users and groups specified for a profile receive filtered versions of the same publication that only display the data most relevant to them.

Consider a situation where a global sales report is distributed to a company's regional sales teams in North America, South America, Europe, and Asia. Each regional sales team only wants to view the data that is specific to their region. The administrator creates a Regional Sales profile and adds each regional sales team to the profile as a group. The administrator assigns each regional sales team a corresponding profile value (for example, the North America Sales group is assigned “North America”). During Publishing, the publisher uses the Region field in the global sales report as a local profile target, and applies the profile to the report. The global sales report is filtered according to the profile values set for each regional sales team. When the global sales report is distributed, each regional sales team receives a personalized version that only displays regional sales data.

### 9.2.1 To specify a global profile target

This task lets you specify a global profile target for a profile. Local profile targets are specified during the Publishing process.

1. In the "Profiles" area of the CMC, select the profile that you want to specify a profile target for.
2. Click **Actions > Profile Targets**.
   - The "Profile Targets" dialog box appears.
3. Click **Add**.
4. Select a universe from the **Universe Name** list.
5. Enter a class name in the **Class Name** field, or click **Select object from the universe**.
6. Enter a variable name in the **Variable Name** field, or click **Select object from the universe**.
7. Click **OK**.

### 9.2.2 Specifying profile values

You can use static values, expressions, or variables as profile values.

Static values are the most common profile value type and can be used to filter any source document type. You can also enter multiple static values for a user or group for one profile. For example, a manager interested in receiving data from several departments can have “Production”, “Design”, and “Marketing” as static profile values for a Department profile.

Expressions use syntax that is specific to certain source document types. You can use SAP Crystal Reports and Web Intelligence expressions to perform more complex personalization and filtering. Expressions are useful if you want to filter a range of values, or a range of values greater than or less than a given value, for a user.

If you want to use user information as profile values, you can use variables for user names, full names, and email addresses. These variables are mapped to user information and act as placeholders. When you apply the profile to a publication, the system retrieves the most recent information for users.

Profile value variables are useful because they decrease administrative costs and possible errors associated with entering information manually. Consider a situation where an administrator maps an AD user to the system and adds the user to two profiles. Instead of entering the information manually for each profile value and possibly making typographical errors, the administrator can specify which variables to use for the user's data.

For third-party users, if the user's information changes in an external system, the data in BI platform can be updated to reflect those changes when a publication is run.

**Tip:**
If you have a third-party user account with data that should not be overwritten by user attributes in an external directory, open the "Properties" dialog box for the user object and clear the **Import full name and email address** check box.

**Note:**
Static-value profile values can filter string fields in source documents only. If you map the incorrect type of field to the profile, personalization will fail.

### 9.2.2.1 To specify a profile value
This task lets you specify a profile value for a user or group.

1. In the "Profiles" area of the CMC, select a profile.

   **Tip:** Alternatively, you can select a user or group in the "Users and Groups" area.

2. Click **Actions > Profile Values**.

   The "Profile Values" dialog box appears.

3. Click **Add**.

4. Click **Choose**.

5. Select a user or group or multiple users or groups, and click > to move them into the list on the right side.

6. Click **OK**.

7. Enter a profile value for the selected user or group or multiple users or groups.

   You can use several different types of profile values. You can enter a static profile value or an expression. You can also specify variable profile values for third-party users and groups mapped to the system.

   - If you want to use a value:
     a. Click **Value**.
     b. Enter a value in the **New Value** field.
     c. Click **Add**.

   **Tip:**
   - You can add multiple static values for a user or group. Repeat steps 1-3 for each static value that you want to add.
   - You can use %NULL% as a static profile value if the user or group does not have values that the profile can filter for personalization.

   - If you want to use a filter expression:
     a. Click **Filter Expression**.
     b. Depending on the type of expression you want to use, enter an expression in the **Web Intelligence formula expression** field or the **Crystal reports expression** field.

       **Note:**
       To use a Web Intelligence expression, you must first specify a global profile target for the profile.

       **Tip:**
       If you want to apply the profile to multiple document types, you can enter filter expressions in all three fields.

8. Click **OK**.

**Related Topics**

- To use variables as profile values
9.2.2.2 To use variables as profile values

This task lets you specify variable profile values for users when you add them to a profile. You can specify variable profile values for the user's full name, account name, or email address.

1. In the "Profiles" area of the CMC, select the profile that you want to add the user or group to.
2. Click Actions > Profile Values.
   The "Profile Values" dialog box appears.
3. Click Add.
4. Click Choose.
5. Select the user or group from the list on the left, and click > to move the user or group to the list on the right.
6. Click OK.
7. Click Value.
8. Select a placeholder variable from the Add placeholder list, and click Add.

The following table summarizes the variables that can be used for the externalization of profiles.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>This variable is associated with the user's account name.</td>
</tr>
<tr>
<td>User's full name</td>
<td>This variable is associated with the user's full name.</td>
</tr>
<tr>
<td>E-mail address</td>
<td>This variable is associated with the user's email address.</td>
</tr>
</tbody>
</table>

**Tip:**
These variables can also be used for groups. You can map the E-mail address variable to a common email address for the entire group. When you do this, the system resolves the variable and retrieves individual email addresses for each member of the group.

The placeholder appears in the Existing values field.

9. Click OK.

When you use the profile to personalize a publication, the profile value for the third-party user will update itself with the most recent user information. For example, if the user's email address has changed since the last time the publication was run, the email address used for the profile value will change the next time the publication runs.

9.3 Resolving conflicts between profiles
Conflicts between profiles can arise when users and groups are assigned to multiple profiles. If a document is delivered to a user that has two profiles that conflict, the conflict must be resolved.

For example, Tony is a product manager in the Mexico office. He is assigned a profile called Region that personalizes his documents to show only data from Mexico. He is also assigned a profile called Management that personalizes his documents to show data for product managers.

If a document uses both of these profiles, which data will Tony see? According to one profile, he'll see data for Mexico. According to the other profile, he should see only data for product managers.

You can resolve this conflict in two ways in BI platform:

• Do not merge
  BI platform determines all possible views of a publication and produces a unique view for each one. In the example, Tony would receive one publication personalized to show data for Mexico, and another publication that shows product manager data.

• Merge
  If you choose Merge, BI platform determines the different possible data views and merges non-conflicting profiles. This type of profile resolution is designed for role-based security. In the example, Tony would receive a single publication personalized to show data for Mexican product managers.

You can specify profile resolution settings when you define your publications.

Note:
This “do not merge/merge” scenario applies to inherited profile values only. If a user is assigned two profile values explicitly, the publication instances are always merged.

Related Topics
• To specify a profile resolution method

9.3.1 Conflicts between profile values

Conflicts between profile values can arise when a user inherits two contradictory profile values as a result of group membership. In general, explicitly assigned profile values override profile values inherited from group membership. A profile value assigned to a user or a subgroup overrides the profile value inherited from group membership.

For example, David belongs to the North America Sales and Canada Sales groups. The Canada Sales group is a subgroup of the North America Sales group. These groups are both added to the Region profile. From the North America Sales group, David inherits a Region profile value of “North America”, and from the Canada Sales group, David inherits a Region profile value of “Canada”. In this case, the profile value that is assigned to the subgroup overrides the profile value that is assigned to the group, and David receives a publication with data for Canada.
Conflicts between profile values can also arise when a user is explicitly assigned a profile value that contradicts a profile value inherited from group membership. For example, Paula belongs to the North America Sales group, which has a Region profile value of “North America”. The administrator also assigns Paula a Region profile value of “Spain”. In this case, the profile value that is assigned to the member overrides the profile value that is inherited from the group, and Paula receives a publication with data for Spain.

However, sometimes a user can inherit different profile values from two different groups for one profile. Both groups are hierarchically equal; one group is not a subgroup of the other group, so one profile value does not override the other. In this case, both profile values are valid and the user receives a publication instance for each profile value.

As a result of this profile value conflict, sometimes duplicate report instances are included in different publication instances and sent to the same user. For example, Sandra is a manager in two North America offices and receives a publication via email that contains two reports. Report 1 is personalized using the Region profile, for which Sandra inherits the conflicting profile values “USA” and “Canada” from group membership. Report 2 is personalized using the Role profile, for which Sandra inherits the profile value "Manager". If there is no profile value conflict, after personalization, Sandra receives one email with a merged Report 1 instance (USA and Canada data) and a Report 2 instance (Manager data). Instead, Sandra receives two emails: one email includes a Report 1 USA instance, the other email includes a Report 1 Canada instance, and both emails have the same Report 2 Manager instance.

**Tip:**
To avoid profile value conflicts that result in duplicate publication instances being sent, when possible, explicitly assign profile values to users instead of allowing users to inherit profile values from group membership.

### 9.4 Specifying profile rights

You can grant or deny users and groups access to profiles. Depending on how you organize your profiles, you may have specific profiles that you want to be available only for certain employees or departments.

Users with access to CMC will only be able to see profiles they have the rights to see, so you can use rights to hide profiles that aren't applicable to a particular group. For example, by granting only the ITadmin group access to IT-related profiles, those profiles won't appear for a user from the HRadmin group; this makes the profile list easier for the HRadmin group to navigate.

10.1 About publishing

Publishing makes documents (such as Crystal reports and Web Intelligence documents) automatically available via email or FTP server, saved to disk, and managed through BI platform (for web viewing, archiving, retrieval, and scheduling).

In BI launch pad or the CMC, you can tailor documents to different users or recipients, schedule documents to run at intervals, and send the documents to multiple destinations, including BI Inboxes and email addresses.

10.2 What is a publication?

A publication is a collection of documents intended for distribution to a mass audience. Before the documents are distributed, the publisher defines the publication using a collection of metadata. The metadata includes the publication source, its recipients, and the personalization applied.

Publications can help send information through your organization more efficiently. For example:

- They enable you to easily distribute information to users or groups of users and to personalize the information each user or group receives.
- They deliver targeted business information to users or groups of users through a password-protected portal or across an intranet, an extranet, or the Internet.
- They minimize database access by eliminating the need for users to send process requests.

You can create different types of publications based on Crystal reports or Web Intelligence documents.

10.3 Publishing concepts
10.3.1 Report bursting

During publishing, data in documents is refreshed against data sources and personalized before a publication is delivered to recipients—this combined process is known as report bursting.

Depending on the size of a publication and how many recipients it is intended for, you can use the following report bursting methods:

- **One database fetch for all recipients**: All documents in a publication are refreshed once, personalized, and delivered to each recipient. This report bursting method uses the data source logon credentials of the publisher to refresh data.

  This is the default option for Web Intelligence document publications and the recommended option to minimize the impact of publishing on your database. The performance of this option depends on the number of recipients.

  This option is secure only when source documents are delivered as static documents. For example, a recipient who receives a Web Intelligence document in its original format can modify the document and view data associated with other recipients. However, if the document is delivered as a PDF file, data is secure.

  **Note:**
  This option is secure for most Crystal reports, regardless of whether reports are delivered in their original format.

- **One database fetch for each batch of recipients**: A publication is refreshed, personalized, and delivered to recipients in batches, based on the personalization values specified for the recipients. The batch size depends on the specified personalization value and is non-configurable. This report bursting method uses the data source logon credentials of the publisher to refresh data.

  This is the default option for Crystal report publications and the recommended option for high-volume scenarios. With this option, you can process batches concurrently on different servers, which can greatly decrease the processing load and time required for large publications.

  **Note:**
  This option is not available for Web Intelligence documents.

- **One database fetch per recipient**: Data in a document is refreshed for every recipient. This report bursting method uses the data source logon credentials of the recipient to refresh data. For example, if there are five recipients for a publication, the publication is refreshed five times.

  This option is recommended to maximize security for delivered publications.

  For Crystal reports based on universes or on Business Views support, select this option to maximize security.

**Related Topics**

- **To select a report bursting method**
10.3.2 Delivery rules

Delivery rules affect how documents in publications are processed and distributed. When you set delivery rules on documents, the publication is delivered to recipients only if the content in the documents meets certain conditions.

**Note:**
This feature is not available for Web Intelligence documents.

There are two types of delivery rules:

<table>
<thead>
<tr>
<th>Delivery rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global delivery rule</td>
<td>If the data in a designated document meets the delivery rule, the publication is delivered to all recipients.</td>
</tr>
<tr>
<td></td>
<td>The designated document for a global delivery rule can be different from the document or documents used in a publication. For example, you can set a global delivery rule on a document that is used as a dynamic recipient source, instead of on a document in the publication.</td>
</tr>
<tr>
<td>Recipient delivery rule</td>
<td>If the data in the recipient's instance meets the delivery rule, the instance is delivered to all recipients.</td>
</tr>
</tbody>
</table>

If a publication has both a global delivery rule and recipient delivery rules, the global delivery rule is evaluated first to determine whether the publication will be processed. If the publication meets the global delivery rule, BI platform evaluates the recipient delivery rules to determine which instances to process and distribute for each recipient.

How you set delivery rules depends on the document type that you want to publish. For Crystal reports, you specify a delivery rule based on a named alert that the report designer creates in the Crystal report. You can also set a delivery rule based on whether a personalized publication contains any data.

The following diagram illustrates how an alert-based global delivery rule works. The global delivery rule is set on a document in the publication. The Crystal report has a Revenue alert for values greater than 100,000. The publisher creates a global delivery rule based on the Revenue alert. The Crystal report will be delivered to recipients only if revenue exceeds 100,000. In this case, the delivery rule is met so the Crystal report is delivered.

*Figure 10-1: Global delivery rule is met*
The following diagram illustrates how a recipient delivery rule works. The publisher creates a recipient delivery rule in which a Crystal report will be delivered only to recipients for whom the report contains data. When the report is personalized for each recipient, Green Recipient has no data in the Crystal report and does not receive the publication. Blue Recipient and Orange Recipient have data in the report and, therefore, receive the publication.

Figure 10-2: Recipient delivery rule is not met

In publications that contain multiple documents and objects, each document can have its own recipient delivery rule. The following options are available for processing and delivery:

- If a document in a publication fails to meet its recipient delivery rule for a recipient, the entire publication is not delivered for that recipient.
- If a document in the publication fails to meet its recipient delivery rule for a recipient, that document is not delivered, but all other documents in the publication are delivered for that recipient.

Delivery rules are useful because they more efficiently process and distribute publications intended for many recipients. For example, a publisher at an insurance company creates a publication for its clients that contains the following objects:

- An insurance bill (personalized Crystal report)
- A monthly statement (personalized Crystal report)
- A payment methods brochure (PDF file)

In the insurance bill, there is an Amount Due alert for values greater than zero. The publisher creates an Amount Due recipient delivery rule for the insurance bill in which the insurance bill is published and
distributed only if a client owes a payment. The publisher also specifies that the entire publication should not publish if the insurance bill fails to meet the delivery rule; he does not want clients to receive a monthly statement and a brochure when they do not owe a payment. When the publication runs, the publication is processed and distributed only to clients who owe payments.

**Note:**
If a Crystal reports publication is scheduled to print when the publication runs, the print job occurs, regardless of whether a document in the publication fails to meet a delivery rule and is not delivered to a recipient. This is because print jobs are processed during personalization, and delivery rules are applied to publications after personalization.

**Related Topics**
- **(Optional) To set a global delivery rule on a Crystal report**
  Global delivery rules determine whether a publication will be processed and delivered to all recipients. You can set a global delivery rule on any Crystal report in the BI platform.
- **(Optional) To set a recipient delivery rule on a Crystal report**
  Recipient delivery rules determine whether a publication is delivered to a particular recipient after processing and personalization. After creating a publication, you can open the publication and change the delivery rules for it.

### 10.3.3 Dynamic recipients

Dynamic recipients are publication recipients who do not have user accounts in BI platform but do have user information in an external data source, such as a database or an LDAP or AD directory.

To distribute a publication to dynamic recipients, use a dynamic recipient source—a document or custom data provider that provides information about publication recipients outside of BI platform. You can use one dynamic recipient source per publication to link directly to an external data source and retrieve the latest data for dynamic recipients. Dynamic recipient sources decrease administrative costs because you do not have to create BI platform user accounts for dynamic recipients before distributing publications to them.

For example, when a billing company distributes bills to customers who are not BI platform users, the customer information exists in an external database. The publisher creates a document based on the external database and uses the document as a dynamic recipient source for a publication. Customers receive the billing publication, and the dynamic recipient source allows the publisher and the system administrator to maintain up-to-date contact information.

You can perform the following actions with a dynamic recipient source:
- Simultaneously deliver a single publication to dynamic recipients and to BI platform users

**Note:**
Dynamic recipients cannot unsubscribe themselves automatically from a publication.
• Preview dynamic recipients list when you create a publication
• Specify whether to deliver a publication to all dynamic recipients or to exclude some dynamic recipients
• Deliver publications to external destinations, such as email or an FTP server

**Note:**
BI Inbox is not a valid destination for dynamic recipients because they do not have a user account in BI platform.

To use a dynamic recipient source, specify a column for each of the following values:
• Recipient ID (required)
• Full name of recipient
• Email address

The **Recipient ID** column determines the number of dynamic recipients who will receive the publication. Sort dynamic recipient sources by recipient ID.

For general information about creating reports, see the *SAP Crystal Reports User Guide*. For information about creating a custom-coded dynamic recipient source, see the *SAP BusinessObjects Business Intelligence Platform Java SDK Developer Guide*.

### 10.3.4 Publication delivery destinations

Destinations are the locations to which publications are delivered.

A destination can be the BI platform location in which a publication is stored, a BI Inbox, an email address, an FTP server, or a directory in the file system. You can specify multiple destinations for a publication.

If you publish multiple Crystal reports, you can merge them, on a per-destination basis, into a single PDF file.

If you publish a publication as a compressed (.zip) file, you can compress or extract instances on a per-destination basis. For example, you can compress instances for email recipients and extract instances for BI Inboxes.

#### 10.3.4.1 Destinations

The following destinations are available:
• Default Enterprise Location
• BI Inbox
• Email
- FTP Server
- File System
- SAP StreamWork (if enabled and configured)

Table 10-2: Default Enterprise Location destination

<table>
<thead>
<tr>
<th>Description</th>
<th>Instance is saved to</th>
</tr>
</thead>
<tbody>
<tr>
<td>The publication is accessible from the folder it was created in. You can perform the following actions:</td>
<td></td>
</tr>
<tr>
<td>• Merge all exported PDF documents (Crystal reports only)</td>
<td>Output File Repository Server</td>
</tr>
<tr>
<td>• Package the publication as a compressed (.zip) file</td>
<td>Historical instances are saved to the default Enterprise server but not to any other destination.</td>
</tr>
<tr>
<td>If you send a publication to this location, choose a folder that is accessible to all recipients.</td>
<td></td>
</tr>
</tbody>
</table>
Table 10-3: BI Inbox destination

<table>
<thead>
<tr>
<th>Description</th>
<th>Instance is saved to</th>
</tr>
</thead>
<tbody>
<tr>
<td>The publication is sent to each recipient's BI Inbox. You can perform the</td>
<td></td>
</tr>
<tr>
<td>following actions:</td>
<td></td>
</tr>
<tr>
<td>• Use the default settings for the destination</td>
<td>• Output File Repository Server</td>
</tr>
<tr>
<td>• Deliver objects to individual users</td>
<td>• Specified BI Inboxes</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td></td>
</tr>
<tr>
<td>To quickly locate a user, you can search for a recipient's user name,</td>
<td></td>
</tr>
<tr>
<td>full name, or email address in the <strong>Find title</strong> box.</td>
<td></td>
</tr>
<tr>
<td>• Use the default file name, enter a file name, or add placeholders.</td>
<td></td>
</tr>
<tr>
<td>If you select <strong>Use Specific Name</strong>, type a file extension or add the</td>
<td></td>
</tr>
<tr>
<td><strong>File Extension</strong> placeholder to the box.</td>
<td></td>
</tr>
<tr>
<td>• Automatically add the extension to file name</td>
<td></td>
</tr>
<tr>
<td><strong>Caution:</strong></td>
<td></td>
</tr>
<tr>
<td>If you do not add a file extension to a file name, you may be unable to</td>
<td></td>
</tr>
<tr>
<td>open the document.</td>
<td></td>
</tr>
<tr>
<td>• Send the publication as a shortcut or a copy.</td>
<td></td>
</tr>
<tr>
<td>If you send a publication to a recipient's BI Inbox shortcut, choose a</td>
<td></td>
</tr>
<tr>
<td>folder that is accessible to all recipients. To send a publication</td>
<td></td>
</tr>
<tr>
<td>shortcut to a BI Inbox, select both <strong>BI Inbox</strong> and <strong>Default Enterprise</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Location</strong> as the destination.</td>
<td></td>
</tr>
<tr>
<td>• Merge all exported PDF documents (Crystal reports only)</td>
<td></td>
</tr>
<tr>
<td>• Package the publication as a compressed (.zip) file</td>
<td></td>
</tr>
</tbody>
</table>
### Table 10-4: Email destination

<table>
<thead>
<tr>
<th>Description</th>
<th>Instance is saved to</th>
</tr>
</thead>
</table>
|             | • Output File Repository Server  
|             | • Specified email recipients |

Before you can schedule or send a report instance to this destination, you must enable and configure the email (SMTP) destination on the Adaptive Job Server.
### Description

**Note:**
Before you select this destination, confirm that your email settings are configured properly on the Adaptive Job Server.

The publication is sent to recipients in an email. You can perform the following actions:

- Use the default settings for the destination
- Deliver objects to individual users
- (Required) Enter your email address in the **From** box. If you do not enter your email address, BI platform uses the email address associated with the publisher's account. If the publisher's account has no email address, BI platform uses the email address for the Adaptive Job Server.

**Caution:**
If there is no email address in the **From** box, the publisher's account, or the Adaptive Job Server, the publication will fail.

- Enter recipient email addresses or add the Email Address placeholder to the **To** box
- Enter recipient email addresses or add the Email Address placeholder to the **Cc** box
- Enter recipient email addresses or add the Email Address placeholder to the **Bcc** box
- Enter a subject or add placeholders to the **Subject** box
- Enter information to deliver with the publication or add placeholders and embed a dynamic content document in the body of the email in the **Message** box
- Attach source document instances to an email
- Accept the default file name, enter a file name, or add placeholders. If you select **Use Specific Name**, enter a file extension or add the File Extension placeholder to the box.
- Automatically add the extension to file name

**Caution:**
If you do not add a file extension to a file name, you may be unable to open the docu-
**Table 10-5: FTP Server destination**

<table>
<thead>
<tr>
<th>Description</th>
<th>Instance is saved to</th>
</tr>
</thead>
<tbody>
<tr>
<td>The publica</td>
<td></td>
</tr>
<tr>
<td>tion is sent to an FTP server. You must enter the FTP server location in the Host box. (If you do not, BI platform uses the FTP server configured for the Adaptive Job Server.) You can perform the following actions:</td>
<td></td>
</tr>
<tr>
<td>- Use the default settings for the destination</td>
<td></td>
</tr>
<tr>
<td>- Type the port number, user name and password, and account</td>
<td></td>
</tr>
<tr>
<td>- Type a directory name</td>
<td></td>
</tr>
<tr>
<td>- Accept the default file name, enter a file name, or add placeholders. If you select <strong>Use Specific Name</strong>, type a file extension or add the <strong>File Extension</strong> placeholder to the box.</td>
<td></td>
</tr>
<tr>
<td>- Automatically add the extension to file name</td>
<td></td>
</tr>
<tr>
<td><strong>Caution:</strong></td>
<td></td>
</tr>
<tr>
<td>If you do not add a file extension to a file name, you may be unable to open the document.</td>
<td></td>
</tr>
<tr>
<td>- Merge all exported PDF documents (Crystal reports only)</td>
<td></td>
</tr>
<tr>
<td>- Package the publication as a compressed (.zip) file</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Output File Repository Server</td>
</tr>
<tr>
<td></td>
<td>• Selected FTP server</td>
</tr>
</tbody>
</table>
Table 10-6: File System destination

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The publication is sent to a directory on a file system. You must enter the directory for the publication. You can perform the following actions:</td>
</tr>
<tr>
<td>- Use the default settings for the destination</td>
</tr>
<tr>
<td>- Type a user name and password to access the file location</td>
</tr>
<tr>
<td>- Deliver objects to individual users</td>
</tr>
<tr>
<td>- Accept the default file name, enter a file name, or add placeholders. If you select <strong>Use Specific Name</strong>, type a file extension or add the <strong>File Extension</strong> placeholder to the box.</td>
</tr>
<tr>
<td>- Automatically add the extension to file name</td>
</tr>
</tbody>
</table>

**Caution:**
If you do not add a file extension to a file name, you may be unable to open the document.

- Merge all exported PDF documents (Crystal reports only)
- Package the publication as a compressed (.zip) file

<table>
<thead>
<tr>
<th>Instance is saved to</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Output File Repository Server</td>
</tr>
<tr>
<td>- Selected file location</td>
</tr>
</tbody>
</table>

Table 10-7: SAP StreamWork destination

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The publication is sent for collaboration with other users.</td>
</tr>
</tbody>
</table>

**Note:**
This destination is available if SAP StreamWork is configured and enabled in BI platform.

<table>
<thead>
<tr>
<th>Instance is saved to</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP StreamWork</td>
</tr>
</tbody>
</table>

The **Deliver objects to each user** check box is selected by default for all destinations. However, in some cases, you may not want to deliver objects to each user. For example, three recipients have identical personalization values so they receive the same data in publication instances. If you clear the **Deliver objects to each user** check box, one publication instance is generated and delivered to all
three recipients. If you select the Deliver objects to each user check box, the same publication instance is delivered three times (once for each recipient).

If you are sending the publication to the FTP Server or File System destination and some recipients share identical personalization values, you can clear the Deliver objects to each user check box to decrease overall processing time. When you clear Deliver objects to each user, placeholders used when configuring destinations will contain the publisher’s (not the recipient's) information.

### 10.3.5 Personalized placeholders for email fields

For each filter used in a report during personalization, the following placeholders appear in the Add placeholder list:

* `%Field - Query 1-VALUE%`  
  At run-time, the placeholder is replaced by the personalized value used to filter the report. This placeholder is unique for each recipient.

* `%Field - Query 1-NAME%`  
  At run-time, the placeholder is replaced by the name of the field. This placeholder is the same for all recipients.

Before you can use personalized placeholders in the Subject box and the Message box when emailing a publication, all source documents for the publication must be personalized on the same field.

If a publication contains several source documents, the Add placeholder list for the Subject and Message boxes displays personalization parameters only when all source documents are filtered on the same field(s).

### 10.3.6 Formats

A format defines the file type for a document in a publication.

You can publish a single document in multiple formats; each format you choose will result in an instance of the document. Each instance can be delivered to multiple destinations. For publications with multiple documents, you can specify a different format for each document. For publications that contain Web Intelligence documents, you can publish a whole document or a report tab in a document to multiple formats.

The formats you choose for a document apply to all recipients of the publication. For example, you cannot publish a document as a Microsoft Excel file for one recipient and a PDF file for another recipient. If you want recipients to receive instances in both formats, each recipient must receive an Excel file and a PDF file.
Related Topics

- To specify publication formats for a Crystal report

  You can select and configure more than one publication format for a Crystal report.

- To specify publication formats for a Web Intelligence document

10.3.6.1 Publication format options

<table>
<thead>
<tr>
<th>Document type</th>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
</table>
| All document types  | mHTML  | This option publishes a document in mHTML format. You can embed the document’s content as mHTML in an email.  
  • For Crystal reports, you can embed the content of one report in an email.  
  • For Web Intelligence documents, you can embed the content of one report tab in an email.  
Documents are output in the order that source documents are listed in the "New Publication" dialog box. For example, documents at the top of the dialog box appear at the top of the email. |
|                     | PDF    | This option publishes a document as a static PDF file.  
When this option is used with PDF merging, documents are output in the order that source documents are listed in the "New Publication" dialog box. For example, documents at the top of the dialog box appear at the top of the merged PDF file. |
|                     |        | This option publishes a document as a Microsoft Excel (.xls) file and preserves as much of the original formatting as possible.  

<table>
<thead>
<tr>
<th>Document type</th>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crystal reports</td>
<td>Microsoft Excel (97-2003)</td>
<td>These options publish a Crystal report as an Excel (.xls) file that contains only data.</td>
</tr>
<tr>
<td></td>
<td>(Data Only)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Microsoft Excel Workbook</td>
<td>This option publishes a Crystal report in XML (.xml) format.</td>
</tr>
<tr>
<td></td>
<td>Data-only</td>
<td></td>
</tr>
<tr>
<td></td>
<td>XML</td>
<td>This option publishes a Crystal report in XML (.xml) format.</td>
</tr>
<tr>
<td></td>
<td>Crystal Reports</td>
<td>This option publishes a Crystal report in its original (.rpt) format.</td>
</tr>
<tr>
<td></td>
<td>Crystal Reports (RPTR)</td>
<td>This option publishes a Crystal report in read-only (.rptr) format.</td>
</tr>
<tr>
<td></td>
<td>Microsoft Word (97-2003)</td>
<td>This option publishes a Crystal report as a Microsoft Word (.doc) file and preserves the original formatting of the Crystal report.</td>
</tr>
<tr>
<td></td>
<td>(Editable (RTF)</td>
<td>Use this option when you expect recipients to view a publication without making changes to it.</td>
</tr>
<tr>
<td></td>
<td>Rich Text Format (RTF)</td>
<td>This option publishes a Crystal report in Rich Text Format (.rtf).</td>
</tr>
<tr>
<td></td>
<td>Plain Text</td>
<td>This option publishes a Crystal report in plain text (.txt) format.</td>
</tr>
<tr>
<td></td>
<td>Paginated Text</td>
<td>This option publishes a Crystal report in plain text (.txt) format and paginates the content of the publication.</td>
</tr>
<tr>
<td></td>
<td>Tab Separated Text (TTX)</td>
<td>This option publishes a Crystal report in plain text (.txt) format and separates the content in columns with tabs.</td>
</tr>
</tbody>
</table>
### Document type | Format | Description
--- | --- | ---
| | Separated Values (CSV) | This option publishes a Crystal report as a character-separated values (`.csv`) file.
| Web Intelligence documents | Web Intelligence | This option publishes a Web Intelligence document in its original (`.wid`) format.

### 10.3.7 Personalization

Personalization is the process of filtering data in source documents so that only relevant data appears to publication recipients.

Personalization alters the view of data but does not change or secure the data being queried from the data source.

The following diagram illustrates how personalization works. For example, an unpersonalized report contains data types 1, 2, and 3. When personalization is applied to the report, users receive only data that is relevant to them. User 2 receives only data type 2, User 1 receives only data type 1, and User 3 receives only data type 3.

To personalize source documents:
- For Enterprise recipients, you must apply a profile when you design a publication. Before you can use profiles to personalize data for Enterprise recipients, the profiles must be configured in BI platform. If you need profiles added to BI platform, contact your system administrator.
• For dynamic recipients, you can map a data field or column in the source document to data in the dynamic recipient source. For example, you can map a Customer ID field in a source document to the Recipient ID field in the dynamic recipient source.

**Note:**
To view a list of recipients who will receive unpersonalized publication instances after personalization, select Additional Options > Advanced in the "New Publication" dialog box, and select the Display users who have no personalization applied check box.

**Related Topics**
• To personalize a Crystal report using parameter values
• To personalize a Crystal report by filtering fields
  When you use filters, a ViewTime selection formula is added to a report to filter data. The formula is applied when the publication runs; it is not saved in the report.
• To personalize a Web Intelligence document using a global profile target
  You can personalize a Web Intelligence document for Enterprise recipients by filtering a global profile target. If the profile is not configured in BI platform, personalization will fail.
• To personalize a Web Intelligence document by filtering fields

### 10.3.8 Publication extensions

A publication extension is a library of code that applies business logic to publications.

Use a publication extension when you need automated customization of publications after processing or delivery. You can use publication extensions to perform the following tasks after processing:

• Merge documents of the same type (for example, merge multiple Excel spreadsheets into a single Excel workbook)
• Add password protection to or encrypt a document
• Convert a document to a different format
• Create custom log files for a publication job

You specify publication extensions in the Central Management Console (CMC).

**Note:**
You cannot use publication extensions if you are designing a publication in BI launch pad.

For more information about publication extensions, see the *SAP BusinessObjects Business Intelligence Platform Java SDK Developer Guide*.

**Related Topics**
• To select publication extensions
10.3.9 Subscriptions

A subscription enables users who are not publication recipients to view the latest instance.

Enterprise recipients can unsubscribe from a publication at any time. Dynamic recipients can neither subscribe to or unsubscribe from a publication.

Users with the appropriate access rights can subscribe and unsubscribe other users. To subscribe to or unsubscribe from a publication, you need a BI platform account and the following rights:

- Access to BI launch pad or the Central Management Console (CMC)
- View rights to see the publication
- Subscriber rights for the user account (Enterprise recipients)

Related Topics

- To subscribe to or unsubscribe from a publication

Enterprise recipients can subscribe to or unsubscribe from a publication.

10.3.10 PDF-file merging for Crystal reports

You can merge PDF instances of Crystal reports and static PDF documents into a single PDF file and then perform the following tasks on the merged PDF file:

- Add and format a table of contents
- Insert running page numbers
- Add user and owner passwords to view and edit the PDF file
- Set restrictions on what recipients can do with the PDF file

All static PDF source documents are included in the merged PDF file. Static source documents that are not PDF files are excluded.

10.4 Access rights required for publishing
<table>
<thead>
<tr>
<th>Role</th>
<th>Task</th>
<th>Rights required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document designer</td>
<td>Create a document on which a publication is based</td>
<td>None</td>
</tr>
<tr>
<td>Document designer</td>
<td>Add a document to BI platform</td>
<td>• View rights and Add rights on the folder or category to which the document will be added</td>
</tr>
<tr>
<td>Document designer</td>
<td>Create a document to be used as a dynamic recipient source</td>
<td>• View rights and Add rights on the folder or category to which the document will be added</td>
</tr>
<tr>
<td>Publisher</td>
<td>Create a publication</td>
<td>• Add rights on the folder where the publication is saved</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View rights on the users and the groups intended as recipients</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View rights on the profile that is used for personalization</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View rights on documents on the publication</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Schedule rights on documents on the publication</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Schedule rights on Enterprise recipients</td>
</tr>
<tr>
<td>Role</td>
<td>Task</td>
<td>Rights required</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Publisher</td>
<td>Schedule a publication</td>
<td><strong>Note:</strong> Only the publisher should have Schedule a publication rights.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View rights, Schedule rights, Add rights, and Modify Security rights on the publication</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Delete Instance rights on the publication</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View rights on the users and the groups intended as recipients</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View rights on the profile that is used for personalization</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View rights and Schedule rights on documents on the publication</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View rights and Refresh rights on the dynamic recipient source</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View rights and Refresh rights on the document for which a delivery rule is set</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Data Access rights on universes used by publication objects</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Data Access rights on universe connections used</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• When scheduling to a BI Inbox, Add rights and View rights on each recipient's BI Inbox</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• On the folder containing the publication, Modify the rights users have to objects rights</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Subscribe rights on recipients</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• When a publisher wants to print publication instances, Print rights on Crystal report source documents</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If you selected <strong>One database fetch per recipient</strong>, Schedule on behalf of other users rights on Enterprise recipients</td>
</tr>
</tbody>
</table>

*Note:*
Only the publisher should have Schedule a publication rights.

- View rights, Schedule rights, Add rights, and Modify Security rights on the publication
- Delete Instance rights on the publication
- View rights on the users and the groups intended as recipients
- View rights on the profile that is used for personalization
- View rights and Schedule rights on documents on the publication
- View rights and Refresh rights on the dynamic recipient source
- View rights and Refresh rights on the document for which a delivery rule is set
- Data Access rights on universes used by publication objects
- Data Access rights on universe connections used
- When scheduling to a BI Inbox, Add rights and View rights on each recipient's BI Inbox
- On the folder containing the publication, Modify the rights users have to objects rights
- Subscribe rights on recipients
- When a publisher wants to print publication instances, Print rights on Crystal report source documents
- If you selected **One database fetch per recipient**, Schedule on behalf of other users rights on Enterprise recipients
<table>
<thead>
<tr>
<th>Role</th>
<th>Task</th>
<th>Rights required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publisher</td>
<td>Retry a failed publication instance</td>
<td>• Edit rights on the publication instance</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View rights, Subscribe rights, Add rights, and Modify Security rights on the publication</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Delete Instance rights on the publication</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View rights on the users and groups intended as recipients</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View rights on the profile used for personalization</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View rights and Schedule rights on documents in the publication</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View rights and Refresh rights on the dynamic recipient source</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View rights and Refresh rights on the document for which a delivery rule is set</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Data Access rights on universes used by publication objects</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Data Access rights on universe connections used</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• When scheduling to a BI Inbox, Add rights and View rights on each recipient's BI Inbox</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• On the folder containing the publication, Modify the rights users have to objects rights</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Subscribe rights on recipients</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• When a publisher wants to print publication instances, Print rights on Crystal report source documents</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If you selected <strong>One database fetch per recipient</strong>, Schedule on behalf of other users rights on Enterprise recipients</td>
</tr>
<tr>
<td>Role</td>
<td>Task</td>
<td>Rights required</td>
</tr>
<tr>
<td>------------</td>
<td>-------------------------------------------</td>
<td>----------------------------------------------------------</td>
</tr>
<tr>
<td>Publisher</td>
<td>Redistribute a publication instance</td>
<td>• View rights, Schedule rights, Add rights, and Modify Security rights on the publication</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Add rights and View rights on each recipient BI Inbox</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View Instance rights and Edit rights on the publication instance</td>
</tr>
<tr>
<td>Recipient</td>
<td>View a publication</td>
<td>• View rights on the publication</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View Instance rights on the publication</td>
</tr>
<tr>
<td></td>
<td></td>
<td>These rights enable you to see a publication object in BI platform. You do not need these rights to see content sent to a BI Inbox.</td>
</tr>
<tr>
<td>Recipient</td>
<td>Subscribe to or unsubscribe from a publication</td>
<td>• View rights on the publication</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Subscribe rights on Enterprise recipients</td>
</tr>
</tbody>
</table>

**10.4.1 Publishers and recipients: Who has rights to view what?**

A publisher (the person who owns and schedules a publication) can view all publication instances for all recipients. Recipients can view only their own personalized publication instances.

These viewing rights ensure maximum security for publication data because only the publisher has rights to schedule publications and to view all publication instances.

**Tip:**
If you are a publisher and want to add yourself to a publication as a recipient, create two user accounts for yourself: a Publisher account and a Recipient account. The Publisher account grants you access rights to design and to schedule publications, and the Recipient account grants you the access rights of a typical recipient.
11.1 Designing publications

To design a new publication, use the publishing feature in BI platform.

You can access publishing in the Central Management Console (CMC) or in BI launch pad, depending on your access rights and on your access to BI platform web-based applications.

At any point during publication design, you can save changes made to a publication, close it, reopen it, and make further changes.

11.1.1 Designing publications for Live Office

When you design publications for use with SAP BusinessObjects Live Office, consider the following information:

- Dynamic content documents can consist only of Crystal reports or Web Intelligence documents in the original format.
- Dynamic recipients are not supported.
- The only destination option available is Default Enterprise Location.
- If recipients receive multiple publication instances after personalization, they can view only the first publication instance in the Live Office Client. Recipients who inherit multiple profile values from group membership may receive multiple instances. To avoid sending multiple instances, assign only necessary profile values to recipients.

Related Topics

- Personalization
Personalization is the process of filtering data in source documents so that only relevant data appears to publication recipients.

### 11.1.2 Designing publications for SAP recipients

A publication intended for SAP recipients works the same way as a publication intended for Enterprise or dynamic recipients.

However, SAP recipients have the following differences in a publishing workflow:

- You do not use personalization to design source documents for SAP recipients. Each SAP recipient has a profile value mapped to a user account outside of BI platform, and the profile value serves as built-in personalization. You do not need to create profiles and profile values for SAP recipients in BI platform or to map profiles to source document fields.

- The only report bursting method that works for a publication intended for SAP recipients is **One database fetch per recipient**. It maximizes security and individually processes the database logon credentials of each publication recipient.

For information about single sign-on configuration and authentication, see the *SAP BusinessObjects Business Intelligence Platform Administrator Guide*.

### 11.1.3 To create a new publication in the CMC

1. Under **Folders** in the CMC, click the group tree, and locate the folder where you want to create a publication.
2. Right-click the folder and select **New > Publication**.
   The "New Publication" dialog box appears, with general property options displayed.
3. (Required) In the **Title** box, type the title of the publication.
4. (Optional) In the **Description** box, type a description of the publication.
5. (Optional) In the **Keywords** box, type keywords that are associated with the publication's content.
6. Click **Source Documents** in the navigation list, and then click the **Add** button.
7. In the "Select Source Documents" dialog box, select one or more source documents to add to the publication, and click **OK**.
   The **Refresh At Runtime** check box is selected by default for each source document. It refreshes the document against its data source when the publication runs.
8. If you do not want to refresh a source document when the publication runs, clear the **Refresh At Runtime** check box for the document.
9. Click **Save & Close**.
11.1.4 To create a new publication in BI launch pad

1. On the Documents tab, expand the Folders drawer, and locate the folder where you want to create a publication.
2. Right-click the folder and select New > Publication. The "New Publication" dialog box appears, with general property options displayed.
3. (Required) In the Title box, type the title of the publication.
4. (Optional) In the Description box, type a description of the publication.
5. (Optional) In the Keywords box, type keywords that are associated with the publication's content.
6. Click Source Documents in the navigation list, and click the Add button.
7. In the "Select Source Documents" dialog box, select one or more source documents to add to the publication, and click OK. The Refresh At Runtime check box is selected by default for each source document. It refreshes the document against its data source when the publication runs.
8. If you do not want to refresh source documents at runtime, clear the Refresh At Runtime check box.
9. Click Save & Close.

You must specify other information required for the publication—recipients, delivery formats and destinations, and how documents are personalized.

11.1.5 To open a publication

1. Locate the publication:
   • In BI launch pad, on the Documents tab, expand the Folders drawer.
   • In the Central Management Console (CMC), go to the Folders management area.
2. Right-click the publication and select View. The publication opens in a new window.

11.1.6 To define general properties for a publication

1. Right-click the publication for which you want to enter general properties and select Properties. The "Properties" dialog box appears, displaying the publication's general properties and title.
2. (Optional) In the Description box, type a description of the publication.
3. (Optional) In the Keywords box, type keywords that are associated with the publication's content.
4. Click Save & Close.

11.1.7 To select source documents

When choosing which source documents to include in a publication, the dynamic content document type determines which options are available.

**Tip:**
When sending source documents as an attachment or a merged PDF file, you can set the order in which documents appear. In the "New Publication" dialog box, in the Source Documents area, select a document in the Selected list, and click Move Up or Move Down to move the document to a different place in the order.

1. Right-click a publication and select Schedule.
   The "Properties" dialog box appears, displaying the publication's general properties and title.
2. In the "New Publication" dialog box, click Source Documents.
3. Click Add.
   The "Select Source Documents" dialog box appears.
4. Locate and select dynamic content documents of the same document type to include in the publication, and click OK.
   **Tip:**
   Press CTRL + click or SHIFT + click to select multiple source documents, or double-click a source document to select it.

   The source documents you selected appear in the Selected list in the "New Publication" dialog box. The check box in the Refresh At Runtime column is selected by default for the source document. When this check box is selected, the document is refreshed against its data source when the publication runs.
5. If you do not want to refresh a source document against its data source when the publication runs, clear the check box for that document in the Refresh At Runtime column.
   **Tip:**
   To improve system performance, clear the check box in the Refresh At Runtime column for each document you do not need to refresh.
6. Click Save & Close.

11.1.8 To select Enterprise recipients
1. Right-click a publication and select **Schedule**.
   The "Schedule" dialog box appears.
2. Click **Destinations** in the navigation list, and click **Enterprise Recipients**.
3. Choose recipients for the publication:
   a. Under **Available**, click **User List** to display a list of all users in the BI platform or **Group List** to display a list of all user groups in the BI platform.
   b. Select users or user groups, and move the users or groups to the **Selected** list.

**Tip:**
Type a recipient's user name, full name, or email address in the **Find title** box to quickly locate the user in the **Available Recipients** list.

**Tip:**
- Press **Shift + click** or **Ctrl + click** to select multiple users or groups.
- To exclude recipients, select a user or user group in the **Selected** list, and move the user or group to the **Excluded** list.
4. Click **OK**.

### 11.1.9 To select dynamic recipients

Dynamic recipients are recipients who are not BI platform users.

Before you can specify dynamic recipients, you must have a dynamic recipient source designed and ready for use.

The dynamic recipient source contains recipient data; it can be a Crystal report, a Web Intelligence document, or a custom-coded data provider. For information about creating a custom-coded dynamic recipient source, see the *SAP BusinessObjects Business Intelligence Platform Java SDK Developer Guide*.

**Note:**
Dynamic recipient data comes from the query and may not match data that appears when you view a document. Depending on how a query is built, dynamic recipient sources created in the Web Intelligence component may contain values that do not correspond to data in the publication's source documents. For example, a filter in a report may exclude relevant values, or duplicate records may appear because a query was set to retrieve duplicate rows. Review the full list of dynamic recipients during the publication design process.

**Tip:**
To more efficiently process publications, use the **Recipient Identifier** list to sort recipient data by the recipient ID.

1. Double-click a publication to open it.
   The "Properties" dialog box appears.
2. Click Dynamic Recipients in the navigation list.

**Note:**
Crystal report dynamic recipient sources cannot be in .rptr format.

3. Under Choose the source for the dynamic recipients, select either Web Intelligence Report Dynamic Recipient Provider or Crystal Reports Dynamic Recipient Provider.

4. Locate and select the object to use as a dynamic recipient source, and click OK.

5. If you chose a Web Intelligence document as a dynamic recipient source, in the Select the datasource name for the document list, select a query that appears in the document.

6. In the Recipient Identifier (required) list, select a field that contains the recipient identity values.

7. (Optional) In the Full Name list, select a field that contains the full names of recipients.

8. If you intend to deliver the publication to email addresses, in the Email list, select a field that contains the recipient email addresses.

9. Decide which recipients in the dynamic recipient source to distribute the publication to:
   • To send the publication to all dynamic recipients, select the Use entire list check box.
   • To send the publication to particular dynamic recipients, clear the Use entire list check box, and then, under Available, select the check box for a recipient, and move the recipient to the Selected list.

**Tip:**
Type a recipient's user name, full name, or email address in the Find title box to quickly locate the user in the Available Recipients list.

**Tip:**
To exclude a recipient, select the check box for the recipient, and move the recipient to the Excluded list.

10. Click OK.

After specifying dynamic recipients for the publication, you can personalize the publication for dynamic recipients. To do this, map a field in the source document to a column in the dynamic recipient source.

### 11.1.10 To select a destination for a publication

Dynamic recipients do not have a BI account and cannot access the publication instance.

Enterprise recipients must have "View" rights on a publication to view publication instances.

1. Double-click a publication to open it.
   The "Properties" dialog box appears.

2. Click Destinations.

3. (Optional) To avoid storing publication instances on your system, clear the Default Enterprise Location check box under Select Destinations.

4. Set a low instance limit on the publication object.
   For instructions, see the SAP BusinessObjects Business Intelligence Platform User Guide.
5. **Under Select Destinations**, select the check box beside each destination that you want to send the publication to.
   
   If you want to create a shortcut to the publication, select both **BI Inbox** and **Default Enterprise Location** as destinations.
   
   If the publication will be sent to email recipients and you want to embed a link to the Enterprise location in the email body, select both **Email** and **Default Enterprise Location** as destinations.
   
   The destination you chose appears in the **Show options for selected destinations** list. If you selected multiple destinations, options appear for the last check box you selected.

6. If necessary, select a destination to configure in the **Show options for selected destinations** list. Options for the destination appear.

7. (Optional) To choose a name for the publication, select **Use Specific Name**, and type a name or select a placeholder in the **Add placeholder** list.

   If you do not choose a name, a system-generated name is assigned to a publication.
   
   When the publication runs, a value will be inserted in each placeholder.

8. (Optional) If you selected **Use Specific Name** and the publication contains multiple documents to which you want to assign individual names, select the **Specific Name per Document** check box, and type a name or select a placeholder in the **Add placeholder** list for each document.

   If you do not choose a name, the same system-generated name is assigned to each document.

9. **(Email only)** To embed a link to the Enterprise location in the email body, position the cursor in the **Message** box, and select **Viewer** in the **Add placeholder** list under the box.

   The placeholder `%SI_VIEWER_URL%` is inserted in the email body. It will be replaced by a link when the publication runs.

   **Tip:**
   
   If you are unable to embed a link, confirm that you selected both **Email** and **Default Enterprise Location** as the destination.

10. **(BI Inbox only)** Under **Send As**, click **Shortcut** to create a shortcut to the publication or **Copy** to create a copy of the publication.

    **Tip:**
    
    If you are unable to create a shortcut, confirm that you selected both **BI Inbox** and **Default Enterprise Location** as the destination.

11. If you selected multiple destinations, repeat steps 5 to 10 for each destination to select and configure the destination.

12. Click **OK**.

### 11.10.1 Destinations
Table 11-1: Default Enterprise Location destination

<table>
<thead>
<tr>
<th>Description</th>
<th>Instance is saved to</th>
</tr>
</thead>
<tbody>
<tr>
<td>The publication is accessible from the folder it was created in. You can perform the following actions:</td>
<td>Output File Repository Server</td>
</tr>
<tr>
<td>• Merge all exported PDF documents (Crystal reports only)</td>
<td>Historical instances are saved to the default Enterprise server but not to any other destination.</td>
</tr>
<tr>
<td>• Package the publication as a compressed (*.zip) file</td>
<td></td>
</tr>
<tr>
<td>If you send a publication to this location, choose a folder that is accessible to all recipients.</td>
<td></td>
</tr>
</tbody>
</table>
### Table 11-2: BI Inbox destination

<table>
<thead>
<tr>
<th>Description</th>
<th>Instance is saved to</th>
</tr>
</thead>
<tbody>
<tr>
<td>The publication is sent to each recipient's BI Inbox. You can perform the following actions:</td>
<td></td>
</tr>
<tr>
<td>• Use the default settings for the destination</td>
<td>• Output File Repository Server</td>
</tr>
<tr>
<td>• Deliver objects to individual users</td>
<td>• Specified BI Inboxes</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td></td>
</tr>
<tr>
<td>To quickly locate a user, you can search for a recipient's user name, full name, or email</td>
<td></td>
</tr>
<tr>
<td>address in the <strong>Find title</strong> box.</td>
<td></td>
</tr>
<tr>
<td>• Use the default file name, enter a file name, or add placeholders. If you select <strong>Use Specific Name</strong>, type a file extension or add the <strong>File Extension</strong> placeholder to the box.</td>
<td></td>
</tr>
<tr>
<td>• Automatically add the extension to file name</td>
<td></td>
</tr>
<tr>
<td><strong>Caution:</strong></td>
<td></td>
</tr>
<tr>
<td>If you do not add a file extension to a file name, you may be unable to open the document.</td>
<td></td>
</tr>
<tr>
<td>• Send the publication as a shortcut or a copy.</td>
<td></td>
</tr>
<tr>
<td>If you send a publication to a recipient's BI Inbox shortcut, choose a folder that is accessible to all recipients. To send a publication shortcut to a BI Inbox, select both <strong>BI Inbox</strong> and <strong>Default Enterprise Location</strong> as the destination.</td>
<td></td>
</tr>
<tr>
<td>• Merge all exported PDF documents (Crystal reports only)</td>
<td></td>
</tr>
<tr>
<td>• Package the publication as a compressed (.zip) file</td>
<td></td>
</tr>
</tbody>
</table>
### Table 11-3: Email destination

<table>
<thead>
<tr>
<th>Description</th>
<th>Instance is saved to</th>
</tr>
</thead>
</table>
|             | • Output File Repository Server  
|             | • Specified email recipients  

Before you can schedule or send a report instance to this destination, you must enable and configure the email (SMTP) destination on the Adaptive Job Server.
Note:
Before you select this destination, confirm that your email settings are configured properly on the Adaptive Job Server.

The publication is sent to recipients in an email. You can perform the following actions:
• Use the default settings for the destination
• Deliver objects to individual users
• (Required) Enter your email address in the From box. If you do not enter your email address, BI platform uses the email address associated with the publisher's account. If the publisher's account has no email address, BI platform uses the email address for the Adaptive Job Server.

Caution:
If there is no email address in the From box, the publisher's account, or the Adaptive Job Server, the publication will fail.

• Enter recipient email addresses or add the Email Address placeholder to the To box
• Enter recipient email addresses or add the Email Address placeholder to the Cc box
• Enter recipient email addresses or add the Email Address placeholder to the Bcc box
• Enter a subject or add placeholders to the Subject box
• Enter information to deliver with the publication or add placeholders and embed a dynamic content document in the body of the email in the Message box
• Attach source document instances to an email
• Accept the default file name, enter a file name, or add placeholders. If you select Use Specific Name, enter a file extension or add the File Extension placeholder to the box.
• Automatically add the extension to file name

Caution:
If you do not add a file extension to a file name, you may be unable to open the docu-
### Table 11-4: FTP Server destination

<table>
<thead>
<tr>
<th>Description</th>
<th>Instance is saved to</th>
</tr>
</thead>
<tbody>
<tr>
<td>The publication is sent to an FTP server. You must enter the FTP server location in the <strong>Host</strong> box. (If you do not, BI platform uses the FTP server configured for the Adaptive Job Server.) You can perform the following actions:</td>
<td></td>
</tr>
<tr>
<td>• Use the default settings for the destination</td>
<td></td>
</tr>
<tr>
<td>• Type the port number, user name and password, and account</td>
<td>Output File Repository Server</td>
</tr>
<tr>
<td>• Type a directory name</td>
<td>Selected FTP server</td>
</tr>
<tr>
<td>• Accept the default file name, enter a file name, or add placeholders. If you select <strong>Use Specific Name</strong>, type a file extension or add the <strong>File Extension</strong> placeholder to the box.</td>
<td></td>
</tr>
<tr>
<td>• Automatically add the extension to file name</td>
<td></td>
</tr>
<tr>
<td><strong>Caution:</strong> If you do not add a file extension to a file name, you may be unable to open the document.</td>
<td></td>
</tr>
<tr>
<td>• Merge all exported PDF documents (Crystal reports only)</td>
<td></td>
</tr>
<tr>
<td>• Package the publication as a compressed (<strong>.zip</strong>) file</td>
<td></td>
</tr>
</tbody>
</table>

- Merge all exported PDF documents (Crystal reports only)
- Package the publication as a compressed (**.zip**) file

- Output File Repository Server
- Selected FTP server
Table 11-5: File System destination

<table>
<thead>
<tr>
<th>Description</th>
<th>Instance is saved to</th>
</tr>
</thead>
<tbody>
<tr>
<td>The publication is sent to a directory on a file system. You must enter the directory for the publication. You can perform the following actions:</td>
<td>• Output File Repository Server</td>
</tr>
<tr>
<td>• Use the default settings for the destination</td>
<td>• Selected file location</td>
</tr>
<tr>
<td>• Type a user name and password to access the file location</td>
<td></td>
</tr>
<tr>
<td>• Deliver objects to individual users</td>
<td></td>
</tr>
<tr>
<td>• Accept the default file name, enter a file name, or add placeholders. If you select <strong>Use Specific Name</strong>, type a file extension or add the <strong>File Extension</strong> placeholder to the box.</td>
<td></td>
</tr>
<tr>
<td>• Automatically add the extension to file name</td>
<td></td>
</tr>
<tr>
<td><strong>Caution:</strong> If you do not add a file extension to a file name, you may be unable to open the document.</td>
<td></td>
</tr>
<tr>
<td>• Merge all exported PDF documents (Crystal reports only)</td>
<td></td>
</tr>
<tr>
<td>• Package the publication as a compressed (.zip) file</td>
<td></td>
</tr>
</tbody>
</table>

Table 11-6: SAP StreamWork destination

<table>
<thead>
<tr>
<th>Description</th>
<th>Instance is saved to</th>
</tr>
</thead>
<tbody>
<tr>
<td>The publication is sent for collaboration with other users.</td>
<td>SAP StreamWork</td>
</tr>
<tr>
<td><strong>Note:</strong> This destination is available if SAP StreamWork is configured and enabled in BI platform.</td>
<td></td>
</tr>
</tbody>
</table>

The **Deliver objects to each user** check box is selected by default for all destinations. However, in some cases, you may not want to deliver objects to each user. For example, three recipients have identical personalization values so they receive the same data in publication instances. If you clear the **Deliver objects to each user** check box, one publication instance is generated and delivered to all
three recipients. If you select the **Deliver objects to each user** check box, the same publication instance is delivered three times (once for each recipient).

If you are sending the publication to the **FTP Server** or **File System** destination and some recipients share identical personalization values, you can clear the **Deliver objects to each user** check box to decrease overall processing time. When you clear **Deliver objects to each user**, placeholders used when configuring destinations will contain the publisher's (not the recipient's) information.

### 11.1.11 To select a recurrence pattern

The recurrence pattern determines how often a publication runs.

1. Right-click a publication and select **Schedule**.
2. In the "Schedule" dialog box, click **Recurrence**.
3. In the **Run object** list, select a recurrence pattern.
4. 
5. 
6. Click **Schedule**.
   
   The publication runs at the scheduled times.

### 11.11.1 Recurrence patterns

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Now</strong></td>
<td>Runs the object one time, starting immediately</td>
</tr>
<tr>
<td><strong>Once</strong></td>
<td>Runs the object once, at the specified start time. If you schedule an object with events, the object will run once, if the event is triggered between the start and end times. Select when to start and to stop running the object in the <strong>Start Date/Time</strong> and <strong>End Date/Time</strong> lists, and enter the date of the start and the stop times.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Hourly</strong></td>
<td>Creates an instance every hour, at the specified time. The first instance will be created at the specified start time, and instances will be created hourly at that time, until the object stops running at the specified end time. Select the frequency at which to run the object in the Hour(N) and Minute(X) lists, select when to start and to stop running the object in the Start Date/Time and End Date/Time lists, and enter the date of the start and the stop times.</td>
</tr>
<tr>
<td><strong>Daily</strong></td>
<td>Runs the object once daily, at the specified start time. The first instance will be created at the specified start time, and instances will be created daily at that time, until the object stops running at the specified end time. Enter the interval at which to run the object in the Days(N) box, select when to start and to stop running the object in the Start Date/Time and End Date/Time lists, and enter the date of the start and the stop times.</td>
</tr>
<tr>
<td><strong>Weekly</strong></td>
<td>Runs the object each week on the selected days, at the specified start time. The first instance will be created at the specified start time, and instances will be created each week on those days at that time, until the object stops running at the specified end time. Select a check box for each day that you want to run the object, select when to start and to stop running the object in the Start Date/Time and End Date/Time lists, and enter the date of the start and the stop times.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Monthly</strong></td>
<td>Runs the object on the specified date, at the specified start time, and at the specified monthly intervals. The first instance will be created at the specified start time, and instances will be created in monthly intervals at that time, until the object stops running at the specified end time. Select the interval at which to run the object in the Month(N) box, select when to start and to stop running the object in the Start Date/Time and End Date/Time lists, and enter the date of the start and the stop times.</td>
</tr>
<tr>
<td><strong>Nth Day of Month</strong></td>
<td>Creates an instance each month on the specified day, at the specified start time. The first instance will be created at the specified start time, and instances will be created on the specified day of each month at that time, until the object stops running at the specified end time. Enter the time to start and to stop running the object and the day of the month on which to run the object.</td>
</tr>
<tr>
<td><strong>1st Monday of Month</strong></td>
<td>Creates an instance on the first Monday of each month, at the specified start time. Enter the time to start and to stop running the object.</td>
</tr>
<tr>
<td><strong>Last Day of Month</strong></td>
<td>Creates an instance on the last day of each month, at the specified start time. Enter the time to start and to stop running the object.</td>
</tr>
<tr>
<td><strong>X Day of Nth Week of the Month</strong></td>
<td>Creates an instance each month on the specified day and week, at the specified start time. Enter the time to start and to stop running the object, the day of the week, and the week in the month to run the object.</td>
</tr>
</tbody>
</table>
Option | Description
--- | ---
Calendar | Creates an instance on each calendar date you specify, at the specified start time. Enter the time to start and to stop running the object, and select the calendar dates when you want to run the object.

11.1.12 To select personalized placeholders for publication source documents

Before you can use personalized placeholders in publication instance names, you must have used personalization to filter data in source documents.

**Tip:**
You can combine text and placeholders—and use multiple placeholders—in a publication name.

1. Double-click a publication to open it.
   The "Properties" dialog box appears.
2. Click **Destinations** in the navigation list.
3. Under **Show options for selected destinations**, select **Use Specific Name** and choose a placeholder for the publication name from the **Add placeholder** list.
   The placeholders you select appear in the **Specific Name** box for the document title.
4. To add individual documents:
   a. Under **Target Name**, select **Specific Name per Document**.
   b. For each document title, select a placeholder from the **Add placeholder** list.
   The placeholders you select appear in the **Specific Name** box for each document title.
5. Click **OK**.

After personalization is set up for a publication, personalized placeholders appear in the **Add placeholder** list in the "Destinations" dialog box.

11.1.13 To select personalized placeholders for email fields

When scheduling a publication to an email destination, you can use placeholders in the **From**, **To**, **Cc**, **Bcc**, **Subject**, **Message**, and **Use Specific Name** fields.
Tip:
You can combine text and placeholders—and use multiple placeholders—in any email field.

1. Double-click a publication to open it.
   The "Properties" dialog box appears.
2. Click Destinations in the navigation list.
3. In the Destination list, select Email.
4. Set the destination options, including placeholders, as needed.
5. Click OK.

11.1.14 To embed content from a dynamic source document in an email

You can embed content from dynamic content documents in the body of an email.

For Crystal reports, you can embed content from a report. For Web Intelligence documents, you can embed an entire document or a single report tab.

1. Right-click a publication and select Properties.
   The "Properties" dialog box appears.
2. Click Formats in the navigation list.
3. Under Documents, select the dynamic content document that you want to embed in the email.
4. For Crystal reports, under Format Options for Selected Document, select the mHTML check box.
5. For Web Intelligence documents, choose whether to publish the entire document or one report tab in the document:
   a. Under Output Format, select the mHTML check box.
   b. Under Output Format Details, select All reports to publish the entire document or Select one report and choose a report tab in the list.
6. Click Destinations in the navigation list.
7. In the "Destinations" dialog box, under Select Destinations, select the Email check box.
   The email configuration options appear.
8. In the From box, type a name or email address or select Email Address from the Add placeholder list.
   For example, you can type Robert, Publisher, or publisher@sap.com. If you type a name, the name is appended to your email server—for example, Publisher@emailserver.
9. In the Subject box, type a subject or select a placeholder.
   If you personalized the report, personalized placeholders are available in the Add placeholder list.
10. In the Message box, type the message that you want to appear in the body of the mail.
11. To embed dynamic content in the Message box, position the cursor in the Message box where you want to embed content, and select Report HTML Content in the Add placeholder list.
11.1.15 Crystal report design tasks

11.1.15.1 Personalizing Crystal reports with parameter values

You can personalize a Crystal report for recipients based on predefined parameter values for each recipient. Personalization that is based on parameter values may be overridden by other personalization methods.

For example, if a profile is mapped to a parameter and the profile value for an Enterprise recipient conflicts with the parameter value, the profile value will override the parameter value when the publication runs. Similarly, if a personalization value in the dynamic recipient source conflicts with a parameter value for a dynamic recipient, the parameter value will be overridden when the publication runs.

**Note:**
Personalize Crystal reports with local profile targets when possible. Parameter-based personalization requires one database fetch per recipient when the parameter is used in a record selection formula, command, table, or stored procedure, which can increase publication processing time.

11.1.15.2 To personalize a Crystal report using parameter values

- Before you can use profiles to personalize data for Enterprise recipients, the profiles must be configured in the BI platform.
- Before you can perform this task, the Crystal report must contain parameters.
  1. Double-click a publication to open it.
     The "Properties" dialog box appears.
  2. Click **Personalization** in the navigation list.
  3. Review the parameter values under **Parameters** and note any values that need to be changed.
4. To change a default value, click the **Edit Values** button beside the default parameter value, select or type the parameter value, and click **OK**.

5. Perform one of the following actions:
   - To override the default parameter personalization with Enterprise-recipient profile values, in the **Enterprise Recipient Mapping** column, select a profile in the list.
     
     **Note:**
     If this profile is not configured in the BI platform, personalization will fail. If you need profiles added to the BI platform, contact your system administrator.
     
     - If you are using only default parameter values to personalize a report, select **Default value for all recipients** in the **Enterprise Recipient Mapping** column.
     
     **Note:**
     The **Enterprise Recipient Mapping** column appears only if the publication is intended for Enterprise recipients.

6. To override the default parameter personalization with dynamic recipient personalization values, in the **Dynamic Recipient Mapping** column, select a dynamic recipient source in the list.

   **Note:**
   The **Dynamic Recipient Mapping** column appears only if the publication is intended for dynamic recipients.

   If you are using default parameter values to personalize a report, select **Not Specified** in the **Dynamic Recipient Mapping** column.

7. Click **OK**.

---

**11.1.15.3 To personalize a Crystal report by filtering fields**

When you use filters, a ViewTime selection formula is added to a report to filter data. The formula is applied when the publication runs; it is not saved in the report.

Before you can use profiles to personalize data for Enterprise recipients, the profiles must be configured in the BI platform.

You can filter multiple fields in Crystal reports.

**Note:**

- Static-value profiles can filter only string fields in Crystal reports. To filter other types of fields, use expression profile values. If you map the incorrect type of field to the profile, personalization will fail.
- This feature is not available for Crystal reports in .rptr format.

1. Double-click a publication to open it.
   - The "Properties" dialog box appears.

2. Click **Personalization** in the navigation list.

3. Under **Local Profiles**, in the **Report Field** column, select a Crystal report field in the list.
The list of available fields includes all database fields and recurring formulas in the main report and in not-on-demand subreports.

4. In the **Enterprise Recipient Mapping** column, select a profile in the list.
   
   This profile maps the report Central Management Console (CMC) field to profile values defined for Enterprise recipients. If the profile is not configured in the BI platform, personalization will fail. If you need profiles added to the BI platform, contact your system administrator.

   **Note:**
   The **Enterprise Recipient Mapping** column appears only for publications intended for Enterprise recipients.

5. In the **Dynamic Recipient Mapping** column, select a dynamic recipient source in the list.
   
   The report field is mapped to a column in the dynamic recipient source that contains corresponding values.

   **Note:**
   The **Dynamic Recipient Mapping** column appears only for publications intended for dynamic recipients.

6. Repeat steps 2 to 5 for each report field you want to filter.
7. Click **OK**.

**11.1.15.4 To specify publication formats for a Crystal report**

You can select and configure more than one publication format for a Crystal report.

When you select a format, the available formatting options appear. For some options, such as **Crystal Reports** and **Crystal Reports (RPTR)**, no formatting options appear and the default source document formatting is applied.

1. Double-click a publication to open it.
   
   The "Properties" dialog box appears.
2. Click **Formats** in the navigation list.
3. Under **Format Options for Selected Document**, select a format to publish the Crystal report in.
   
   The options for the selected format appear.
4. Configure the formatting options as needed.
5. When the **Use the export options defined in the report** check box is available, perform one of the following actions:
   
   - Select the check box to use the default export options defined in the source document.
   - Clear the check box to configure export options for the format you selected, and then configure the options that appear.
6. Repeat steps 3 to 5 for each format in which you want to publish this Crystal report.
7. Click **OK**.
Repeat this task for each Crystal report in the publication.

### 11.1.15.4.1 Crystal report formatting options

#### Microsoft Excel (97-2003)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Page Range**          | • To publish the entire report as an Excel file, select **All**.  
                          | • To publish specific report pages, select **Pages**, type the first page number in the **from** box, and type the last page in the **to** box.     |

If you clear the **Use the export options defined in the report** check box, the following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Set Column Width**    | • To define column widths relative to objects in the report, select **Column width based on objects in the**, and select an option in the list—Whole report, Report Header, Page Header, Group Header #, Details, Group Footer #, Page Footer, or Report Footer.  
                          | • To define a constant width for all columns, select **Constant column width (in points)**, and type a number in the box.                       |
| **Export page header and page footer** | Select this check box to choose how frequently headers and footers appear in the Excel file, and select an option in the list—**None**, **Once Per Report**, or **On Each Page**. |
| **Create page breaks for each page** | Select this check box to create page breaks that reflect the page breaks in the report. |
| **Convert date values to strings** | Select this check box to convert date values to text strings. |
| **Show gridlines**      | Select this check box to include gridlines in the Excel file. |
If you clear the **Use the export options defined in the report** check box, the following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Set Column Width**            | • To define column widths relative to objects in the report, select **Column width based on objects in the**, and select an option in the list: **Whole report**, **Report Header**, **Page Header**, **Group Header #**, **Details**, **Group Footer #**, **Page Footer**, **or Report Footer**.  
• To define a constant width for all columns, select **Constant column width (in points)**, and type a number in the box. |
| **Export object formatting**    | Select this check box to preserve object formatting.                                                                                     |
| **Export images**               | Select this check box to publish report images in the Excel file.                                                                           |
| **Use worksheet functions for summaries** | Select this check box to use the report summaries to create worksheet functions for the Excel file.                                      |
| **Maintain relative object position** | Select this check box to preserve the relative position of report objects.                                                               |
| **Maintain column alignment**   | Select this check box to preserve the column alignment from the report.                                                                     |
| **Export page header and page footer** | Select this check box to choose how frequently headers and footers appear in the Excel file, and select an option in the list: **None**, **Once Per Report**, or **On Each Page**. |
| **Simplify page headers**       | Select this check box to simplify page headers.                                                                                           |
| **Show group outlines**         | Select this check box to show group outlines from the report.                                                                               |
If you clear the **Use the export options defined in the report** check box, the following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Set Column Width**                        | • To define column widths relative to objects in the report, select **Column width based on objects in the**, and select an option in the list—Whole report, Report Header, Page Header, Group Header #, Details, Group Footer #, Page Footer, or Report Footer.  
• To define a constant width for all columns, select **Constant column width (in points)**, and type a number in the box. |
| **Export object formatting**                | Select this check box to preserve object formatting.                        |
| **Export images**                           | Select this check box to publish report images in the Excel file.           |
| **Use worksheet functions for summaries**   | Select this check box to use report summaries to create worksheet functions for the Excel file. |
| **Maintain relative object position**       | Select this check box to preserve the relative position of report objects.  |
| **Maintain column alignment**               | Select this check box to preserve the column alignment from the report.     |
| **Export page header and page footer**      | Select this check box to choose how frequently headers and footers appear in the Excel file, and select an option in the list—**None**, **Once Per Report**, or **On Each Page**. |
| **Simplify page headers**                   | Select this check box to simplify page headers.                            |
| **Show group outlines**                     | Select this check box to show group outlines from the report.              |
**Microsoft Word (97-2003)**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Page Range    | - To publish the entire report as a Word file, select **All**.  
                - To publish specific report pages, select **Pages**, type the first page number in the **from** box, and type the last page in the **to** box. |

**PDF**

The following options apply to source documents published as PDF files.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Page Range    | - To publish the entire report as a PDF file, select **All**.  
                - To publish specific report pages, select **Pages**, type the first page number in the **from** box, and type the last page in the **to** box. |

**Rich Text Format (RTF)**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Page Range    | - To publish the entire report as an RTF file, select **All**.  
                - To publish specific report pages, select **Pages**, type the first page number in the **from** box, and type the last page in the **to** box. |
Microsoft Word - Editable (RTF)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Page Range              | • To publish the entire report as a Word file, select All.  
  • To publish specific report pages, select Pages, type the first page number in the from box, and type the last page in the to box. |

If you clear the **Use the export options defined in the report** check box, the following option is available:

| Insert page break after each report page | Select this check box to create page breaks that reflect the page breaks in the report.                                                   |

Plain Text

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If you clear the <strong>Use the export options defined in the report</strong> check box, the following option is available:</td>
</tr>
<tr>
<td>Number of Characters per Inch</td>
<td>Type the number of characters to appear per inch in the plain text file. The recommended range is between 8 and 16.</td>
</tr>
</tbody>
</table>

Paginated Text

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If you clear the <strong>Use the export options defined in the report</strong> check box, the following options are available:</td>
</tr>
<tr>
<td>Number of Lines per Page</td>
<td>Type a value to indicate how many lines are allowed on each page of the paginated text file.</td>
</tr>
</tbody>
</table>
### Number of Characters per Inch
Type the number of characters to appear per inch in the paginated text file. The recommended range is between 8 and 16.

### Tab Separated Text (TTX)
No additional options appear when you choose Tab Separated Text (TTX) as the formatting option.

### Separated Values (CSV)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delimiter</td>
<td>Type the character to use as a delimiter.</td>
</tr>
<tr>
<td>Separator</td>
<td>Type the character to use to separate values, or select the Tab check box to separate values with tabs.</td>
</tr>
<tr>
<td>Mode</td>
<td>Select Standard Mode (the default) or Legacy Mode.</td>
</tr>
<tr>
<td></td>
<td>In standard mode, you can control how report pages and group headers and footers appear in CSV output.</td>
</tr>
<tr>
<td>Report and page sections</td>
<td>• Select Export to export report and page sections.</td>
</tr>
<tr>
<td></td>
<td>• Select Do not export if you do not want to export report or page sections.</td>
</tr>
<tr>
<td></td>
<td>• Select the Isolate report/page sections check box to isolate report and page sections.</td>
</tr>
<tr>
<td>Group sections</td>
<td>• Select Export to export group sections.</td>
</tr>
<tr>
<td></td>
<td>• Select Do not export if you do not want to export group sections.</td>
</tr>
<tr>
<td></td>
<td>• Select the Isolate report/page sections check box to isolate group sections.</td>
</tr>
</tbody>
</table>
XML

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you clear the Use the export options defined in the report check box, the following option is available:</td>
<td>To specify the XML format, select an option in the list.</td>
</tr>
<tr>
<td>XML Exporting Formats</td>
<td></td>
</tr>
</tbody>
</table>

### 11.1.15.5 (Optional) To set print options for a Crystal report in a publication

You can print instances in Crystal reports format each time a publication runs, using the Crystal Reports Job Server's default printer or a different printer. BI platform prints instances after the publication is personalized but before delivery.

Before you can set print options for the default printer, the printer must be installed and configured properly.

**Note:**
- This task is optional (not required to design or schedule a publication) but can improve publication performance.
- The Crystal Reports Job Server must run on an account that has sufficient privileges to access the printer you specify. For more information, see the SAP BusinessObjects Business Intelligence Platform Administrator Guide.

1. Right-click a publication and select **Schedule**.
2. In the "Schedule" dialog box, click **Print Settings**.
3. Under **Documents**, select the Crystal report that you want to print when the publication runs.
4. Select the **Print Crystal reports when scheduling** check box.
   The Crystal report print options appear.
5. Select **Default printer** to print to the Job Server's default printer, or select **Specify the printer** and select the printer's path and name:
   - If the job server runs on Windows, in the Specify the printer box, type `\printserver\printname`
     Replace `printserver` with the name of your printer server and `printname` with the name of your printer.
   - If the job server runs on Unix, confirm that the Unix is shown (not hidden), and type the print command that you usually use in the **Specify a printer** box.
For example, type `lp -d printname`

6. In the **Number of Copies** box, type the number of copies to print.
7. Under **Page Range**, select **All** to print all pages in the publication or **Pages** and enter the page range to print.
8. (Optional) In the **Set collate option to** list, select **Collate**, **Do not collate**, or **Use printer defaults**.
9. (Optional) In the **Page Scaling** list, select **Scale to fit**, **Only shrink to fit**, or **Do not scale**.
10. (Optional) To center report content on the page, select the **Center the page** check box.
11. (Optional) If the Crystal report is wide and you want it to print on one page, select the **Fit horizontal pages into one page** check box.
12. Click **Schedule**.

### 11.1.15.6 (Optional) To set a recipient delivery rule on a Crystal report

Recipient delivery rules determine whether a publication is delivered to a particular recipient after processing and personalization. After creating a publication, you can open the publication and change the delivery rules for it.

**Note:**
This task is optional (not required to design or schedule a publication) but can improve publication performance.

1. Double-click a publication to open it.
2. In the "New Publication" dialog box, expand **Additional Options**, and click **Delivery Rules**.
3. Under **Recipient Delivery Rule**, select **Deliver individual document when condition is met** or **Deliver all documents only when all conditions are met**.
4. In the **Condition** column beside each document, select the condition that must be met before the publication will be delivered.
5. Click **Save & Close**.

### 11.1.15.7 (Optional) To set a global delivery rule on a Crystal report

Global delivery rules determine whether a publication will be processed and delivered to all recipients. You can set a global delivery rule on any Crystal report in the BI platform.

The Crystal report must contain an alert before you can set a global delivery rule.

**Note:**
This task is optional (not required to design or schedule a publication) but can improve publication performance.
1. Right-click a publication and select **Schedule**.
2. In the "Schedule" dialog box, click **Delivery Rules**.
3. Under **Global Delivery Rule**, click **Browse**.
   
   The "Select a report that contains an alert" window appears, where you can select the Crystal report on which to set the global delivery rule.
4. Locate and select the Crystal report, and click **OK**.
5. In the **Condition** list, select the alert value that the report must include in order to meet the global delivery rule.
6. Click **Schedule**.

---

**11.1.15.8 (Optional) Formatting merged PDF files**

Formatting merged PDF files is optional (not required to design or schedule a publication) but can improve publication performance.

Before you can format a merged PDF file:

- Crystal reports must have titles in order to be included in a merged PDF file. To set the title for a report, open the report in SAP Crystal Reports, select **File > Summary Info**, and type a title for the report in the **Title** box on the **Summary** tab. Save the report and re-export it to the repository.
- In BI launch pad, in the "Schedule" dialog box, under **Source Documents**, the Crystal reports and PDF files that you want to merge must appear in the correct order.
- In BI launch pad, in the "Schedule" dialog box, under **Formats**, the PDF check box must be selected as a format for each Crystal report that you want to include in the merged PDF file.
- In BI launch pad, in the "Schedule" dialog box, under **Destinations**, the **Merge Exported PDF** check box must be selected for each destination that you want to send the merged PDF file to.

To ensure that Crystal reports will appear in the table of contents of the merged PDF file, for each Crystal report listed, select the report in the **Documents** list in the **Formats** area, clear the **Use the export options defined in the report** check box, and select the **Create bookmarks from group tree** check box.

**11.1.15.8.1 (Optional) To format a merged PDF file**

**Note:**

This task is optional (not required to design or schedule a publication) but can improve publication performance.

1. Double-click a publication to open it.
2. In the "Properties" dialog box, click **Merged PDF Options**.
3. Create a table of contents for the merged PDF file:
   
   a. Select the **Create Table of Contents** check box.
      
      The format options for the table of contents appear.
b. In the **Title** box, type a title for the table of contents.

c. In the **Title Font** list, select the font, font size (in points), and font color for the title of the table of contents.

d. In the **Item Font** list, select the font, font size (in points), and font color for items in the table of contents.

4. Set the page number format for the merged PDF file:
   a. Select the **Apply Running Page Numbers** check box.
      The format options for page numbers appear.
      b. In the **Number Format** box, type a format for page numbers.
         By default, the format is set to `Page &p of &P`. You can change the format, but you must use `&p` as a placeholder for the current page number and `&P` as a placeholder for the total number of pages.
   c. In the **Number Location** list, select the page number orientation for the merged PDF file.
   d. In the **Number Font** list, select the font, font size (in points), and font color for the page numbers.
   e. If you want the table of contents to have page numbers, select the **Apply page numbers to Table of Contents pages** check box.

5. Set recipient logon credentials and permissions for recipient actions:
   a. Select the **Set Restrictions** check box.
   b. In the **User Password** box, type the password that recipients must enter to view the merged PDF file.
   c. In the **Owner Password** box, type the password that recipients must enter to edit the merged PDF file.
   d. To allow recipients to print the PDF file, select the **Allow Printing** check box.
   e. To allow recipients to modify the PDF file, select the **Allow Modification of Contents** check box.
   f. To allow recipients to copy and paste PDF contents, select the **Allow Copy and Paste (Required for Embedded Flash Objects to Run)** check box.
   g. To allow recipients to modify annotations in the PDF file, select the **Allow Modification of Annotations** check box.

6. Click **OK**.

### 11.15.9 (Optional) To configure database logon information for a Crystal report

You can modify the database logon information that recipients use to log on to the database and refresh the data in the Crystal report.

Before you begin, confirm that database settings for the Crystal report are correct. Under **Folders** in the CMC, select the Crystal report, and select **Manage > Default Settings > Database Configuration** to check the database information or to enter new information.
**Note:**
This task is optional (not required to design or schedule a publication) but can improve publication performance.

You may need to modify the data source information that a Crystal report references, in the report itself. Open the Crystal report in SAP Crystal Reports, and select **Database > Set Datasource Location**. In the "Set Datasource Location" dialog box, select a connection or create a new connection.

1. Double-click a publication to open it.
2. Click **Database Logon**.
3. In the **Title** list, select a Crystal report.
   The database information for the Crystal report appears below the **Title** list.
4. Confirm that the information in the **Database Server** box and the **Database** box is correct.
5. In the **User** box, type the user name that recipients must use to log on.
6. In the **Password** box, type a password that recipients must use to log on.
7. Click **OK**.

### 11.1.16 Web Intelligence document design tasks

#### 11.1.16.1 To specify publication formats for a Web Intelligence document

1. Double-click a publication to open it.
   The "Properties" dialog box appears.
2. Click **Formats** in the navigation list.
3. Under **Output Format**, select the check box for the format to publish the Web Intelligence document in:
   - Web Intelligence
   - Microsoft Excel
   - Adobe Acrobat
   - mHTML
4. If you selected **Comma Separated Values (CSV)**, under **Format Options and Settings**, perform the following actions:
   a. In the **Text qualifier** list, select a text qualifier.
   b. In the **Column delimiter** list, select a column delimiter.
   c. In the **Charset** list, select the character set.
d. If you want to enter a new character set, select the **Enter a new charset** check box, and type the character set in the box.

e. If you want to use the settings configured as the default, select the **Set as default values** check box.

f. If you want to generate a comma-separated value for each data source, select the **Generate separate CSV per Data Provider** check box.

5. Repeat steps 3 to 4 for each format in which you want to publish the document.

6. Click **OK**.

Repeat this task for each dynamic content source document in the publication.

### 11.1.16.2 To personalize a Web Intelligence document using a global profile target

You can personalize a Web Intelligence document for Enterprise recipients by filtering a global profile target. If the profile is not configured in BI platform, personalization will fail.

- Before you can use profiles to personalize data for Enterprise recipients, the profiles must be configured in BI platform.

- Before you can perform this task, the profile you want to use must have a global profile target.

If you need profiles added to BI platform, contact your system administrator.

**Tip:**
If you set the personalization options under **Global Profiles**, you do not have to set the personalization options under **Filters**.

1. Double-click a publication to open it.

   The "Properties" dialog box appears.

2. Click **Personalization**.

3. Under **Global Profiles**, in the **Enterprise Recipient Mapping** column, select a profile in the list.

   This profile maps the document to the universe field (global profile target) that is filtered for Enterprise recipients.

4. Click **OK**.

### 11.1.16.3 To personalize a Web Intelligence document by filtering fields

Before you can use profiles to personalize data for Enterprise recipients, the profiles must be configured in the BI platform.

**Note:**
Static-value profiles can filter only string fields in source documents. To filter other types of fields, use expression profile values. If you map an incorrect type of field to the profile, personalization will fail.
1. Double-click a publication to open it. The "Properties" dialog box appears.

2. Click Personalization.

3. Under Local Profiles, for each profile listed in the Title column, select a profile from the list in the Report Field column. This profile maps the report field to profile values for Enterprise recipients.

   **Note:**
   If the profile is not configured in the BI platform, personalization will fail. If you need profiles added to the BI platform, contact your system administrator.

4. Under Local Profiles, in the Enterprise Recipient Mapping column, select a profile the list. This profile maps the document to the universe field (global profile target) that is filtered for Enterprise recipients.

5. In the Dynamic Recipient Mapping column, select a profile in the list. The field in the source document is mapped to the column that contains corresponding values in the dynamic recipient source.

6. Repeat steps 3 to 5 for each field that you want to filter.

7. Click OK.

11.16.4 (Optional) To change the prompt value for a Web Intelligence document

You can use the default prompt value in a Web Intelligence document or perform this task to edit the prompt value.

Before you can change a prompt value, the document must contain a prompt.

This task is not required to design or schedule a publication, but it can improve publication performance.

1. Right-click a publication and select Schedule.

2. In the "Schedule" dialog box, expand Additional Options, and click Prompts.
   Web Intelligence documents that contain prompts appear.

3. Click Modify.
   The "Prompts" dialog box appears.

4. Click Refresh Values.
   A list of possible prompt values appears on the left.

5. Move a prompt value or values from the left list to the right list.

6. Click Apply.
   The list of prompt values is updated.
11.1.17 Optional publication features

The tasks in this section are optional (not required to design and schedule a publication) but can improve publication performance.

11.1.17.1 To select publication extensions

Before you can use a publication extension, the extension must be deployed on all computers that run the Adaptive Processing Server. The location varies, depending on the operating system:

- In Windows, the location is `INSTALLDIR\SAP BusinessObjects\SAP BusinessObjects Enterprise XI 4.0\java\lib\`
- In Unix, the location is `INSTALLDIR/sap_bobj/enterprise_xi40/java/lib/`

After a publication extension is deployed, you must restart the Adaptive Processing Server and other servers that host a Publishing Service. For more information about publication extensions, see the SAP BusinessObjects Business Intelligence Platform Java SDK Developer Guide.

1. Double-click a publication to open it.
   The "Properties" dialog box appears.
2. Expand Additional Options, and click Publication Extension.
3. In the Publication Extension Name box, type a name for the extension.
4. In the Class Name box, type the fully qualified class name for the extension.
5. (Optional) In the Parameter box, type a parameter name.
6. To use the extension after processing but before delivery, above the Before Publication Delivery list, click the Add button.
   The extension is added to the Before Publication Delivery list.
7. To use the extension after delivery, above the After Publication Delivery list, click the Add button.
   The extension is added to the After Publication Delivery list.
8. Click Save.
9. Repeat steps 2 to 8 for each extension you want to add.

**Tip:**
To define the order in which to execute publication extensions, click Move Up or Move Down under the Before Publication Delivery list or the After Publication Delivery list.
11.1.17.2 To configure email notification for publication jobs

Before you can use the Adaptive Job Server defaults for email notification, the server must be properly configured.

Perform this task if you want to receive email notification after a publication job runs.

**Note:**
This feature is available only in the CMC.

1. Double-click a publication to open it.
   The "Properties" dialog box appears.
2. Click **Notification**, and expand **Email Notification: Not in use**.
3. To receive email notification for successful publication jobs, select **A job has been run successfully**, and perform either of the following actions:
   a. To use the Adaptive Job Server defaults, click **Use the Job Server’s defaults**.
   b. To enter the email settings, click **Set the values to be used here**, and perform the following actions:
      a. In the **From** box, type an email address or a name.
      b. In the **To** box, type an email address to send the message to.
      c. In the **Cc** box, type the email address of each user who should receive email notification.
      d. In the **Subject** box, type the subject of the email.
      e. In the **Message** box, type a message that will accompany the notification email.
4. To receive email notification for failed publication jobs, select **A job has failed to run**, and perform either of the following actions:
   a. To use the Adaptive Job Server defaults, click **Use the Job Server’s defaults**.
   b. To enter the email settings, click **Set the values to be used here**, and perform the following actions:
      a. In the **From** box, type an email address or a name.
      b. In the **To** box, type an email address to send the message to.
      c. In the **Cc** box, type the email address of each user who should receive email notification.
      d. In the **Subject** box, type the subject of the email.
      e. In the **Message** box, type a message that will accompany the notification email.
5. Click **OK**.

11.1.17.3 To enable auditing notification for publication jobs

...
For more information about auditing, see the *SAP BusinessObjects Business Intelligence Platform Administrator Guide*.

**Note:**
This feature is available only in the CMC.

1. Double-click a publication to open it.
   The "Properties" dialog box appears.
2. Expand **Additional Options**, click **Notification**, and expand **Audit Notification: Not in use**.
3. To audit successful publication jobs, select **A job has been run successfully**.
4. To audit failed publication jobs, select **A job has failed to run**.

### 11.1.17.4 To specify events

Event-based scheduling provides additional control over scheduling publications. You can set up events so that publications are processed only after an event occurs.

Perform this task if a publication job runs after an event occurs or if a publication job triggers an event when it stops running. For information about events, see the *SAP BusinessObjects Business Intelligence Platform User Guide*.

1. Double-click a publication to open it.
   The "Properties" dialog box appears.
2. Expand **Additional Options**, and click **Events**.
3. To specify file-based and custom events for a publication, click the > button to move events from the **Available Events** list to the **Events to wait for** list.
   The events trigger the publication job to run.
4. To specify schedule events for a publication, click the > button to move events from the **Available Schedule Events** list to the **Events to trigger on completion** list.
   The events occur after the publication job runs.
5. Click **OK**.

### 11.1.17.5 To select a server group for a publication

You can choose a particular server group to process a publication.

For information about server groups, see the *SAP BusinessObjects Business Intelligence Platform Administrator Guide*.
You cannot schedule publications across sites in a federation.

1. Double-click a publication to open it. The "Properties" dialog box appears.
2. Expand Additional Options, and click Scheduling Server Group.
3. Select a server group option.
   Select the Run at origin site check box if you want to run the publication job at its site of origin.
4. Click OK.

### 11.1.17.6 To specify a profile resolution method

When a profile conflict occurs, the profile resolution determines whether instances will be merged or delivered as separate documents.

1. Double-click a publication to open it. The "Properties" dialog box appears.
2. Expand Additional Options, and click Advanced.
3. Under Profile Resolution Method, select an option:
   • Select Do not merge if you want profiles from multiple user groups to result in separate documents.
   • Select Merge if you want to apply profiles from multiple user groups to the same document.
4. Click OK.

### 11.1.17.7 To select a report bursting method

Carefully select a report bursting method when a publication meets the following criteria:

- The publication contains Web Intelligence documents intended for Enterprise recipients.
- The profiles used for personalization have filter expressions.

The report bursting method determines how source documents are personalized, processed, and delivered. Report bursting methods use different filter types to personalize and process documents. For example, the **One database fetch for all recipients** option uses a report filter and the **One database fetch per recipient** option uses a query filter. Each filter type supports a different set of operators. If a filter expression uses an operator that the report bursting method does not support, the publication may fail.

1. Double-click a publication to open it. The "Properties" dialog box appears.
2. Expand **Additional Options**, and click **Advanced**.
4. Click **OK**.

### 11.2 Post-design publication tasks

Tasks in this section are optional and can be performed after publication design.

#### 11.2.1 Finalizing a publication

At any point during or after the publication design process, you can view a summary of a publication’s properties on the "Summary" dialog box—including the publication's title, location, description, source documents, the number of recipients who will receive the publication (sorted by recipient type, Enterprise or dynamic), how the publication is personalized, the distribution format, and the destination.

To open the "Summary" dialog box, click **Summary**. You can use other options on the navigation panel to change the properties, or you can save a publication and schedule it.

#### 11.2.2 To test a publication

You can use test mode in BI launch pad to send a publication to yourself before sending it to recipients. You receive the same information that recipients will receive. Destinations are automatically updated so that your BI Inbox or your email address is used instead of publication recipients' BI Inbox or email address.

If necessary, you can exclude selected recipients from the original group of recipients in test mode.

1. Right-click a publication and select **Test Mode**.
2. (Optional) In the "Test Mode" dialog box, modify the list of Enterprise recipients:
   a. Click **Enterprise Recipients**.
   b. Under **Available**, select users or groups, and click the > button to move the users or groups to the **Selected** list or the **Excluded** list.
3. (Optional) Modify the list of dynamic recipients:
   a. Click **Dynamic Recipients**.
   b. Under **Choose the source for the dynamic recipients**, select **Web Intelligence Report Dynamic Recipient Provider** or **Crystal Reports Dynamic Recipient Provider** in the list.
4. Click **Test**.
   The publication runs in test mode.

11.2.3 **To schedule a publication to run**

You must design and save a publication before you can schedule it to run.

When you schedule a publication, you can use the settings under **Recurrence** or enter new settings. You can change the recipients each time you schedule a publication.

1. Right-click a publication and select **Actions > Schedule** in the CMC or select **Schedule** in BI launch pad.
2. In the "Schedule" dialog box, click **Recurrence**, and confirm that the option selected in the **Run object** list is correct.
3. Click **Schedule**.
   The publication runs as specified.

**Tip:**
To view the progress of a publication job while it runs, right-click the job and select **Actions > History** in the CMC or **History** in BI launch pad. In the **Status** column, click the status (Success, Failed, or Running), and click **View Log File** at the bottom of the "Publication History" dialog box.

11.2.3.1 **To view publication results**

**Viewing results as a publisher**
You can view the results of a publication in various ways. After a publication runs, the publication history appears, listing publication instances, the times when the publication ran, and whether the publication succeeded or failed. In the **Instance Time** column, you can click a link to a publication instance to view instances generated for all recipients when the publication ran.

**Tip:**
To quickly access a publication's history, right-click a publication and select **Actions > History** in the CMC or **More Actions > History** in BI launch pad.

**Viewing log files for publication jobs**
Log files are useful for troubleshooting a publication and for identifying which recipients did not receive a publication instance. The BI platform logs publication job information as each batch of personalized publication instances is processed and then consolidates the details into one or more log files. The maximum log file size is 10 MB and is non-configurable. If you run a high-volume publication with many details, the publication instance may have several log files.

You can view log files for a publication instance in the following ways in the "History" dialog box:
To view the last log file in a series, in the **Status** column, click the status (Success, Failed, or Running), and click **View Log File** at the bottom of the "Instance Details" dialog box.

**Tip:**
You can view the last log file while a publication is running.

To view all log files, in the **Instance Time** column, click the link for a publication instance. Log files are listed after the personalized instances.

Log files are updated with new information every two minutes. If a publication job has been running less than two minutes, the log file may have a status of Pending.

**Viewing results as a recipient**
The following table summarizes the ways that you can view a publication:
<table>
<thead>
<tr>
<th>Destination</th>
<th>How to view the publication result</th>
</tr>
</thead>
</table>
| Default Enterprise location | **Note:**
Dynamic recipients cannot log on to the BI platform to view publication results.

As a recipient, you can view only your own personalized publication instances in the BI platform. You cannot view publication instances that are personalized for other recipients.

1. Perform either of the following actions to start the CMC:
   - In Windows, select **Start > Programs > SAP Business Intelligence > SAP BusinessObjects BI platform 4 > SAP BusinessObjects BI platform Central Management Console**.
   - In a web browser, type `http://<ServerName>:<ConnectionPort>/CMC`.
     Replace `<ServerName>` with your CMS name, and replace `<ConnectionPort>` with your connection port number (specified during installation). The default connection port number is 8080.

2. Enter your logon credentials:
   - In the **System** box, confirm that the CMS name and CMS port are correct.
   - Type your user name and password.
   - In the **Authentication** list, select the authentication type.

3. Click **Log On**.
4. Under **Folders**, right-click the publication and select **History**.
5. In the "History" dialog box, click the link in the **Instance Time** column.
6. Double-click the instance that you want to view.
## How to view the publication result

**Note:**
Dynamic recipients cannot log on to BI launch pad to view publication results.

1. Perform either of the following actions to start BI launch pad:
   - In Windows, select **Start > Programs > SAP Business Intelligence > SAP BusinessObjects BI platform 4 > SAP BusinessObjects BI platform Java BI Launch Pad**.
   - In a web browser, type `http://<ServerName>:<ConnectionPort>/BOE/BI`.

   Replace `<ServerName>` with your CMS name, and replace `<ConnectionPort>` with your connection port number (specified during installation). The default connection port number is 8080.

2. Type your logon credentials:
   - In the **System** box, confirm that the CMS name is correct.
   - Type your user name and password.
   - In the **Authentication** list, select the authentication type.

3. Click **Log On**.
4. Click **My Inbox**.
5. Double-click the instance you want to view.

<table>
<thead>
<tr>
<th>Destination</th>
<th>How to view the publication result</th>
</tr>
</thead>
<tbody>
<tr>
<td>BI Inbox</td>
<td>Log on to your email to view embedded publication content or to download the attachment or attachments.</td>
</tr>
<tr>
<td>Email</td>
<td>Log on to your FTP host.</td>
</tr>
<tr>
<td>FTP server</td>
<td>Go to the location specified when the publication was designed.</td>
</tr>
</tbody>
</table>
### 11.2.4 To subscribe to or unsubscribe from a publication

Enterprise recipients can subscribe to or unsubscribe from a publication. You must have appropriate access rights to a publication before you can subscribe to it. Dynamic recipients cannot subscribe to or unsubscribe from a publication.

**Note:**
To subscribe to a publication after it is scheduled, subscribe to its recurring instance—or reschedule the publication.

1. In the **Folders** drawer on the **Documents** tab, locate and select the publication that you want subscribe to or unsubscribe from.
2. Perform one of the following actions:
   - In the Central Management Console (CMC), select **Actions > Subscribe** or **Unsubscribe**.
   - In BI launch pad, right-click the publication and select **Subscribe** or **Unsubscribe**.

### 11.2.5 To subscribe to or unsubscribe from a publication instance

After a recurring publication has been scheduled, Enterprise recipients can subscribe to its first recurring instance. You must have appropriate access rights to a publication before you can subscribe to its instances.

For example, for a publication scheduled to run twice a week, subscribe to the first publication instance, not the second one.

Dynamic recipients cannot subscribe to or unsubscribe from publication instances.

1. Perform one of the following actions:
   - In the Central Management Console (CMC), select **Actions > History**.
   - In BI launch pad, right-click a publication and select **History**.
2. In the "History" dialog box, perform one of the following actions:
   - In the CMC, right-click the instance and select **Actions > Subscribe** or **Unsubscribe**.
   - In BI launch pad, right-click the instance and select **Subscribe** or **Unsubscribe**.
11.2.6 To redistribute a publication instance

When you want to resend an instance to a recipient but do not want to rerun an entire publication, you can redistribute successful publication instances to all or some of the original recipients. Only recipients specified when the publication was originally run can receive redistributed instances.

1. Right-click the publication and select Actions > History in the CMC or History in BI launch pad. The "History" dialog box appears.
2. Select a successful publication instance.
3. Perform either of the following actions:
   • In BI launch pad, select More Actions > Reschedule.
   • In the CMC, select Actions > Reschedule.
4. Choose which recipients will receive redistributed instances:
   • To redistribute an instance to Enterprise recipients, click Enterprise Recipients, and click the > button to move recipients from the Available list to the Selected list.
   • To redistribute an instance to dynamic recipients:
     a. Click Dynamic Recipients, and confirm that columns mapped to recipient IDs, full names, and email addresses are correct.
     b. To redistribute the publication to all dynamic recipients, select Use entire list.
     c. To redistribute the publication to selected dynamic recipients, click the > button to move recipients from the Available list to the Selected list.
5. Click Redistribute.
   The publication history appears, and the redistributed instance has a status of Running. The date in the Instance Time column is updated to reflect the redistribution time.

11.2.7 To retry a failed publication

Before you begin, view the log file for the failed publication instance, address any errors, and reschedule the publication.

1. Select the failed publication instance.
2. Perform either of the following actions:
   • In BI launch pad, select More Actions > History.
   • In the Central Management Console (CMC), select Actions > History.
   The instance status changes to Running.

   If the publication fails again, review the new log file and fix any errors that occurred.
11.3 Improving publication performance

**Adaptive Processing Server**

<table>
<thead>
<tr>
<th>Area</th>
<th>Consideration</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU and memory</td>
<td>Move the Adaptive Processing Server to a faster machine that has more available CPUs and BI platform Feature Pack 3 or later installed. The server will automatically scale to use more CPUs.</td>
</tr>
<tr>
<td></td>
<td>Isolate the Publishing Service and the Publication Post Processing Service on dedicated Adaptive Processing Servers and remove unused services hosted on those servers. Each service will consume more shared resources (requests to thread pool, memory, and CPU consumption) on an Adaptive Processing Server, and publishing performance may improve.</td>
</tr>
</tbody>
</table>

**Publishing Service**

Because publishing is a hard-drive-intensive process, the Publishing Service should be installed on a machine with fast I/O or SAN disks for the FRS.

<table>
<thead>
<tr>
<th>Area</th>
<th>Consideration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Many publication instances that execute concurrently</td>
<td>If the underlying CMS, FRS, Adaptive Job Server, and report processing servers have been scaled appropriately, horizontally scale out the Publishing Service across multiple Adaptive Processing Servers, on one or more machines, to concurrently process more publication instances.</td>
</tr>
</tbody>
</table>

**Note:**
A single publication job (for example, with one million recipients) is not shared across Publishing Services hosted on different Adaptive Processing Servers. Horizontally scaling out the Publishing Service will not improve processing time for a single publication, regardless of the number of recipients.
<table>
<thead>
<tr>
<th>Area</th>
<th>Consideration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publications with many recipients</td>
<td>Vertically scale the Adaptive Processing Server on machines with more CPUs and RAM to concurrently process more recipients and to generate more jobs on the Adaptive Processing Server.</td>
</tr>
<tr>
<td>Note:</td>
<td>• You may need to scale the Adaptive Job Server and report processing servers accordingly to increase throughput.</td>
</tr>
<tr>
<td></td>
<td>• You may need to increase the Adaptive Processing Server’s heap size (that is, set (-Xmx) to 2 GB or more) when the server runs on a machine with more than eight CPU cores. The larger number of CPU cores enables the Adaptive Processing Server to spawn more threads and increase throughput. Note that more threads require more RAM.</td>
</tr>
<tr>
<td>Publishing cleanup option</td>
<td>For a large publication that does not need redistribution or to view artifacts in the report, do not select the default destination.</td>
</tr>
<tr>
<td>Crystal report publications</td>
<td>If you do not need to apply unique security for each recipient, select One database fetch for each batch of recipients. Database access will be batched in multiple, smaller, concurrent queries.</td>
</tr>
<tr>
<td>Web Intelligence publications</td>
<td>Select One database fetch for all recipients or One database fetch per recipient.</td>
</tr>
<tr>
<td></td>
<td>When you select One database fetch for all recipients for a large publication, to break the database query into multiple, smaller queries, add the following command line option to speed disk delivery to all Adaptive Processing Servers that host the Publishing Service:</td>
</tr>
<tr>
<td></td>
<td>(-Dcom.businessobjects.publisher.scopebatch.max.recipients=&lt;integer&gt;)</td>
</tr>
</tbody>
</table>
Consideration Area

<table>
<thead>
<tr>
<th>Area</th>
<th>Consideration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Large publications with slow disk delivery to a single folder on Windows</td>
<td>Search for <em>disable short file name generation</em> (article ID 210638) or for <code>NtfsDisable8dot3NameCreation</code> on Microsoft TechNet at <a href="http://technet.microsoft.com">http://technet.microsoft.com</a> and follow the instructions.</td>
</tr>
<tr>
<td>Large publications with slow disk delivery to a single folder that contains more than 300,000 files on Windows</td>
<td>Search for <em>how NTFS works</em> at <a href="http://technet.microsoft.com">http://technet.microsoft.com</a> and follow the instructions.</td>
</tr>
</tbody>
</table>

**Publishing Post Processing Service**

The Publishing Post Processing Service is called when the **Package as ZIP File** check box (in the "Schedule" dialog box) and/or the **Merge Exported PDF** check box (in the "Destinations" dialog box) is selected or when custom post-processing plugins are enabled on a publication.

**Area**

| Publications with both **Package as ZIP File** and **Merge Exported PDF** selected | Horizontally scale out the Publishing Post Processing Service to spread the ZIP- and PDF-merging workloads across multiple Publishing Post Processing Services hosted on different Adaptive Processing Servers. |

### 11.3.1 Recommendations for adding source documents

This section contains recommendations for adding dynamic content documents to publications.

**Use publication log files to troubleshoot errors in failed publications**

When you schedule publications to run, log files are generated to record errors that may occur when the publications are processed. To view all log files for a publication instance, select **More Actions > History**. In the "History" dialog box, click the link for the instance in the **Instance Time** column. The instance details appear in a new window.
If using parameter-based personalization for Crystal reports, set parameters to default

Parameter-based personalization may lead to slower publication performance. To significantly speed performance, personalize Crystal report publications by mapping fields to Enterprise recipient profiles or to dynamic recipient personalization values.

If you must personalize Crystal reports using parameters, in the "Personalization" section, set parameters to their default value.

**Note:**
Before you can use Enterprise recipient profiles in publications, the profiles must be configured in BI platform.

View and schedule individual dynamic content documents before adding them to a publication

If you can view and schedule dynamic content documents successfully, the data source connection is working properly and the source document data can be refreshed when the publication is scheduled. If you cannot view and schedule dynamic content documents, confirm that the data source connection settings are correct. The following table summarizes how to check the settings:

<table>
<thead>
<tr>
<th>Document type</th>
<th>How to check data source connection settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crystal report</td>
<td>In the CMC, select the Crystal report, and select Manage &gt; Default Settings. In the &quot;Default Settings&quot; dialog box, click Database Configuration on the navigation panel.</td>
</tr>
<tr>
<td>Web Intelligence document</td>
<td>In the CMC, select the Web Intelligence document, and select Manage &gt; Default Settings. In the &quot;Default Settings&quot; dialog box, click Report Universes on the navigation panel.</td>
</tr>
</tbody>
</table>

In some cases, you may have to open a dynamic content document in the designer to configure the data source connection and to re-export the file to the CMS repository and overwrite the previous copy. For more information about configuring data source connections for dynamic content documents, see the designer documentation.

Avoid unnecessary data refreshes

If a data refresh is unnecessary for a dynamic content document, in the "Source Documents" section, clear the Refresh At Runtime check box for that document to improve overall publication performance.

**11.3.2 Recommendations for using dynamic recipient sources**

Sort dynamic recipient sources according to the recipient ID column

In general, you should sort dynamic recipient sources by the Recipient ID column. This is especially important when you are running a high-volume publication or when you selected One database fetch
for each batch of recipients because it can reduce the number of deliveries to recipients with multiple personalization values.

For Crystal report dynamic recipient sources, confirm that database configuration information is correct

In the CMC, select the dynamic recipient source, select Manage > Default Settings, and confirm the following settings:

- Under Database Configuration, confirm the database logon information is correct and Use same database logon as when report is run is selected.
- Under Parameters, confirm that all parameters have values and all Prompt when viewing check boxes for parameters are cleared.

If using Crystal report dynamic recipient sources, contact your administrator and confirm that the RAS is configured correctly

The Report Application Server (RAS) must be configured to read at least the same number of database records as the number of recipients in the dynamic recipient source. For example, to process a dynamic recipient source with data for 100,000 recipients, the RAS must be set to read more than 100,000 database records.

11.3.3 Recommendations for sending and receiving email publication instances

If possible, view embedded-content email-publication instances in Outlook 2003

View embedded content in email publication instances in Outlook 2003 whenever possible. Embedded content in email publication instances may have formatting issues when viewed in Outlook 2007 or in web email accounts, such as Hotmail or Gmail.

Contact your administrator to confirm that the email settings are configured properly for the Destination Job Server

You must ensure that email settings are properly configured for the Destination Job Server. Publications intended for email destinations may fail because email has not been configured properly as a destination for the Adaptive Job Server. For more information, see the SAP BusinessObjects Business Intelligence Platform Administrator Guide.
Index

A

access
- calendars 81
- categories 32, 33
- events 134
- profiles 154

Adaptive Job Server 226
Adaptive Job Servers
- disabling destinations for 107
- enabling destinations for 107

add placeholders
- personalized values 167

administration
- categories 33
- CMC 17
- events 134
- folders 29
- profiles 154
- tools 17

alert notifications 108
- comparison to alerting 137
- forwarding to BI Inbox 145
- forwarding to other users 145

alert source objects, CMC 138

alerting 135, 138
- alert sources 136
- comparison to alert notifications 137

Crystal reports 142, 143, 144
- enabling for events 142
- events 142, 143, 144
- excluding other users from 145
- rights conflicts 141
- rights required 138
- settings, managing 145
- subscribing other users to 144
- subscribing to 142
- unsubscribing from 143
- unsubscribing other users from 144

workflow 136

alerting management 141

alerts (continued)
- unsubscribing other users from 144
- viewing in Crystal reports 58
- areas, management 18
- audit notification 87, 213
- authentication, object packages 74

B

BEx personalization 61
BI Analyst license 13
BI Inbox
- forwarding alert notifications to 145
- forwarding alert notifications to other users 145
- scheduling objects to 104
- scheduling to 96

BI launch pad 60
- categories 33
- creating publications in 179
- Favorites folders 30
- folders 30
- publication results, viewing 216
- viewing reports in 60

BI Viewer license 13

BW
- adding reports from 59
- migrating systems 59

C

cache format, Web Intelligence documents 117

Cache Server
- for viewing reports 46

calendars 75
- creating 75
- dates 76, 77
- deleting 80
- format options 76
- recurring dates 78
- specifying rights 81

categories
- access rights for 30
- adding multiple objects to 34
- adding objects 32
- corporate 30, 31
- creating 31
- deleting 31
- deleting objects in 33
- moving 32

categories (continued)
- personal 30, 31
- removing objects in 33
- rights 33

CMC
- logging on 18
- management areas 18
- navigating 18
- publication results, viewing 216
- setting preferences 19

CMC tasks
- alert source objects, locating 138
- alerting workflow, Crystal reports 136
- alerting workflow, events 136
- alerts, subscribing other users to 144
- alerts, subscribing to 142
- alerts, unsubscribing from 143
- creating publications 178
- email notification for jobs 212
- subscribing to publication instances 220
- subscribing to publications 220
- unsubscribing from publication instances 220
- unsubscribing from publications 220
- unsubscribing other users from alerts 144

CMS, saving objects to 25

collaboration
- scheduling for 96
- scheduling objects for 107

command line arguments, specifying 66

concurrent user license 13

Content Administration Workbench 59

copying
- folders 28
- objects 35

creating
- folders 27

Crystal reports 145
- adding from BW 59
- adding to BI platform 59
- adding with existing hyperlinks 56
- alert notifications 137
- alerts 58
- data sharing 45
- database logon, configuring 207
Crystal reports (continued)
database settings 48
delivery rules 157, 205
dynamic recipient sources,
troubleshooting 225
filters 51
processing extensions 50
selection formulas 50
formats
specifying 197
formatting options 198
from BW 60
job server for scheduling 46
page layout options 53
PDF file merging
formatting 206
PDF merging 172
personalizing
with local profile targets 196
with parameters 195
printing 204
processing extensions 54
publishing formats 168
refresh options 44
scheduling formats 112
selecting printers 52
specifying prompt values for 49
thumbnails 57
troubleshooting 224
viewing options 45
CSV, scheduling formats 112
custom events 128, 132

D
data refresh 156, 224
database
logon, Crystal reports 207
settings 48
database fetches 156, 214
Default Enterprise Location, scheduling to 96
default servers
selecting 47
default values 62
deleting
folders 28
subfolders 28
delivery rules
Crystal reports 157
global 205
recipient 205
destination report 55
destinations
BI Inbox 104
by object type 40
destinations (continued)
default settings 103
e-mail 194
SMTP mail support 104
file location 106
file system 106
FTP 105
locations 39
placeholders 182
publications 160
scheduling 89, 96
selecting 182
sending to 38
unmanaged disk 106
destinations for job servers
enabling, disabling 107
destinations, scheduling
locations 90, 160, 184
DLL files 54
dynamic recipients 159
adding 181
sources 159
troubleshooting 225
dynamic-link libraries, processing
extensions 54

e-mail
embedding publication content in
194
notification 212
publication instances,
troubleshooting 226
scheduling objects to 104
scheduling to 96
e-mail fields
personalized placeholders 194
e-mail notification 87
emailing publications
using personalized placeholders
167
Enterprise recipients, adding 181
environment variables 69
editing 70
removing 70
events
access to 134
alerting, enabling 142
alerts for 145
alerts settings for 145
custom 132
file-based 130
managing 128
notification 87
publications 213

events (continued)
schedule-based 131
scheduling 117, 118
scheduling object to trigger 119
Excel, scheduling formats 112
executable programs 65
configuring 68
exporting, objects to CMS 25
extensions, processing 54
external recipients 159

F
failed publications, retrying 221
Favorites folders 30
file events 128, 130
file location, scheduling to 96
file system, scheduling to 96
filtering
publication data 170
filters, for Crystal reports
processing extensions 50
selection formulas 50
filters, for Crystal reports 51
folders 27
copying 28
creating 27
default user 30
default user folders 33
deleting 28
Favorites 30
moving 28
personal 30
rights 29
setting instance limits 29
formats 208
Crystal reports 197
mHTML 194
publications 167, 168
Web Intelligence documents 208
formatting options
Crystal reports 198
FTP destination
scheduling 105
FTP server
scheduling to 96

G
global delivery rules 205
global profile targets 148, 149, 209

H
high-volume publications 156, 222
I

importing 59
  BW content 59
instance
  failure 87
instance format
  selecting 111
Instance Manager 123
instances 127
  columns 126
  Crystal report formats 109
  deleting 127
  finding 124
  in formats 167
  managing 121, 123, 125
  notification 87
  object 43
  object packages 72
  output formats 109
  pausing 126
  program objects 65
  redistributing 221
  report objects 43
  resuming 126
  scheduled 43
  sending 38
  setting limits at the folder level 29
  viewing 126
  Web Intelligence formats 109

J

Java programs 65
  configuring 70
  providing access to other files 70
  setting parameters 70
job servers
  disabling destinations for 107
  enabling destinations for 107

L

languages
  viewing reports in 60
licenses
  BI Analyst 13
  BI Viewer 13
  concurrent user 13
  named user 13
Life Cycle Manager
  importing report objects 59

limits
  for folder level instances 29
local profile targets 148
Crystal reports 196
Web Intelligence documents 209
log on, CMC 18

M

management areas 18
  managing alerts 141
  merged PDF files, formatting 206
  mHTML 194
  migrating reporting content in BW 59
  moving
    folders 28
  multiple profile values 177

N

named user license 13
navigation, between reports 55
NetWeaver BW
  adding reports from 59
  migrating systems 59
  no personalization 170
  notification
    audit 87, 88
    email 87, 88
    event 87
    failure 87
    setting for instances 88
  notifications
    alerts 108
    scheduled object 86
  null parameter values 63
  null values 63

O

object instances 43
  object management 21, 43
object packages
  (continued)
  program objects 73
  report objects 73
  scheduling 121
  object shortcuts 36
  object types
    object packages
      preventing from failure 87
      scheduling options for
        individual objects 87
    program objects 87
    report objects 87
    Web Intelligence documents 87

objects
  adding 21
    with CMC 22
  adding to categories 32, 34
  adding to object packages 73
  changing
    default settings 43
    properties 42
  copying 35
  creating shortcuts to 36
  deleting 37
  exporting to CMS 25
  failure notification 86
  formatting 109
  managing 21, 35
  moving 36
  program 73
  property options 23
  report 73
  Run Now 120
  saving to CMS 25
  scheduling 81
  search 37
  sending 38
  success notification 86

objects rights
  when moving categories 32
output file format
  selecting 111

P

parameters
  and personalization 64
  and variables in BW queries 62
Crystal reports 195
  default values 62
  dynamic picklists 62
  Java programs 70
  null values 63
parameters vs. report variables 62

parent folders
  creating 27
passwords 19
pausing instances 126
PDF
merging 172
scheduling formats 112
performance, publication, improving 222
personal categories
viewing 33
personalization 61, 170
personalized parameter values 63
personalized placeholders 167
personalizing
Crystal reports 195, 196
publications 170
Web Intelligence documents 209
picklists 62
placeholder 170
placeholders 193, 194
plain text, scheduling formats 112
preferences
setting in the CMC 19
preferred viewing locale 20
printing
assigning printers 52
Crystal report publications 204
Crystal reports 51
processing extensions 54
applying to reports 54
selecting 54
Processing Server 46, 224
processing settings 119
profiles 147
access to 154
conflicts 153
creating 148
global profile targets 149
profile resolution 214
profile targets 148
profile values 148
conflicts 153
types 150
variables 152
role in Publishing 147
program objects
authentication 71
batch files 68
binary files 68
environment variables 69
executable 65
executable programs 68
Java 65
Java programs 70
managing 64
paths to auxiliary files 68
paths to external files 68
program objects (continued)
script 65
shell scripts 68
prompts 49
updating 50
prompts in Web Intelligence
documents 210
publication extensions 171, 211
publication instances
subscribing to 220
unsubscribing from 220
publication instances, redistributing 221
publication names
designation
placeholders 193, 194
publication source documents
personalized placeholders 193
publications 155
additional options 211
creating
in BI launch pad 179
in CMC 178
delivery rules 157
designing 177
destinations 160
dynamic recipients 159, 181
embedding content in email 194
Enterprise recipients, adding 181
file types for documents in 167
finalizing 215
for SAP BusinessObjects Live
Office 177
formats 167, 168
general properties 179
general properties for 179
opening 179
personalization 170
placeholder 170
publication extensions 171
redistributing instances 221
report bursting 156
running 190
scheduling 190, 216
source documents for 179
source documents, adding 180
subscribing to 172, 220
testing 215
unsubscribing from 172, 220
viewing results 216
published reports
viewing 61
publisher 176
publishing 155
access rights 172
rights 176
Publishing
profiles, role of 147
SAP integration 178
PVL 20
queries, relationship 42
queries, relationships 43
recipients
delivery rules 205
dynamic 159
personalizing publications for 221
redistributing instances to 221
recurrence pattern options 190
recurrence patterns 190
recurrence patterns, object scheduling 83
refresh options 44
setting 45
refreshing
source document data 156, 224
refreshing reports 44
relationship queries 42, 43
Report Application Server 46, 225
report bursting 214
agnostic source documents 156
Crystal reports 156
logon credentials 156
security 156
static source documents 156
Web Intelligence documents 156
report instances
columns 126
history 122
managing 43, 125
setting limits 127
viewing 126
report objects
adding and hyperlinking 57
adding with existing hyperlinks 56
data sharing 45
database settings, specifying 48
destination 89
filters 50
filters, specifying 51
hyperlinking 55
hyperlinks, viewing 56
managing 43
processing extensions 54
prompt values 49
refresh options 44
report objects (continued)
scheduling with events 117, 118, 119
setting instance limits 127
specifying Job Servers for 46
specifying servers 46
triggering events 119
viewing options 45
report tabs, publishing 208
report variables vs. parameters 62
report viewing options
setting 46
reports 32
migrating with BW content 59
null parameter values in 63
personalization in 61
viewing in BI launch pad 60
resuming instances 126
rich text, scheduling formats 112
rights
alerting conflicts 141
calendars 81
categories 33
copying folders 28
events 134
folders 29
moving folders 28
profiles 154
publishing 172, 176
rights, alerting
Edit 138
Schedule 138
Subscribe 138
Trigger 138
View 138
View Instance 138
row-level security, processing
extensions 54
run options, object scheduling 85
S
SAP BusinessObjects Business Intelligence platform
documentation 11
SAP BusinessObjects Enterprise SDK 54
SAP BusinessObjects Live Office 177
SAP Easy Access 60, 61
SAP Logon 61
SAP StreamWork
scheduling objects to 107
scheduling to 96
schedule events 128, 131
scheduled instances 43
scheduled reports
personalized parameter values 63
scheduling 81
events 117, 118
forms 112
individual objects
for group 83
for user 83
notification 86
object packages 121
objects 82
for group 83
for user 83
in batches 121
recurrence patterns 83
run options 85
publications 190, 216
server group settings 119
server groups 213
specifying server for 46
with events 213
scheduling objects
events
triggering 119
script programs 65
search 37
security, processing extensions 54
selecting
Enterprise recipients 181
separated values, scheduling formats 112
server groups, scheduling 213
servers
default, for scheduling objects 46
for viewing and modifying reports 46
shared libraries, as processing
extensions 54
SMTP mail support 104
source documents, troubleshooting
224
static source documents 156
subcategories
access rights for 30
corporate 30, 31
personal 30, 31
subfolders
copying 28
deleting 28
moving 28
subscription 172, 220
Summary dialog box, publications 215
system performance 141
T
test mode 215
thumbnails, Crystal reports 57
tools, administration 17
top-level folders
creating 27
translated reports
viewing 60
troubleshooting
dynamic recipient sources 225
e-mail publication instances 226
failed publications 221
publication performance 222
source documents 224
TXT, scheduling formats 112
U
universes
Web Intelligence documents 58
unmanaged disk destination 106
user folders 30
V
variables, for profile values 152
W
Web Intelligence document objects 43
Web Intelligence documents
formats, specifying 208
personalization 209
prompts
updating 50
publishing formats 168
selecting cache options 117
server for scheduling 46
dynamic recipient sources 225
e-mail publication instances 226
failed publications 221
publication performance 222
source documents 224
Word, scheduling formats 112
workflows
alerting 136
profiles and Publishing 147
X
XML, scheduling formats 112